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Welcome to the AGCC User Manual
Welcome to the Affymetrix® GeneChip® Command Console® (AGCC) User Manual. 

This guide describes the functions of the Affymetrix GeneChip Command Console software, version 4.0.

There are several configurations for installing AGCC:

 AGCC and GeneChip (GCS3000 and FS450): Windows XP (32-bit) with SP3 and above and Windows 
7 Professional (64-bit) with SP1.

 AGCC and GeneTitan® System: Windows XP (32-bit) with SP3 and above and Windows 7 
Professional (64-bit) with SP1, works with:

 GeneTitan Instrument (Single Channel)

 GeneTitan Multi-Channel (MC) Instrument

 AGCC Only: Windows XP (32-bit) with SP3 and above and Windows 7 Professional (64-bit) with SP1.

Affymetrix GeneChip Command Console Software
The development of microarray technology means that researchers can now perform more experiments 
and collect more data from each experiment than ever before. Researchers need to analyze and organize 
this mass of data, which presents new challenges for the researchers and the software they use.

Affymetrix GeneChip Command Console (AGCC) provides flexible and powerful tools for:

 Entering and organizing information about the sample and GeneChip probe arrays.

 Controlling the instruments used to process probe arrays and collect the intensity data.

 Tracking the progress of an array through the array processing workflow.

 Working seamlessly with other tools for downstream analysis.

New Features in AGCC 4.0
 AGCC 4.0 supports the new 384 plate format (GeneTitan® Multi-Channel Instrument Control ONLY).

 AGCC 4.0 is compatible with Windows 7 Professional (64-bit) with SP1.

Conventions Used in This Guide
This guide provides a detailed outline for all tasks associated with Affymetrix® GeneChip Command 
Console. Various conventions are used throughout the guide to help illustrate the procedures described. 
Explanations of these conventions are provided below.

Steps

Instructions for procedures are written in a step format. Immediately following the step number is the 
action to be performed. Following the response additional information pertaining to the step may be 
found and is presented in paragraph format. For example:

1. Click Yes to continue.

The Delete task proceeds. 
In the lower right pane the status is displayed. 

To view more information pertaining to the delete task, right-click Delete and select View Task Log 
from the shortcut menu that appears.

Font Styles

Bold fonts indicate names of commands, buttons, options or titles within a dialog box. When asked to 
enter specific information, such input appears in italics within the procedure being outlined.
For example:
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1. Click the Find button or select Edit → Find from the menu bar.

The Find dialog box appears.

2. Enter AFFX-BioB-5_at in the Find what box, then click Find Next to view the first search result.

3. Continue to click Find Next to view each successive search result.

Screen Captures

The steps outlining procedures are frequently supplemented with screen captures to further illustrate the 
instructions given. The screen captures depicted in this guide may not exactly match the windows 
displayed on your screen.

Additional Comments

Resources

Documentation
This manual is available in Adobe Acrobat format (as *.pdf files) on the CD or download package for 
AGCC and is readable with the Adobe® Acrobat Reader® software, available at no charge from Adobe at 
http://www.adobe.com.

The content of this manual is available in context-sensitive online help, accessible by clicking the Help 
links in the different software components.

The AGCC Installation Instructions Manual is also available in PDF format on the CD or download 
package:

Technical Support
Affymetrix provides technical support to all licensed users via phone or E-mail. To contact Affymetrix® 
Technical Support:

TIP: Information presented in Tips provide helpful advice or shortcuts for completing a task.

NOTE: The Note format presents important information pertaining to the text or procedure
being outlined.

IMPORTANT: The Important format presents important information that may affect the
accuracy of your results.

CAUTION: Caution notes advise you that the consequence(s) of an action may be irreversible
and/or result in lost data.

WARNING: Warnings alert you to situations where physical harm to person or damage to
hardware is possible.
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Affymetrix, Inc.
3420 Central Expressway

Santa Clara, CA 95051 USA

E-mail: support@affymetrix.com

Tel: 1-888-362-2447 (1-888-DNA-CHIP)

Fax: 1-408-731-5441

Affymetrix UK Ltd.
Voyager, Mercury Park

Wycombe Lane, Wooburn Green

High Wycombe HP10 0HH

United Kingdom

UK and Others Tel: +44 (0) 1628 552550

France Tel: 0800919505

Germany Tel: 01803001334

E-mail: supporteurope@affymetrix.com

Tel: +44 (0) 1628 552550

Fax: +44 (0) 1628 552585

Affymetrix Japan, K. K.
ORIX Hamamatsucho Bldg, 7F

1-24-8 Hamamatsucho, Minato-ku

Tokyo 105-0013 Japan

Tel: +81-3-6430-4020

Fax: +81-3-6430-4021

salesjapan@affymetrix.com

supportjapan@affymetrix.com
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Getting Started With AGCC

AGCC provides tools that enable you to process arrays, extract the intensity data for use by the probe 
level analysis software, and organize the resulting sets of data files.

You can use AGCC 4.0 to process:

 Cartridge Arrays

 GeneTitan® Array Plates

See The Different Array Types, below, for more information about the differences in the arrays.

To fully use the capabilities of AGCC, you need to understand: 

 The components of the software

 The array processing workflow that the AGCC components perform

 The types of files that AGCC produces and uses

 The structures and tools that AGCC uses to organize the resulting data

This chapter introduces those concepts in:

 The AGCC Software Components on page 11

 Array Processing Workflow on page 15

 File Types in AGCC on page 19

 Data Organization in AGCC on page 22

See the Affymetrix® Data Exchange Console User’s Guide for information on migrating data from 
Affymetrix GeneChip Operating System (GCOS) to AGCC.

NOTE: Before running AGCC for a particular GeneChip Array, you must have the library files
for that array type installed on your computer. For more information, see Prerequisites for
Running AGCC on page 12

NOTE: Norton Antivirus can interfere with AGCC software. The symptom is that AGCC will
stop generating CEL files. If that problem occurs, then you should check the Norton Anti-Virus
settings as described in Appendix B, Settings for Norton Anti-Virus of the AGCC 4.0
Installation Instructions (P/N 702567). 
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The Different Array Types
The AGCC software may be used to process both cartridge arrays and GeneTitan® Array Plates.

An array cartridge contains a single array, which is processed on its own through washing and staining 
and scanning by using the AGCC Instrument Control software with the FS-450 Fluidics Station and the 
GCS3000 scanner. Hybridization is performed using instruments that are not controlled by AGCC. The 
array cartridge is identified by a bar code that can be scanned and used to track the array workflow.

Multiple arrays can be scanned sequentially if you use the GCS 3000 AutoLoader.

A 384 or 96 array plate can be used. A 96 array plate may contain 16, 24, or 96 arrays. All the arrays on 
the plate are processed from hybridization to scanning using the GeneTitan® Instrument or GeneTitan 
Multi-Channel (MC) Instrument and the AGCC GeneTitan® Control software. This allows increased 
automation and consistency in processing when dealing with large numbers of samples 

Figure 2.1  384, 96, and 24 array Array Plates and Cartridge Array shown

Figure 2.2  Arrangement of Arrays on GeneTitan® Array Plate
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The array plate has a barcode for tracking. Each individual array on the plate is identified by its row and 
column. For example, the circled array in the figure below is array D05.

The AGCC Software Components
The features and functions of AGCC vary depending upon which instrument or instruments it is being 
used with:

The AGCC User Manual describes the features and functionality of AGCC.

AGCC is comprised of the following components:

 AGCC Portal: software for sample registration, data organization, and tracking the array processing 
workflow. AGCC Portal uses a web interface for user access. 

Other AGCC components are installed on your computer and run behind the scenes on your computer. 
These include the Indexer, a service that tracks the relationships of files in the AGCC data roots. The 
information is used to keep track of the AGCC files, for example, in the Folders and Projects views. 
The services typically run behind the scenes without user control, but you may need to change their 
configuration in some circumstances. See Affymetrix Services on page 25 for more information.

 AGCC Instrument Control software for processing cartridge arrays:

 AGCC Fluidics Control: Software for running the Fluidics Station 450. 

 AGCC Scan Control: Software for the GeneChip Scanner 3000 (GCS 3000) and GCS 3000 with 
AutoLoader (AutoLoader). 

 AGCC Instrument Control software for processing array plates:

 AGCC GeneTitan® Control software for running the GeneTitan® Instrument or the GeneTitan 
Multi-Channel (MC) Instrument.

 AGCC Viewer: Software for viewing image data and workflow status and performing manual gridding.

In addition, the following tools enable you to migrate data from GeneChip Operating Software (GCOS) 
to AGCC:

 Data Exchange Console (for more information, see the Affymetrix Data Exchange Console User’s 
Guide).

 Reconnector (for more information, see the Reconnector User’s Guide).

Table 2.1  Operating systems for AGCC

Operating System GCS3000/FS450 
Instrument

GeneTitan Family of 
Instruments

Analysis Only 
Workstation

Windows XP (32-bit) Yes Yes Yes

Windows 7 (64-bit) Yes Yes Yes

IMPORTANT: A computer used as a GeneTitan workstation requires a user account with
specific privilege settings. In addition, some of the other features of Windows XP or Windows
7 must be set up in particular ways or disabled to avoid causing problems when running
GeneTitan IC software.

A workstation set up by Affymetrix for use with GeneTitan has a user account called
AFFXUser with these privileges and features already set. If the settings have been changed,
refer to the AGCC Installation Instructions for information about the correct settings.
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Other tools are used to install necessary files or manage other AGCC functions:

 Library File Importer (for more information, see the AGCC Installation Instructions).

 Fluidics Script Installer (see Installing and Updating Protocols on page 147).

 GeneTitan Library File Installer (for more information, see the AGCC Installation Instructions)

 Email Configuration Editor (see Appendix D, Configuring E-mail for the Notification Options on 
page 325).

 Data Uploader Scheduler (see Scheduling AutoUploads on page 73).

Launching the AGCC Components
This section explains:

 Prerequisites for Running AGCC, below

 The Command Console Launcher on page 12

Prerequisites for Running AGCC

Before using AGCC, the following prerequisites must be met:

 The necessary AGCC components are installed.

See the AGCC Installation Instructions.

 The proper Data Root is set up and selected.

See Adding a Data Root on page 54.

 Libraries are installed for the probe array types you wish to process.

See the AGCC Installation Instructions for more information.

 The correct fluidics scripts are installed for the probe array types you wish to process.

See Installing Protocols on page 147.

 If using remote network data storage or linked instrument control systems, you need to perform 
additional configuration.

See Appendix A, Network Functionality for AGCC on Windows XP or Windows 7 on page 301.

The Command Console Launcher

The Command Console® Launcher (Figure 2.3) provides a convenient way to open the AGCC software 
applications.

To start the Command Console Launcher:

 Click the Microsoft® Windows® Start button  and select Programs → Affymetrix → 
Command Console → Affymetrix Launcher; or

 Double-click the Launcher shortcut on the desktop.

The Command Console Launcher opens (Figure 2.3).

NOTE: Norton Antivirus can interfere with AGCC software. The symptom is that AGCC will
stop generating CEL files. If that problem occurs, then you should check the Norton Anti-Virus
settings as described in Appendix B, Settings for Norton Anti-Virus of the AGCC 4.0
Installation Instructions (P/N 702567). 
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The launcher enables you to start the following AGCC software components and tools:

 AGCC Portal: For more information, see AGCC Portal Home Page on page 27.

 AGCC Viewer: For more information, see Chapter 8, Using the AGCC Viewer on page 238.

 AGCC Instrument Control Software:

 For GCS 3000/FS450 systems used with cartridges:

AGCC Fluidics control: For more information, see Chapter 5, Controlling the Fluidics Station 450 
on page 126.

Fluidics Script Installer: For more information, see Installing Protocols on page 147.

AGCC Scan control: For more information, see Chapter 6, Scanning Cartridge Arrays on page 157.

 For the GeneTitan® family of instruments: AGCC GeneTitan Control: for more information, see 
Chapter 7, Controlling the GeneTitan® Instruments on page 204).

In addition, the following tools provide convenient options for transferring data between AGCC and the 
GeneChip Operating Software (GCOS):

 Data Exchange Console: For more information, see Affymetrix Data Exchange Console User’s Guide.

 Reconnector: for more information, see Affymetrix Reconnector User’s Guide.

Other tools are used to install necessary files or manage other AGCC functions:

 Library File Importer: For more information, see AGCC Installation Instructions.

 Fluidics Script Importer: For more information see AGCC Installation Instructions.

Figure 2.3  Command Console Launcher window For Cartridge systems and GeneTitan Family of instruments 

Command Console components for 
performing Array Processing Workflow

Affymetrix Analysis Applications 
for analyzing cell intensity data

Affymetrix Tools for migrating data 
and installing necessary support files

Web resources to learn more about the 
Command Console software and other 

Affymetrix products
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 GeneTitan Library File Installer: (for more information, see the AGCC Installation Instructions)

 Data Upload Scheduler: for more information, see Scheduling AutoUploads on page 73.

 Email Configuration Editor: for more information, see Appendix D, Configuring E-mail for the 
Notification Options on page 325.

The Launcher also provides access to:

 Affymetrix Analysis Applications

 Affymetrix Web Resources:

These web sites provide additional information on using AGCC and Affymetrix probe arrays.

 Affymetrix.com

 Affymetrix.com Support

 NetAffx

To use the Launcher:

 Click on the icon for the component or web page you wish to launch.

NOTE: You can also launch AGCC software components by using the Windows® Start Menu.
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Array Processing Workflow
AGCC is used to process the arrays used in your experiment. While AGCC provides several options and 
alternatives for processing arrays, the recommended workflows for cartridge arrays (Figure 2.4) and for 
array plates  (Figure 2.5) enables you to include data about the sample and experiment and to easily track 
the processing steps for the array or array plate. 

In the recommended array processing workflow for cartridge arrays, you create a sample file as the first 
step, assigning sample attributes and a physical array or arrays to the sample. You then:

 Hybridize the array and sample (step not controlled using AGCC)

 Wash and stain the array

 Scan the array(s) to create Image data (DAT) files. 

After that, AGCC aligns a grid on the DAT files and computes the Cell Intensity data (CEL) file. 

Figure 2.4  Processing cartridge arrays with AGCC

AGCC Cartridge Array 

Processing Workflow
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Arrays in Sample (ARR) files
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Generate Probe Analysis Data in CHP files
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Not performed by AGCC for 
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In the recommended array processing workflow for Array Plates, you create sample files for all the arrays 
on the array plate as the first step. The Hybridization, Fluidics, and Imaging of the array plates are 
completed using the GeneTitan instrument. After that, AGCC aligns a grid on the DAT files and 
computes the Cell Intensity data (CEL) file. 

The CEL data generated in the AGCC software from array plate data or cartridge data can be used by 
other software packages for probe analysis. 

The workflow steps are described in more detail in the following sections:

 Registering Samples and Arrays, below

 Hybridizing Arrays and Samples on page 18

 Washing and Staining the Array on page 18

 Running Scanners on page 18

 Tracking Gridding and CEL file Generation on page 19

The AGCC Sample and data files that are created during the workflow are described in more detail in File 
Types in AGCC on page 19.

Registering Samples and Arrays
In AGCC, the Sample file is the beginning of the data chain for a given experiment. The sample 
information is stored in a Sample file with an ARR extension. The arrays used in analysis and data files 
produced by analysis are linked to this Sample File. 

Figure 2.5   Array Plate Processing Workflow in GeneTitan System

GeneTitan Array Plate 

Processing Workflow
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Hybridize Array Plate 
and Sample



Chapter 2  |  Getting Started With AGCC 17
The information about the sample and experiment are collected as attributes. These attributes can then be 
used to locate particular Sample files in filtering and search operations.

The links between the sample and data files and the AGCC tools used to generate the sample files are 
described in more detail below:

 Template and User Attributes on page 17

 Sample Registration Options on page 17

Template and User Attributes

There are two types of sample attributes in AGCC:

 Template Attributes

 User Attributes

Template Attributes

A template in AGCC is a list of attributes that can be assigned to a Sample file. When you create a 
template, you can specify:

 the attributes included in the template 

 the data type for each attribute

 whether the attribute is required

 value options for a controlled data attribute

After you have created a template you can assign the template to a new Sample file during Batch 
Registration. This automatically adds all the attributes in the template to the Sample file. You can then 
enter values for each attribute. This allows you to standardize the attributes that are assigned to samples.

The template functions are described in Working with Templates on page 292.

User Attributes

User attributes are created dynamically during the registration of a sample and array. This allows you to 
create a quick note for a particular sample file.

User attributes are not listed in a template; they have usually been added to a specific sample file. They 
can be used in filtering and search operations, just like the template attributes.

Sample Registration Options

AGCC provides multiple ways to create Sample files. To select the best one for your operation, evaluate:

 Whether you are creating sample files for cartridge arrays or array plates.

 The number of arrays you are going to be processing.

 Whether you will want to enter sample attributes during registration.

 Whether you will want to enter attributes at a later time.

 Whether you are creating sample files for samples that were processed in a 96-well sample prep plate.

For example:

 Batch Registration enables you to create a group of Sample files for cartridge arrays; you can assign 
attributes to each Sample file, along with one or more arrays.

 Detailed Registration creates a single Sample file for a cartridge array; you can assign attributes and 
one or more arrays to the sample file.

 Quick Registration creates multiple sample files for cartridge arrays, each with a single array and no 
attributes (attributes can be entered later).

 Sample Prep Plate Registration creates sample files for cartridge arrays for samples in up to two 96-
well plates.

 Array Plate Registration creates the sample files for the arrays on an Array Plate for GeneTitan System.

 Editing functions correct problems or add attributes to previously created sample files.
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The Sample registration options are described in Chapter 4, Creating and Editing Sample (ARR) Files on 
page 78.

In addition, the Drop and Scan feature enables you to create a sample file for an array when the array is 
scanned. Drop and Scan is available for:

 Cartridge arrays (see Drop and Scan on page 186)

 Array Plates (see Drop and Scan with Array Plates on page 231) 

Hybridizing Arrays and Samples
For GeneChip cartridge arrays, hybridization is not controlled using AGCC.

For Array Plates, the hybridization is controlled using the AGCC GeneTitan Control software (see 
Chapter 7, Controlling the GeneTitan® Instruments on page 204).

Washing and Staining the Array
Different instrumentation and instrument control software used to process Cartridge Arrays and Array 
Plates.

Cartridge Arrays

The Fluidics Station 450 (FS450) is used to hybridize, wash, and stain the GeneChip probe arrays (called 
arrays in this manual). The FS450 can independently process an array using a different fluidics protocol 
in each of four different modules. 

The AGCC Fluidics Control software is used to control the FS450. A workstation with AGCC Fluidics 
Control software and a Sealevel card installed can control up to eight different fluidics stations. The 
software and its use are described in Chapter 5, Controlling the Fluidics Station 450 on page 126.

Array Plate

The arrays on the Array Plate are washed and stained using the GeneTitan Instrument or the GeneTitan 
MC Instrument, controlled using the AGCC GeneTitan Control software. The software and its use are 
described in Chapter 7, Controlling the GeneTitan® Instruments on page 204.

Running Scanners
Different IC software and instrumentation are used to scan:

 Cartridge Arrays

 Expression Array Plates

 Genotyping Array Plates

Cartridge Arrays

The array is scanned after hybridization, washing, and staining, using one of the following scanners:

 GeneChip Scanner 3000 (GCS3000) (scans one chip only)

 GCS3000 with Autoloader (load up to 48 chips for scanning without operator attention)

The AGCC Scan Control Software is used to control the scanner. The software and its use are described 
in Chapter 6, Scanning Cartridge Arrays on page 157.

Expression Array Plates

The arrays on the array plate are scanned using the GeneTitan Instrument or the GeneTitan MC 
Instrument, controlled by the AGCC GeneTitan Control software. 

The software and its use are described in Chapter 7, Controlling the GeneTitan® Instruments on 
page 204.
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There are some differences in how the arrays from array plates are scanned and the data is managed, 
described on GeneTitan® Array Plates on page 242).

Genotyping Array Plates

The arrays on the genotyping array plates are scanned using the GeneTitan MC Instrument, controlled by 
the AGCC GeneTitan Control software. 

The software and its use are described in Chapter 7, Controlling the GeneTitan® Instruments on 
page 204.

There are some differences in how the arrays from array plates are scanned and the data is managed, 
described on GeneTitan® Array Plates on page 242).

Tracking Gridding and CEL file Generation
After the array has been scanned, AGCC:

 Aligns a grid on the Image (DAT) file to identify the probe cells.

 Computes the probe cell intensity data for the array and creates a CEL file.

 Generates JPG and RPT files.

The AGCC Viewer enables you to track the progress of this step in the workflow and manually correct 
gridding problems, if necessary. The Viewer and its use are described in Chapter 8, Using the AGCC 
Viewer on page 238.

File Types in AGCC
Different types of information are collected by AGCC in different types of files:

 Information about the sample and experiment are collected in Sample files (see Sample Files, below)

 Probe array data generated during scanning and processing are collected in Data files of various types 
(see Tracking Files with GUIDs on page 20).

 Audit and Log files contain information about array processing and other processes (see Other File 
Types on page 21)

Globally Unique Identifiers (GUIDs) are used to track the relationships between Sample files, physical 
arrays, and Data Files (see Tracking Files with GUIDs on page 20)

Sample Files
The Sample (.ARR) file (Figure 2.6) collects two types of information:

 Sample Attributes: information that you can use to interpret the experimental data. It can include 
information about the sample itself, the experimental conditions, or other information you may find 
useful. 

You can use the attributes to search for particular files; some attributes can be used by the probe level 
analysis software during analysis. You can use templates to manage the attributes used for a particular 
experiment (see Template and User Attributes on page 17 for more information).

 Array Information: Information about the array(s) used with the sample. More than one array can be 
associated with the sample. This is useful for tracking replicates; in addition, it can be used to simplify 
tracking data for multi-chip arrays.

Each array is assigned an array name during registration. The array name is used to identify the DAT, 
CEL, and CHP data files that are generated during analysis.
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Tracking Files with GUIDs
A GUID, or Globally Unique Identifier, is assigned to each file for tracking (Figure 2.7). GUIDs are 
numbers generated to track a file that will be unique to that file.

Figure 2.6  Sample File with associated arrays and data files

Figure 2.7  GUIDs in Sample and Data Files
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During Sample registration the Sample file is assigned a Sample File GUID; in addition an Array GUID 
is provided for every array name entered.

Every data file (DAT, CEL, and CHP) generated for an array will contain the Array GUID for the array, 
as well as the GUIDs for each of its parent data files.

The GUIDs enable you to trace the lineage of any data file independent of the file name.

Data Files

A set of data files is produced for each array in the Sample file (Figure 2.6). 

The data files include:

 Image (DAT) file, below

 Intensity (CEL) Data Files on page 21

 Probe Analysis (CHP) Files on page 21

Each file is assigned a GUID, or Globally Unique Identifier, to be used in tracking the relationships 
between Sample files, physical arrays, and data files. See Tracking Files with GUIDs on page 20 for more 
information.

Image (DAT) file

The DAT file contains pixel intensity values collected from an Affymetrix scanner, along with the 
gridding information used during feature extraction.

When a DAT file is regridded, the underlying data used by previously generated CEL files is changed. A 
new GUID is assigned to the regridded DAT file, breaking the link to any previously generated CEL files. 
The CEL files will be linked with the array via array GUIDs, but not to the regridded DAT file. CEL files 
generated after regridding will be linked to the new DAT file via the DAT file GUID and to the array by 
the array GUID. 

Intensity (CEL) Data Files 

The CEL file stores the results of the intensity calculations on the pixel values of the DAT file. This 
includes an intensity value, standard deviation of the intensity, the number of pixels used to calculate the 
intensity value, a flag to indicate an outlier as calculated by the algorithm and a user defined flag 
indicating the feature should be excluded from future analysis. This data is used by the CHP writer 
software to extract the actual data of interest.

JPG Files

JPEG files are a copy of the DAT file in a standard image file format; they provide an image file with a 
reduced file size for QC inspection, archiving, and publication.

Probe Analysis (CHP) Files

These files, which have file extensions ending in CHP, contain the probe analysis data for the array. They 
are produced by the Analysis Application software and contain the actual data of interest (SNP calls, 
expression data, etc., depending upon the array type).

Other File Types
Audit and Log files track the tasks performed by different software components.

Audit Files

An Audit file is an XML file that tracks the processing of each physical array processed by AGCC. An 
Audit file is produced for each physical array and tracks all the processing steps that were performed on 
the array, including multiple scannings and regridding. 

The audit file has the same root name as the physical array.

See Viewing Audit Files on page 44.
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Log Files

Log files are produced by different AGCC components. The logs provide a record of the tasks performed 
by different components, such as the migration tools and the installer.

These log files may provide useful information for troubleshooting problems.

See Appendix E, Log Files Generated by AGCC on page 327 for more information.

Data Organization in AGCC
To use AGCC, you need to understand the structures and tools the software provides for organizing your 
data during and after generation.

This section describes:

 Folders on page 22

 Projects on page 24

 Data Organization Tools in AGCC on page 24

 AGCC Network Functionality on page 25

Folders
AGCC uses the Windows file folders on your hard drive to organize your data; A folder must be 
designated as an AGCC data root, or must be a subfolder of a designated AGCC data root, for the files in 
that folder to be tracked by AGCC (Figure 2.8).

Windows File Folders

These are folders that are on your hard drive, but have not been assigned to an AGCC Data Root, either 
directly or by a parent/child relationship. 

Figure 2.8  Organization of files in AGCC

C:\Command Console\Data Root 1 (on user’s computer)

Subfolder 1 [Project A]

Sample File A1

Sample File A2

SubFolder 2 (not associated with project)
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C:\Command Console\Data Root 2 (on user’s computer)

Subfolder 1 [Project C]

Sample File C1

\\sharename\share\Network Data Root (on network storage)

Subfolder 1 [Project D]

Sample File D1

Sample File X

Windows® File Folder  (not associated with AGCC)
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These file folders are not searched by the Indexer and the files in them are not displayed in the AGCC 
Portal. You can copy AGCC files to a system folder using different AGCC Portal functions, which is 
useful for sharing data with other users.

Data Roots and Subfolders

A Data Root is a folder that has been specified for Command Console data. Data roots are searched by 
the Indexer and the files in them are listed in the AGCC Portal. 

A default data root is created when the software is installed. You can assign other folders as data roots, 
too. A data root can be on the computer running AGCC, or on a network data storage computer connected 
with a Windows network. 

A data root on a local drive is indicated as a local drive path: C:\Command Console\Data for 
example.

Data roots on networked computers are specified using Universal Naming Convention (UNC) paths as 
\\server\share\filepath.

A Subfolder is a child folder created within a data root. The Subfolder and its files are also searched by 
the indexer and listed in the AGCC Portal.

For information about setting the data root, see Managing Data Roots on page 54.

For information about using a data root on a different computer on a Windows network, see Appendix A, 
Network Functionality for AGCC on Windows XP or Windows 7 on page 301.

The data roots and subfolders and their contents are displayed in the Folder view (see Folder View on 
page 29).

File and Folder Security

You can use the Windows Sharing and Security settings to control access to your data when using 
network functionality. AGCC supports setting permissions at the folder level, not the file level, even 
though the Windows settings can be set at the file level. You can change the settings for Sharing, 
permissions, and security for a selected file, but you need to be very careful about setting permissions 
when using AGCC; you could lock yourself out of your own data or deny access to other people if the 
permissions are set incorrectly. Work with your IT department for help in setting the permissions. 

For more information, see Appendix B, Windows Sharing and Security Issues on page 315.

Default Folders

A Default folder is a data root or subfolder that has been set as a destination folder for files produced 
when certain operations are performed:

 Sample and data files produced when performing Drop and Scan.

 Data files for an array that is registered to a Sample file located on network data storage. 

For more information, see:

 Specifying a Default Folder on page 67

 Drop and Scan on page 186

 Drop and Scan with Array Plates on page 231

 AGCC Network Functionality on page 25

 Running Scans on Systems with Network Data Storage on page 160

NOTE: On instrument control workstations, the default data root has to be on the local drive
and cannot be a USB or an external networked drive.
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Projects
A project is a label assigned to a Data Root or Subfolder; the project label can be used to organize Sample 
and data files. If you assign a project name to a Data Root or Subfolder, all the Sample and data files in 
that folder will be assigned that project name. Also, any child subfolders of that project folder will be 
assigned the project name. 

Projects have the following characteristics:

 Any Data Root or Subfolder can be a project.

 All subfolders in a project folder are automatically a part of that project.

 One folder can be a member of more than one project.

 Folders in different locations can be in the same project.

After assigning a project name to a data root or subfolder, any Sample file placed in that data root or 
subfolder is assigned to the project. You can then use the project label to:

 Display file lists grouped by project

 Search on data limited to a project

 Create a spreadsheet listing the Sample (.ARR) files assigned to the project with their attributes. The 
list can be reviewed as a summary of the project information or used to edit the Sample (.ARR) file 
content using Batch Edit.

You can also assign a sample file to a project during its creation. This places the Sample File and the 
associated data files in the folder assigned to the project name.

You can move files between projects using Windows Explorer.

For more information, see Using Projects to Organize Data on page 57.

Data Organization Tools in AGCC
The data organization tools in AGCC enable you to:

 View the files in data roots and folders

 Create and manage projects

 Search for files of interest by various attributes, including sample attributes entered during registration.

Figure 2.9  Projects and folders in a data root
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 Add and remove Data Roots

 Upload data to a data root

In this version of AGCC, you will need to use Windows Explorer for certain data management functions.

See Chapter 3, AGCC Portal and Data Organization on page 26 for more information on the data 
organization tools.

Affymetrix Services 

The Affymetrix Services run behind the scenes on your computer: 

 AGCCAuditLogger

 AGCCIndexer.

 AGCCTaskManager

 AGCCWebServer

If using network functionality, you may need to change the configuration of these services. See 
Configuring AGCC Services on page 307.

Displaying AGCCWebServer Status

For AGCC on XP, the AGCCWebServer enables the display of the AGCC Portal pages; it must be 
running to use AGCC Portal. By default, it starts when the computer boots up.

Normal operation is indicated by an icon in the right side of the Taskbar (Figure 2.10).

AGCC Network Functionality
When AGCC is installed on a computer running Windows XP or Windows 7 and connected to a Windows 
network, it provides additional functionality with options for running the array processing workflow and 
organizing data. These functions include:

 Consolidating the data from multiple AGCC workstations on network data storage.

 Performing different parts of the workflow for an array on different workstations while consolidating 
the data on a single workstation.

You may need to change the settings for some Affymetrix Services to use the network functionality. See 
Appendix A, Network Functionality for AGCC on Windows XP or Windows 7 on page 301 for more 
information.

Figure 2.10  AGCCWebServer Icon in status area of Taskbar
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AGCC Portal and Data Organization
The data organization functions enable you to organize your data and copy files from place to place. The 
functions are described in:

 Starting AGCC Portal, below

 Viewing the Data Organization on page 28

 Searching for Files on page 45

 Managing Data Roots on page 54

 Using Projects to Organize Data on page 57

 Generating Reports and Summaries on page 63

 Copying Files on page 64

 Specifying a Default Folder on page 67

 Uploading Data to Network Data Storage on page 68

Disabling Fast User Switching

Fast user switching is an option in Windows that allows multiple active sessions on the console.

This option must be disabled on computers with AGCC Portal installed, because it may cause a user to 
take actions under a different user ID and ultimately lock the first user from their data.

Refer to your Windows XP or Windows 7 documentation on how to disable Fast User Switching.

Starting AGCC Portal
1. To start AGCC Portal:

1. Open the AGCC Launcher.

2. Click on the AGCC Portal icon.

The Home page appears (Figure 3.1).

NOTE: AGCC provides limited functionality for moving files around. You can use Windows
Explorer for some functions.
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AGCC Portal Home Page
The AGCC Home page (Figure 3.1) is your entry point to the AGCC Portal functions. 

The Home page has the following sections:

 Search Functions (see Searching for Files on page 45)

 Menu Bar (see below)

 Page content with a frame around it.

Figure 3.1  AGCC Portal Home Page

Search Functions
Menu Bar

Page Content
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The Menu bar at the top of the page has the following menus:

The Basic Search Function (Figure 3.2) enables you to search for files by:

 Array Name

 Attribute Value

 File Name

 Project Name

For more information about the search options, see Searching for Files on page 45.

Viewing the Data Organization
You have two different options for viewing the organization of data in AGCC Portal:

 The Folder View displays a list of all the Data Roots in the AGCC system, along with a list of the 
Sample, Data, and other files in a selected Data Root or Subfolder (see Folder View on page 29).

 The Project View displays the Sample and Data files associated with a selected project, showing parent 
and child relationships between the Sample and Data files (see Project View on page 42).

Home page Provides links to:

• AGCC Home Page

• Affymetrix.com web site

• Affymetrix.com/Support web site

• NetAffx Analysis Center

Data Provides links to:

• Folder View (see page 29).

• Project View (see page 42).

• Data Management functions (see Chapter 3, AGCC Portal and Data 
Organization on page 26).

Samples Provides links to:

• Sample Registration functions (see Chapter 4, Creating and Editing Sample 
(ARR) Files on page 78).

Administration Provides links to:

• Project functions (see Using Projects to Organize Data on page 57).

• Template functions (See Working with Templates on page 292).

• Workflow Monitor (see Tracking the Workflow on page 299).

Help Provides links to the online help and other resources.

Figure 3.2  Search controls

Select Search type Enter search string Click to start search
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See Data Organization in AGCC on page 22 for more information about the way data is organized in 
AGCC. 

Windows Security issues can impact your ability to view files and data. See Appendix B, Windows 
Sharing and Security Issues on page 315 for more information.

Folder View
The Folder View displays a list of all the Data Roots in the AGCC system, along with a list of the content 
of a selected data root or subfolder.

To use the Folder View:

 From the View menu, click Folder View.

The Folder View appears (Figure 3.3).

The left side of the page displays the Folders list.

The right side displays the following items:

 Path to the selected folder

 Folder controls: used to open, add, and rename subfolders

 Display controls: used to control the display of attributes and file types

 File List with Select controls: used to select files and perform operations on the selected files

The data roots and project folders are displayed in the Folders list (see below). The contents of the data 
roots and project folders are displayed in the File list (see File List on page 33). 

For a description of the file hierarchy used to organize AGCC files, see Data Organization in AGCC on 
page 22.

The page links enable you to go to additional pages of data.

Figure 3.3  Folder view

File ListFolder list

Folder controls
Display controls

Path to selected folder

Select controls
Page links
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Folders List

The Folders list (Figure 3.5) shows the data roots, folders, and projects used to organize data.

The Folders lists displays the folder names and project names for subfolders. 

Click on a folder to display its contents in the File list (see below).

The Folders controls enable you to:

 Add a folder (see Adding Folders and Projects, below).

 Rename a folder (see Renaming Folders on page 31).

 Open a selected folder in Explorer (see Opening Folders in Explorer on page 32).

Adding Folders and Projects

You can add a new subfolder in a selected data root or subfolder using the Add Folder button. You can 
optionally assign the folder to a project of the same name when you create the folder.

Figure 3.4  Folder view controls

Figure 3.5  Folders list

NOTE: You can add or rename a folder using Windows explorer in addition to the AGCC
Portal functions.

Data Root

Project subfolders

Subfolder without project
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To add a new folder:

1. Select the data root in the Folders list in which you want the new folder to be created.

2. Click the Add Subfolder button in the Folder controls (Figure 3.6).

The Add Subfolder page opens (Figure 3.7).

3. Enter the new folder name in the box.

4. Select the Make folder and create project with same name checkbox to create a project in AGCC 
with the same name as the folder.

5. Click Add Folder.

The Folder View page opens with the new folder and project displayed.

Renaming Folders

You can rename a folder using the Rename Folder link.

Figure 3.6  Folder controls

Figure 3.7  Add Subfolder page with folder name entered

Figure 3.8  New folder

Folder controls
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To rename a folder:

1. Select the folder to be renamed.

2. Click the Rename button in the Folders controls (Figure 3.6).

The Rename Folder page opens (Figure 3.9).

3. Enter the new folder name in the box.

Select the radio button if you want to change the project name, too.

4. Click Rename.

The Folder View page opens with the renamed folder (Figure 3.10).

Opening Folders in Explorer

To open a folder in Explorer:

1. Select the folder to be opened.

2. Click the Open button in the Folders controls (Figure 3.6).

An Explorer window opens displaying the contents of the folder. The AGCC Portal browser shrinks 
to make room for the window (Figure 3.11).

TIP: For information on changing the name of a project, see Managing Projects on page 57.

Figure 3.9  Rename Folder page

Figure 3.10  Folder View with renamed folder
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File List

The file list displays a list of the files and folders in the selected folder (Figure 3.12).

The Display controls, at the top, allow you to change the display of attributes and files.

The select controls allow you to select files for various operations.

The numbered links below the Select controls enable you to switch from page to page of the File list. 
They are displayed only if the number of files in the selected subfolder exceeds the display limit.

By default the File list displays a table of files with the following columns:

Figure 3.11  Explorer window with reduced AGCC Portal browser

Figure 3.12  File List

Select controls

Display controls

File list

Links to other pages
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You can conceal some of these columns and display selected attributes in other columns. For information 
about displaying and concealing columns, see Selecting Attributes for the File List on page 35.

To sort the file list by any column:

 Click on the column header.

File Types

There are several different types of files in the File List:

 Sample files (.ARR)

 Image files (.DAT)

 Intensity Data Files (.CEL)

 Probe Analysis Files (.CHP)

Select Use the checkbox to select a file for different operations:

• Copy Selected Files (see Copying Files on page 64).

• Create Report from Sample files in List (see Copying Files on page 64).

• Change Probe Array Type (see Chapter 9, Changing The Probe Array Type on 
page 289).

See Selecting Files on page 35 for more information.

Placing your cursor over the Select checkbox displays the full path and file name in a 
popup:

FileName The name of the file or folder.

In some cases the file name is a link. Click on the link to open the following file types:

• Folder: displays the contents of the folder in the file list.

• Sample File: opens the Sample/Array Attributes page (see Detailed Sample 
Registration on page 81).

• Image file (.DAT) and Intensity File (CEL): opens the AGCC Viewer (see Chapter 8, 
Using the AGCC Viewer on page 238).

• Audit file (AUDIT): opens the Audit File Viewer (see Viewing Audit Files on 
page 44)

You cannot use the Action link to open the other file types displayed in the File list. 
These file types can be opened using a text editor (.AUDIT, .RPT, .GRD) or the AGCC 
Viewer (.CEL, .JPG).

Project Name The name of the project that contains the file.

Array Name Name assigned to the array during registration.

Barcode Barcode of probe array (may be Affymetrix or custom barcode).

Lot Number Manufacturer’s lot number for the array (only displayed with Affymetrix barcodes).

Expiration Date Expiration date for the array (only displayed with Affymetrix barcodes).

Probe Array 
Type

Model number of probe array.

Date Modified Last date the file was modified.
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 JPG files (.JPG)

 Audit Information files (.AUDIT)

 Grid Data files (.GRD)

 Project files (.Project)

 Report files (.RPT)

For more information about the different files, see File Types in AGCC on page 19.

See Selecting File Types for Display on page 40 for more information about displaying different file 
types.

Selecting Files

You can use the checkboxes in the File list to select files for different operations:

 Copy Selected Files (see Copying Files on page 64).

 Create Report from Sample files in List (see Generating Reports for Selected Sample Files on page 63).

 Create Batch Edit file from Selected ARR Files in List (see Creating the Batch Edit File on page 120).

 Change Probe Array Type (see Chapter 9, Changing The Probe Array Type on page 289).

The Select Files controls allow you to select files and operations. The number of displayed and selected 
files are also displayed.

To select files:

 Click the checkbox next to the file name; or

Click the Select All button.

Click the Unselect All button to unselect selected files.

Selecting Attributes for the File List

You can add or delete attributes for display in the File List using the Folder View feature. The Folder 
view allows you to create and edit lists of attributes to be displayed, called views. You can then select a 
view for display to customize the attributes in the File list.

Selecting a Previously Created View

To select a previously created view:

 In the File controls, select a view from the View drop-down list (Figure 3.14).

NOTE: Other file types, such as PARAM, may not be displayed in the list or the folders.

Figure 3.13  Select Files controls

NOTE: When cartridge users upgrade to 4.0, the default folder view does not have well
position (Pos) in the default folder view. If they have GeneTitan® Array Plate data and want
to see this attribute in the folder view, they will either need to add it to the default folder or
create a custom view with that attribute.
The Pos attribute is part of the standard fields.
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The selected View is displayed.

Creating a New View

To add a new View:

1. Click the View Customize button (Figure 3.14).

The Customize page opens (Figure 3.15).

There are three steps in creating a new View:

A. Entering a name for the view.

B. Selecting the source of attributes.

C. Selecting the attributes and saving the view.

Figure 3.14  File list with View controls

Figure 3.15  Add New Folder View page
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2. Enter a name for the view in the New View Name box and click the Add button (Figure 3.16).

The view name is displayed in the Select Existing View dropdown box (Figure 3.17).

In this step, you select the sources of the attributes (Figure 3.18).

You have several options for doing this:

 You can limit the display to attributes that are organized in templates.

 You can display user attributes which have been created by the user for individual sample files.

 If you want to use standard fields, you can display the fields from all templates, or display attributes 
from templates you select in the Attributes Source list.

3. Select the attributes options and templates

The selected attributes are displayed in the Available Attributes list (Figure 3.19).

Figure 3.16  New View Name

Figure 3.17  New view name in the Select Existing View 
dropdown box.

Figure 3.18  Select Source controls
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The Available Attributes list displays the attributes (with template names) that are not being currently 
displayed.

The Displayed Attributes lists displays the attributes that are currently being displayed in the Folder 
view.

The File Name attribute is required and cannot be hidden. 

4. Select and deselect the items you wish to display and conceal.

You can double-click on an item in one of the lists to move it to the other list or click and drag it over.

You can also use the center controls to add and remove attributes in groups.

Select the Sorted checkbox to display the available attributes in alphabetical order.

5. After selecting the attributes, click the Save button.

The Folder View is displayed with the newly created view selected in the View drop-down box 
(Figure 3.20).

Figure 3.19  Selected templates with attributes
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Editing a View

To edit a created custom view:

1. Click the View Customize button.

The Customize page opens.

2. Select the view you want to edit from the Select existing view dropdown box (Figure 3.21).

You can click the Delete button to delete the selected view.

The attributes in the view are displayed in the Select Attributes section (Figure 3.22).

Figure 3.20  New View added

Figure 3.21  Selecting existing view to edit
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3. Select templates and attributes as described in Creating a New View on page 36

4. After you have selected and arranged the attributes, click Save.

You can click Cancel to cancel the changes.

5. The View is displayed in the Folders list with the new attributes selected. 

Selecting File Types for Display

The File Filter enables you to exclude or include particular file types in the File list.

You can:

 Use a previously created filter

 Create a new file filter.

 Edit a previously created filter

To use a previously created filter:

 In the Filter controls, select the filter from the drop-down list.

The filtered files are displayed. 

To create a new file filter:

1. In the top of the File list, click the File Filter Customize button (Figure 3.24).

Figure 3.22  Selecting attributes

Figure 3.23  Folder list with File Filter controls
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The File Filters page appears (Figure 3.25).

2. Enter a name for the new filter in the new Filter list. 

3. Click Add.

The new filter name appears in the Name box.

4. Enter the file types you wish to exclude or include in the Patterns box.

Format: *.file extension, where * is a wildcard.

Enter multiple file types separated by semicolons (;).

5. Select whether you want to exclude or include the specified file types.

6. Click Save.

The Folder View appears with the edited filter selected.

The displayed files are filtered.

To edit a file filter:

1. In the top of the File list, click the Customize button (Figure 3.23).

The File Filters page appears (Figure 3.26).

Figure 3.24  Folder list with File Filter controls

Figure 3.25  File Filter page
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2. Select the filter you wish to edit from the Filter Name drop-down list.

3. Enter the file types you wish to exclude or include in the Patterns box.

Format: *.file extension, where * is a wildcard.

Enter multiple file types separated by semicolons (;).

4. Select whether you want to exclude or include the specified file types.

5. Click Save.

The Folder view appears with the edited filter selected.

The displayed files are filtered.

Project View
The Project View displays the Sample and Data files associated with a selected project, showing parent 
and child relationships between the Sample and Data files:

 Array name(s)

 Image (DAT) file(s)

 Intensity Data (CEL) file(s)

 Probe Level Summarization (CHP) file(s)

The Project view also displays basic information about a selected file, and will allow you to open and 
view Sample, DAT, and CEL files.

To view the Sample and data files associated with a project:

1. From the View menu, select Project View.

The Project View pages opens.

2. Select a project from the Project list.

A list of the Sample files associated with that project is displayed (Figure 3.27).

You can expand the file structure by expanding and contracting nodes in the tree.

Figure 3.26  File Filter page
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3. Click on a file to display more information about the file in the right side of the page.

Different information is displayed for different files.

4. For certain files, you can click the Open button to display the file:

 Sample files: Opens the Detailed Registration Page (see Detailed Sample Registration on page 81).

 DAT and CEL files: Opens the AGCC Viewer (see Chapter 8, Using the AGCC Viewer on 
page 238).

Selecting Files

You can use the checkboxes in the Project data tree to select files for different operations:

 Copy Selected Files (see Copying Files on page 64).

 Create Report from Sample files in List (see Generating Reports for Selected Sample Files on page 63).

 Create Batch Edit file from Selected ARR Files in List (see Creating the Batch Edit File on page 120).

 Change Probe Array Type (see Chapter 9, Changing The Probe Array Type on page 289).

Figure 3.27  Project view page with list of Sample files.

Figure 3.28  Information for selected CEL file



Chapter 3  |  AGCC Portal and Data Organization 44
The Select Files controls allow you to select files and operations. The number of selected files are also 
displayed.

To select files:

1. Click the checkbox next to the file name; or

Click the Select All button.

Click the Unselect All button to unselect selected files.

When you select a parent file, all its child files are also selected. If you only want to select the parent 
file, deselect its child files after selecting the parent file.

2. Select an operation from the Command to Run dropdown.

Viewing Audit Files
Audit files provide a record of the processing done to an array.

To open an audit file:

1. Click on the link in the File List

2. The Audit File page opens (Figure 3.30).

The Audit File displays information about the processing steps the array has gone through, including the 
instruments and computers used in processing.

Figure 3.29  Select Files controls

Figure 3.30  Audit File page
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Searching for Files
You have two options for locating files in AGCC:

 Basic Search, below

 Advanced Search on page 46

The results are displayed in the Search Results page (see Search Results Page on page 53).

Basic Search
The Search Function (Figure 3.31) enables you to search for files by:

 Array Name

 Attribute Value

 File Name

 Project Name

To search for a file:

1. Select the search criteria from the Search Files By drop-down list.

2. Enter a search string in the text box.

You can perform special searches by using the “*” symbol and “OR” operator

“*” Serves as a wild card function. Using searchstring* will return all arrays that contain an 
attribute that starts with the search string. Using *searchstring will return all arrays that 
contain an attribute that ends with the search string.

Using the “OR” operator between items (searchstring1 OR searchstring2) will return 
all arrays that contain an attribute that matches any of the search strings.

3. Click the Search button .

Files or Projects that match the search string are displayed in the Search Results page (see Search 
Results Page on page 53).

NOTE: Windows Security issues have an impact on the search function. for more information,
see Appendix B, Windows Sharing and Security Issues on page 315.

NOTE: Searching by Attribute Value returns any file with any attribute with a value that
matches the search string. To search for a particular attribute, use the Advanced Search.

Figure 3.31  Search controls

Select Search type Enter search string Click to start 
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Advanced Search
The Advanced search provides several ways to refine your search.

To use the Advanced Search:

1. Click Advanced Search in the Search controls. 

The Advanced Search page opens (Figure 3.32).

You create a search in three steps:

Step 1: Specify Array Search Criteria on page 46

Step 2: Specify Sample Attributes on page 47

Step 3: Select Options on page 51

Step 1: Specify Array Search Criteria

This section enables you to search for arrays that match:

 Barcode

 Probe Array Type

 Array Names

2. Enter the criteria for the information you wish to find.

Figure 3.32  Advanced Search page

Figure 3.33  Array Search Criteria

Array 
Search 
Criteria

Sample 
Attributes

Options
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Step 2: Specify Sample Attributes

This section (Figure 3.34) enables you to specify attributes used to describe the sample and 
experiment. Depending upon how the search is set up, the search may return:

 Samples with any of the specified attributes.

 Samples that match all of the specified attributes.

Four things have to be selected or entered to specify an attribute:

 the attribute’s source (template name or user attribute)

 the attribute name

 the type of comparison

 the value for the attribute

When the Advanced Search page first opens, the sample attributes has three drop-down lists:

 Select Template

 Select Attribute

 Select Comparison

The Enter Value(s) box does not appear until you have selected a template and attribute.

To select an attribute:

3. Select a template or other option from the Select Template drop-down list.

The Select Template list displays a list of the templates used by the files in AGCC. You can also 
select:

 All attributes: allows you to perform a blanket search over every attribute in the Sample files, both 
from templates and from user attributes. 

See Performing an All Attributes Search on page 52 for more information.

 No Templates: allows you to select from user attributes, used in a Sample file but not included in 
a template.

Figure 3.34  Specifying sample attributes

NOTE: The Sample Attribute Conversion function may impact your selection of templates
and attributes. For more information, see Sample Attributes Conversion on page 92.
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4. After selecting the template, a list of attributes appears in the Select Attributes drop-down list 
(Figure 3.36).

5. Select the attribute you wish to search on.

You can perform different types of comparisons for the search. 

If you select a numerical attribute, you can select from the following limits (Figure 3.37):

 Equal to

 Less than

 Less than or equal to

 Greater than

 Between (displays two entry boxes for the range limits).

 Any value

Figure 3.35  Selecting a template

NOTE: If you have converted attribute types in Sample files, you may need to:

 select an attribute from the No Template list and from the template

 Select multiple types of the attribute

See Sample Attributes Conversion on page 92 for more information.

Figure 3.36  Select attribute from list
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F

For date attributes, the comparisons are (Figure 3.38):

 Equal to today

 Within the last week

 On a specific date: (requires date value)

 Before date: (requires date value)

 After date: (requires date value)

 Between dates: (requires date value)

 Any value

For text string or SingleSelect attributes, the comparisons are (Figure 3.39):

 Equal to: exact match to the search string

 Contains: text string containing the search string

Figure 3.37  Comparisons for numerical attributes

Figure 3.38  Comparisons for dates
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6. Select the appropriate comparison for the attribute.

You can use comparisons with user attributes that have the data type specified, as well as sample 
attributes.

7. Enter a string for the attribute in the Enter Value(s) box.

You can perform special searches by using the “*” symbol and “OR” operator when searching for 
Text attributes.

“*” Serves as a wild card function. Using searchstring* will return all arrays that contain an 
attribute that starts with the search string. Using *searchstring will return all arrays that 
contain an attribute that ends with the search string.

Using the “OR” operator between items (searchstring1 OR searchstring2) will return 
all arrays that contain an attribute that matches any of the search strings.

For date attributes, click on the Calendar icon  and select the date from the calendar that appears 
(Figure 3.40).

Click the < and > buttons to display a different month.

8. Click the Add button to add another attribute and repeat Step 3 through Step 7.

9. Select how the searches will be combined:

 Results must match ALL of the selected attributes.

 Results can match ANY of the selected attributes.

After you have finished specifying the attributes, you can select other options.

Figure 3.39  Comparisons for text string attributes

Figure 3.40  Selecting dates
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Step 3: Select Options

This section enables you to search for files that match other criteria:

10. Select or enter the options for the information you wish to find.

You can select multiple items in the Type of Results and Projects list by holding down the Shift key 
and clicking on the items.

You can deselect a project by holding down the Ctrl key and clicking on the project.

For date attributes, click on the Calendar icon  and select the date from the calendar that appears 
(Figure 3.42).

Figure 3.41  Options for limiting search results

Type of results to 
return

Specify one or more of the following types of files:

• ARR

• CEL

• CHP

• DAT

Limit results to the 
Projects

Projects to be searched. Selecting none runs the search through all the files 
in the main data folder and in all the project folders. You can limit your 
search to one or more project folders using this box.

Creation Dates Date of file creation:

• Equal to today

• Within the last week

• On a specific date: (requires date value)

• Before date: (requires date value)

• After date: (requires date value)

• Between dates: (requires date value)

• Any value

Show results Limit on the number of results to be returned.
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Click the < and > buttons to display a different month.

11. Click Search.

The files that match the search criteria appear in the Search Results list. (Figure 3.43)

Performing an All Attributes Search

The All Attribute search allows you to search across all attributes of the following types:

 Date

 Number 

 Text

If you use the All Attributes search, it will return any file that has any attribute with a value that matches 
the search string. 

Figure 3.42  Select date

Figure 3.43  Search Results list
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Search Results Page
The Search Results page lists the files that meet the criteria specified in your search (Figure 3.44).

You can:

 Change sort order of the list by clicking at the head of the column you wish to sort by.

 Change the attributes displayed in the list with the View controls (see Selecting Attributes for the File 
List on page 35).

 Use the Select controls to select files for various operations.

Placing your cursor over the Select checkbox displays the full path and file name in a popup 
(Figure 3.45):

Selecting Files

You can use the checkboxes in the Selected column to select files for different operations:

 Copying Selected Files to a different location (see Copying Files on page 64).

 Create Report from Sample files in List (see Generating Reports for Selected Sample Files on page 63). 
The Report can be used to review the file attributes.

 Create Batch Edit file from Selected ARR Files in List (see Creating the Batch Edit File on page 120)

 Change Probe Array Type (see Chapter 9, Changing The Probe Array Type on page 289).

The Select Files controls allow you to select files and operations. The number of selected files are also 
displayed.

Figure 3.44  Search Results list

Figure 3.45  Popup showing path 
and name

Figure 3.46  Select Files controls
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To select files:

1. Click the checkbox next to the file name; or

Click the Select All button.

Click the Unselect All button to unselect selected files.

2. Select an operation from the Command to Run dropdown.

Managing Data Roots
A data root is a folder used to contain data files for AGCC. The folder and files are displayed in the Folder 
View of Command Console®. A default data root at C:\Command_Console\Data is created during 
installation, but you can create additional data roots to help you organize data from different researchers 
or for other purposes.

For more information about data roots, see Folders on page 22.

You can:

 Create a data root (see Adding a Data Root, below)

 Remove a data root (see Removing a Data Root on page 56)

Adding a Data Root

To add a data root:

3. From the Data menu, select Data Roots → Add.

The Add Data Roots page opens (Figure 3.47).

IMPORTANT: Each workstation has its own data roots. Setting the data root on one station
does not add the data root on other machines.

IMPORTANT: Please make sure that the data roots used in AGCC software on the instrument
control workstations do not contain files that have non-Affymetrix file extensions (eg .DLL,
.TMP, .CPP, .ASPX, .OUT, etc). 
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The Data Root page displays a list of the data roots currently assigned in AGCC and the folders that 
can be selected as data roots. Expand the tree to view and select child folders.

4. Select a folder for the new data root from the Data Root list; or

In the Add a New Data Root box, enter the full path name and the name of the new data root.

Data roots on networked computers are specified using Universal Naming Convention (UNC) paths 
as \\server\share\filepath.

The folder cannot be:

 In the Windows directory

 In the Program Files directory

 In a root directory

5. Click Add.

The list displays the new data root (Figure 3.48).

Figure 3.47  Data Root page

IMPORTANT: To select a data root on a networked computer, you must configure the
AGCC Services to permit access. See Configuring AGCC Services on page 307 for more
information.

IMPORTANT: Please make sure that the data roots used in AGCC software on the
instrument control workstations do not contain files that have non-Affymetrix file
extensions (eg .DLL, .TMP, .CPP, .ASPX, .OUT, etc). 
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The new data root is also visible in the Folder View (see Folder View on page 29).

Removing a Data Root

To remove a data root:

1. From the Data menu, select Data Roots → Remove.

The Remove Data Root page opens (Figure 3.49).

The Remove Data Root page displays a list of the data roots available to AGCC.

2. Select the radio button next to the data root.

3. Click Remove.

Figure 3.48  New data root added

Figure 3.49  Remove Data Root page

NOTE: You cannot delete the default data root. You must assign default status to another
data root before deleting the current default data root. See Specifying a Default Folder
on page 67 for more information. 
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Using Projects to Organize Data
A project is a label assigned to a Data Root or Subfolder that can be used to organize Sample and data 
files. If you assign a project name to a Data Root or Subfolder, all the Sample and data files in that folder 
will be assigned that project name. Also, any child subfolders of that project folder will be assigned the 
project name. A project name can be assigned to multiple Data Roots or Subfolders, in order to group 
data on multiple folders together.

Project folders enable you to organize your data. After organizing data into projects you can:

 Display data grouped by project

 Search on data limited to a project

 Create a spreadsheet listing the Sample (.ARR) files assigned to the project. The list can be reviewed 
as a summary of the project information or used to edit the Sample (.ARR) file content using Batch 
Edit.

The Projects functions provide tools for:

 Managing Projects

 Copying Files

Managing Projects

To open the Manage Projects page:

 From the Administration menu, select Project → Manage.

The Manage Projects page opens (Figure 3.50).

IMPORTANT: Deleting a data root in AGCC does not delete the actual root directory or data
files in Windows.

Figure 3.50  Manage Projects page
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The page has a folders list on the left side, similar to the one in the Folder View page.

The work area on the right has controls that allow you to:

 Create a new Subfolder.

 Assign a project name to a folder.

 Designate a primary folder for a project.

 Add or delete folders for a project.

Creating a Project

The Create New Project controls of the Manage Projects page allows you to:

 Assign a previously created Data Root or Subfolder to a Project

 Create a Subfolder and assign it to a project.

To create a Subfolder and Project:

1. From the Administration menu, select Project → Manage.

The Project Management page opens (Figure 3.52).

Figure 3.51  Create New Project controls

TIP: You can also create a folder and project using the Create Folder function in Folder View
(see Adding Folders and Projects on page 30).
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2. In the Folders tree, select the Data Root or Subfolder where you want to create the new Subfolder and 
Project (Figure 3.53).

3. Enter a Subfolder name in the Create Subfolder box (Figure 3.54) and click the Create Subfolder 
button.

Figure 3.52  Manage Projects page

Figure 3.53  Folder selected as location for new subfolder

NOTE: The name of the location folder will be entered automatically in the Create New
Project box. Ignore this if you do not wish to use the same name for folder and project.
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The new Subfolder appears in the Folders list (Figure 3.55).

4. Select the folder that you created in the previous steps in the Folder list.

The folder name appears in the New Project box and the path to the folder appears. (Figure 3.56).

5. Enter a new project name, if desired, and click Create.

The selected subfolder has a project label assigned to it. (Figure 3.57).

Figure 3.54  Entering name of new Subfolder

Figure 3.55  New subfolder created

Figure 3.56  Project name entered
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You can also assign a project label to a previously created subfolder by:

1. Selecting the subfolder in the Folders list

2. Entering a Project name in the New Project box and clicking the Create New Project button.

Managing Existing Projects

The Manage Existing Projects controls of the Manage Projects page (Figure 3.58) allows you to:

 Add an existing subfolder to a previously created project.

 Specify a Primary Subfolder for a project with multiple subfolders. A Primary subfolder functions as 
the default folder for the project. The Primary Subfolder cannot be deleted.

 Delete subfolders that are not Primary Subfolders.

 Delete a selected Project. 

Figure 3.57  New subfolder with project label assigned

NOTE: This deletes only the Project label. The subfolders and files are not deleted. 

Figure 3.58  Manage Existing Projects controls
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To add an existing Subfolder to a previously created project:

1. Select the project from the Select Project dropdown list (Figure 3.58).

2. Select the Subfolder to be added in the Folders list.

The Add button appears with the path of the selected folder (Figure 3.59).

3. Click the Add button.

The selected Subfolder is added to the Projects Folder list (Figure 3.60).

Projects with multiple folders will have one folder specified as the primary folder. When files are 
assigned to the project during registration, they will be placed in the Primary folder for the project. The 
Primary folder cannot be removed from the project; you must designate another folder as the Primary or 
delete the entire project.

To designate a primary subfolder for a project:

1. Select the project from the Select Project Dropdown.

The folders associated with the project are displayed in the Project Folder list (Figure 3.60).

2. For the folder you wish to designate as primary, click the Primary checkbox.

The folder will be designated as the primary folder.

NOTE: You can assign a Subfolder to more than one project.

Figure 3.59  Add button with path

Figure 3.60  Folder added to Projects Folder list
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To remove Subfolders from a project:

1. Select the project from the Select Project Dropdown.

The folders associated with the project are displayed in the Project Folder list (Figure 3.60).

2. Click the red X for the folder you wish to remove. 

The subfolder will be removed from the project.

To delete a Project:

1. Select the project from the Select Project Dropdown.

The folders associated with the project are displayed in the Project Folder list (Figure 3.60).

2. Click the Delete Project Name button. 

The project is deleted.

Generating Reports and Summaries
You can generate

 Reports for selected Sample Files, below

 A summary report file for the Sample files in a Project (see page 64)

Generating Reports for Selected Sample Files
You can generate a report file in a tab-delimited text format on selected Sample (ARR) files, which you 
can then view in a text editor or spreadsheet program. 

You can also create a Batch Edit file for the selected sample (ARR) file. See Creating the Batch Edit File 
on page 120 for more information.

To generate a report for selected Sample files:

1. Select the Sample files from the:

 Folder view page (see page 35)

 Project view page (see page 43)

 Search Results page (see page 53)

2. From the Command to Select dropdown (Figure 3.61), select Create Report from Selected Arr files 
link.

NOTE: You cannot remove primary folders from the project using this method. Designate
another folder as primary or delete the entire project, as described above.

NOTE: This deletes only the Project label. The subfolders and files are not deleted. 

NOTE: This deletes only the Project label. The subfolders and files are not deleted. 
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The report is created and the Summary page opens (Figure 3.62).

The page displays the location and file name of the report.

The report file can be viewed in a text editor or spreadsheet program.

Generating a Project Summary
You can create a report for the Sample (.ARR) files in a project.

The report can be used to review data.

To generate a Project Summary:

1. From the Administration menu, select Projects → Summary.

The Generate Summary page opens.

2. Select the project you wish a report on from the drop-down list.

3. Click the Create button.

The Summary page displays the name and location of the generated report.

The report file can be viewed in a text editor or spreadsheet program.

Copying Files
The Copy Files function enables you to select files and place a copy of those files to a new location.You 
can select:

 The Sample (.ARR) files in a project.

 Selected Sample (.ARR) files in: 

 Folder view page (see page 35)

 Project view page (see page 43)

Figure 3.61  Create Report command

Figure 3.62  Summary page
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 Search Results page (see page 53)

This can be useful for giving other users access to data. 

Projects are described in Using Projects to Organize Data on page 57 of this manual.

To copy files associated with a project:

1. From the Data menu, select Copy Project.

The Copy files page opens (Figure 3.63).

2. Select a destination folder from the Folders List, or

Enter the path to the destination folder in the Destinations box.

3. Select a project for copying from the Projects drop-down.

4. Select the file types you wish to copy:

 Sample (ARR)

 Audit

 Image (DAT)

 Intensity Data (CEL)

 Probe level summarization (CHP)

 The file types are described in File Types on page 34.

NOTE: You do not have to copy files to a Data Root or subfolder; you can copy to any folder
you have access to.

Figure 3.63  Copy Files page
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5. Click Copy.

The progress of the transfer is displayed in the Status window.

To copy selected files:

1. Select the Sample files from the:

 Folder view page (see page 35)

 Project view page (see page 43)

 Search Results page (see page 53)

2. From the Command to Select dropdown, select Create Report from Arr files in List link.

The Copy files page opens (Figure 3.65).

Figure 3.64  Status window

Figure 3.65  Copy Files page
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3. Select a destination folder from the Folders List, or

Enter the path to the destination folder in the Destinations box.

4. Review the Files to be copied list.

5. Click Copy.

The progress of the transfer is displayed in the Status window (Figure 3.66).

Specifying a Default Folder
The Default folder is used as a destination folder for data when:

 Performing Drop and Scan.

 Scanning data for an array for a Sample (.ARR) file located on another computer, connected through a 
network.

See Appendix A, Network Functionality for AGCC on Windows XP or Windows 7 on page 301 for more 
information on the Network functionality of AGCC.

When AGCC is installed, C:\Command_Console\Data\Default is used for the default folder.

You can change the Default folder if you wish.

To change the Default folder:

1. From the Data menu, select Default Folder. 

The Set Default Folder page appears (Figure 3.67).

Figure 3.66  Status window

Figure 3.67  Set Default Folder
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A Folder list is displayed on the left side of the page. The right side displays the current default folder 
and the selection controls.

2. Select a folder from the Folder list. You can select a data root or a subfolder.

3. Click Set.

The selected folder is used for the Default folder.

Uploading Data to Network Data Storage
You can create Sample (.ARR) files on any data root your AGCC system has access to, including network 
data storage. However, you cannot create DAT files over a network connection to network data storage; 
instead, the DAT files are created in the Default folder on the local computer. This is done to protect the 
DAT file from any problems related to the networks, so that an array can always be scanned successfully 
even when a network is unreliable.

The Upload Data function can be used to automatically transfer DAT, CEL, and other files from the 
Default folder to the network data storage where the Sample (.ARR) file is located. Upload Data is useful 
when you wish to consolidate data from different workstation computers onto one network data storage 
site.

The use of the Data Upload function is explained in:

 Uploading Data Manually on page 71

 Scheduling AutoUploads on page 73

The Overview section below provides information on why you may wish to use the Upload Data function.

NOTE: This option is available only when you have a network data root enabled. For more
information, see Appendix A, Network Functionality for AGCC on Windows XP or Windows 7
on page 301.
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Overview
You can create Sample (.ARR) files on any data root your AGCC system has access to, including network 
data storage (Figure 3.68).

However, you cannot create DAT files over a network connection to network data storage; instead, the 
DAT files are created in the Default folder on the Scanner Workstation computer (Figure 3.69). This is 
done to protect the DAT file from any problems related to the networks, so that an array can always be 
scanned successfully even when a network is unreliable.

Figure 3.68  Creating a Sample (ARR) file on a network data root

Creating the Sample (ARR) File on the Network Data Root

Create a Sample (Arr) file for the sample and arrayon the Network Data Root using AGCC Portal sample registration functions

Windows
Network

AGCC Scanner Workstation Network Data Storage

Physical Array Name

Tissue Type B Array 1

Sample (ARR) File

Tissue Type B.ARR

Network Data Root

Researcher Folder

Scanner Workstation

Data Root

Default Folder
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The Upload Data function can be used to automatically transfer DAT and CEL files from the Default 
folder to the network data storage where the Sample (.ARR) file is located (Figure 3.70). Upload Data is 
useful when you wish to consolidate data from different workstation computers onto one network data 
storage site.

Figure 3.69  Creating DAT and CEL files on the Scanner Workstation Default Folder

Scanning the Array on the Scanner Workstation

Windows
Network

Scan the array using the Scanner Workstation. Since AGCC cannot create a DAT file over a Windows network, the DAT and CEL file will be 
created on the Scanner Workstation Data Root.

AGCC Scanner Workstation Network Data Storage

Image (DAT) File(s)

Tissue Type B Array 1.DAT

Intensity (CEL) File(

Tissue Type B Array 1.CEL

Scanner Workstation

Data Root

Default Folder

The DAT file  on the Scanner Workstation Data 
Root is linked with the Sample (ARR) file on the 
Network Data Root.

Physical Array Name

Tissue Type B Array 1

Sample (ARR) File

Tissue Type B.ARR

Network Data Root

Audit File

Tissue Type B Array 1.Audit

Researcher Folder
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Uploading Data Manually

To upload data:

1. From the Data menu, select Upload Data.

The Upload Data page is displayed (Figure 3.71).

Figure 3.70  transferring the DAT and CEL files using the AGCC Upload Data function

TIP: If the network connection goes down during the scan, you may end up with duplicate
Sample (ARR) files for a single physical array. You can use the Affymetrix Reconnector to
merge these duplicate files and restore the proper parent-child connections between files.
See the Affymetrix Reconnector User’s Guide for more information.

Transferring the DAT and CEL Data with AGCC Data Upload

Windows
Network

AGCC Scanner Workstation Network Data Storage

Finally we move the DAT and CEL file to the same folder as the ARR file on the Network Data Root using the AGCC Upload Data function

Scanner Workstation

Data Root

Default Folder

Physical Array Name

Tissue Type B Array 1

Sample (ARR) File

Tissue Type B.ARR

Network Data Root

Image (DAT) File

Tissue Type B Array 1.DAT

Intensity (CEL) File

Tissue Type B Array 1.CEL

Researcher Folder

Audit File

Tissue Type B Array 1.Audit
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A new page opens with info on the files to be uploaded (Figure 3.72).

The page displays a list of data files in the Default folder that are associated with a Sample (ARR) 
file on a network drive:

2. Click Start Uploading to upload the files to the locations.

A notice informs you that the move is in progress (Figure 3.73).

Figure 3.71  Upload Data page

Figure 3.72  Data for uploading displayed

From Current location and file name.

To The file destination (location of the Sample (.ARR) file).

Status The current status of the move.
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The status of the move is displayed in the lower part of the page, with a list of the files that have been 
transferred and their status.

When the upload is finished, the status is displayed in the page (Figure 3.73).

The uploaded files can be seen in their new location (Figure 3.74).

Scheduling AutoUploads
The Data Uploader Scheduler enables you to run the Data Upload automatically on a schedule you 
determine.

To schedule auto-uploads:

1. Click the Data Uploader icon  in the Affymetrix Launcher. 

The AGCC Data Uploader Scheduler window opens (Figure 3.75).

Figure 3.73  Move in progress

Figure 3.74  Data in new location
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The dialog box has three tabs:

 Task

 Schedule

 Settings

The Task tab allows you to set the options for the task itself.

2. In the Run box, enter the path to the file to be run as a scheduled task.

Use quotation marks around the task path if the path includes spaces.

3. Enter information in the Start In box on the location of the folder with the task or other necessary files.

4. Use the Comments box for notes about the task.

5. In the Run As box, enter the user account for running the scheduled task.

Specify user account (must be the same account used for the AGCC Services, with permissions on 
both the computer and the remote storage location).

6. Enter the password for the user account:

A. Click Set Password.

The Set Password dialog box opens (Figure 3.76).

B. Enter and confirm the password for the user account and click OK in the Set Password dialog box.

7. Select other options:

Figure 3.75  AGCC Data Uploader Scheduler, Task 
tab.

Figure 3.76  Set Password dialog box
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 Run only if logged on.

 Enabled (scheduled task runs at specified time).

8. Click the Schedule tab to set up the schedule for the upload.

The default setting is to run the upload function daily at 2 AM.

The Schedule tab (Figure 3.77) provides options for setting the schedule.

9. Select a period for performing the task from the Schedule Task drop-down.

You can schedule the task to run:

 Daily

 Weekly

 Monthly

 Once

 At System Startup

 At Logon

 When idle

The options for task schedule change with the time period (Figure 3.78).

Click Advanced Options (Figure 3.79) to set Start/Stop dates and to specify how often to repeat the task. 

10. Enter a time for the task to start in the Start time box.

Figure 3.77  Schedule tab with settings for daily task

Figure 3.78  Settings for Weekly task
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11. You can enter multiple schedules:

A. Select the Show Multiple Schedules checkbox.

A schedule drop-down list appears at the top of the tab screen with New and Delete buttons.

B. Click New to create a new schedule.

C. Set the schedule using the Schedule Task controls, as described in steps 9 and .

D. Click Delete to delete a scheduled task.

12. Click the Settings tab.

Figure 3.79  Advanced Schedule Options 
dialog box

Figure 3.80  Multiple schedules
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The Settings tab (Figure 3.81) enables you to set options for the upload:

 Scheduled Task Completed: Use these to set the options for a task that is only running once.

 Idle Time: Use these to start the task only if the computer has been idle for a specified period of time

 Power Management: Use these to set the options for power management if using a laptop.

13. Click OK when you have finished setting the task, schedule, and settings options.

The task is scheduled and will run at the set times.

When the scheduled time comes, the Upload Utility window (Figure 3.82) appears on your desktop and 
shows the progress of the upload.

You can set up the AGCC Email Configuration Editor to notify you when the Upload Utility runs or if 
problems arise. See Appendix D, Configuring E-mail for the Notification Options on page 325 for more 
information.

Figure 3.81  Settings tab

Figure 3.82  Upload utility running
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Creating and Editing Sample (ARR) Files
Sample Registration is the first step in the recommended array processing workflow (Figure 4.1).

For information on scanning arrays without registering them first, see Drop and Scan on page 186.

This chapter describes the following options for creating Sample files and registering arrays:

 Detailed Sample Registration on page 81

 Quick Sample Registration on page 97

 Batch Registration on page 101

 Sample Prep Plate Registration on page 108

 GeneTitan Array Plate Registration on page 111

You can also edit previously created Sample (.ARR) files

 Editing Files and Copying Attributes on page 87

 Adding a Barcode to a Sample file on page 117

 Batch Editing on page 120

For information on selecting a Sample Registration method, see Registering Samples and Arrays on 
page 16.

See Introduction to Sample Registration for an introduction to the types of information that can be 
collected in a Sample file.

Figure 4.1  Array processing workflow

AGCC  Array Processing 

Workflow

Register Sample(s) and Assign 
Arrays in Sample (ARR) files

Perform Wash and Stain operations on 
array(s) in Fluidics Station

Scan Probe Array and 
Save Image Data in DAT files

Review grid alignment and perform 
manual gridding if necessary

Analyze Cell Intensity Data and 
Generate Probe Analysis Data in CHP files

Hybridize Array(s) and Sample (not 
performed by AGCC for Cartridge Arrays)
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Introduction to Sample Registration
To get the most out of AGCC, you need to understand the types of information that are collected in the 
Sample file, as described below:

 Information in the Sample File, below

 Characters Allowed in AGCC on page 80

Information in the Sample File
In AGCC, the samples are the beginning of the data chain for a given experiment. The sample information 
is stored in a Sample file with an ARR extension. 

The Sample (ARR) file collects two types of information:

 Sample Attributes: information that you can use to interpret the experimental data. It can include 
information about the sample itself, the experimental conditions, or other information you may find 
useful.

 Array Information: Information about the array(s) used with the sample. More than one array can be 
associated with the sample. This might be useful for making sure that data from products that contain 
more than one array remain related or to help describe experiments that use replicates.

Sample Attributes
There are two types of attributes in AGCC:

 Template Attributes, which have the attribute name, data type and other information specified in a 
template.

For more information on creating and managing templates, see Working with Templates on page 292.

 User Attributes, which are created individually during registration.

Each attribute in a template is assigned one of the following data types:

 Text: Text string

 Number: Integer or floating point number

 Date: Calendar data

 SingleSelect: Presents a list of items for the user to choose

User Attributes may be Text, Number, or Date data types.

Beta Versions of AGCC included other deprecated data types which are no longer available, such as:

 Integer

 Floating Point

 MultiSelect

The data type determines the type of value that can be entered, and the types of comparisons that can be 
performed during an Advanced Search.

Array Information

The Sample file also contains information about the array(s) used with the sample. More than one array 
can be associated with the sample. This is useful for tracking replicates; in addition, it can be used to 
simplify tracking data for multi-chip arrays, such as 500K arrays.

Each array is assigned an array name during registration. The array name is used to identify the DAT, 
CEL, and CHP data files that are generated during analysis (Figure 4.2).
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The array information includes:

 Array Name

 Probe Array Type

 Barcode (can be Affymetrix barcode or custom barcode provided by the user)

Characters Allowed in AGCC
You can only use a certain set of characters in AGCC Sample File names, Folder Names, Project Names, 
and Array Names:

These names can contain:

 Basic Latin letters (A-Z, a-z)

 Digits (0-9)

 Spaces

 The following set of punctuation marks: ! # $ % & ' ( ) + , - . ; = @ [ ] ^ _ ` { } ~ 

These names cannot use the following characters: \ / : * ? " < >|

International characters are not allowed.

Sample attribute names can contain: 

 Numbers

 Letters

 International characters

 The following set of punctuation marks: ! # $ % & ' ( ) + , - . ; = @ [ ] ^ _ \ / ` ~ 

Sample Attribute names cannot contain any of the following characters: { } : * ? " < > |

Sample attribute values of Text type can contain any characters.

Figure 4.2  Sample File with associated arrays and data files

Sample File (Sample.ARR)
With Sample Attributes

Array name: FirstArray
(used for DAT, CEL, and CHP files)

Array name: SecondArray 
(used for DAT, CEL, and CHP files)

DAT File (FirstArray.DAT)

CEL File (FirstArray.CEL)

CHP File (FirstArray.CHP)

DAT File (SecondArray.DAT)

CEL File (SecondArray.CEL)

CHP File (SecondArray.CHP)
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Detailed Sample Registration
The Detailed Sample Registration page enables you to register a single sample and its associated cartridge 
arrays, along with any sample attribute you wish to include. You can use templates to determine which 
attributes need to be entered for registration, and you can add user attributes that are unique to that 
sample. 

You cannot register a GeneTitan® System array plate using the Detailed Sample Registration (use 
GeneTitan Array Plate Registration, described on on page 111).You can add a cartridge array to a 
previously created array plate Sample file with the editing functions of the Detailed Sample Registration. 

For more information see Creating a New Sample File, below.

The page can also be used for:

 Editing previously created Sample files

 Renaming a Sample file and/or the Array name

 Copying the attribute data over to a new file

 Adding physical arrays to an existing Sample (Arr) file

For more information, see Editing Files and Copying Attributes on page 87.

If you have edited or deleted templates and attributes, you may need to change the attributes in a Sample 
file when you try to edit it. For more information, see Sample Attributes Conversion on page 92.

Creating a New Sample File

To create a new Sample File:

1. From the Samples menu, select Register.

The Detailed Sample Registration page opens (Figure 4.3).

Figure 4.3  Detailed Sample Registration page

Project and File Name

Sample Attributes
from Templates

Additional Sample
Attributes

Arrays
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The Detailed Sample Registration page has four sections:

 Project and File Name (at the top of the page)

 Sample Attributes from Templates

 Additional Sample Attributes

 Arrays list

2. Select a Project from the drop-down list (optional) (Figure 4.4).

3. Enter a name in the Sample File Name box (Figure 4.4).

The Sample Attributes from Templates section displays a list of the attributes in the Default template 
when the page is first opened.

You can:

 Enter attribute values for the Default template (see Step 6 on page 83).

 Add and remove templates with additional attributes (optional—see Step 4, below).

4. To add Templates, use one of the following options:

 Select the template from the drop-down list and click Select (Figure 4.6); or

 Use the following steps:

1) Click Options.

The Template Select page opens (Figure 4.7).

Figure 4.4  Entering Project and File Name

TIP: See Managing Default Templates on page 298 for more information about selecting
or changing the default templates.

Figure 4.5  Sample Attributes from Templates

Figure 4.6  Template List
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The page displays a list of the available templates on the left side.

The right side displays a list of the attributes in the selected templates.

2) Select the template(s) you wish to use.

3) Review the attributes in those templates in the Sample Attribute list.

4) Click Select to add selected templates to the Sample (.ARR) File.

The Detailed Sample Registration page returns with the attributes in the selected template(s) 
displayed (Figure 4.8).

Click Cancel to return to the Detailed Sample Registration page without adding templates.

5. To delete a selected template and all its attributes:

 Click the red x at the top of the template’s attribute list (Figure 4.8).

6. To enter values for the Template Attributes:

A. Enter values for the text, numerical, and date attributes.

B. Select values from the drop down lists for the SingleSelect attributes (Figure 4.9).

NOTE: You can also use the Template Select page to delete templates from the Sample
(ARR) file.

Figure 4.7  Template Select page

Figure 4.8  Added Templates

Click to delete selected 
template and all 
attributes
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7. Add user-defined attributes to the Sample by using the Additional Sample Attributes list:

A. Click Add under the Additional Sample Attributes list.

An empty line appears in the list (Figure 4.10).

B. Enter the attribute name and value.

C. Select an attribute type for the user attribute:

 Text: text string

 Number: Floating point or Integer

 Date: Calendar data

The attribute type determines the sorts of comparisons you can perform during an advanced 
search. For more information, see:

 Sample Attributes on page 79

 Advanced Search on page 46

D. Repeat to add more attributes.

The Arrays list (Figure 4.11) enables you to assign an array or set of arrays to the Sample (.ARR) files.

Figure 4.9  Entering values for the sample attributes

Figure 4.10  Additional Sample Attributes list after adding new field

Figure 4.11  Arrays list
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You can include the following information on the array(s):

 Barcode (optional)

 Array Type

 Array Name

To assign an array to the Sample (.ARR) file:

8. Enter the barcode (optional):

Enter the barcode using the keyboard; or

A. Click in the Barcode field. 

B. Use the barcode reader to scan in the barcode on the array (Figure 4.12).

The reader reads and sends the barcode to the Barcode field.

The array’s lot number and expiration date are displayed below the barcode (Affymetrix barcodes 
only).

Probe Array Position is an attribute for the GeneTitan® System array plates and is not applicable 
to cartridge arrays.

9. Select the array type.

The Derive array names from sample names checkbox is selected by default and an array name is 
created by linking:

 The Sample file name entered in the first set of steps

 The array type

 Incremental numbers added if necessary to distinguish arrays

Figure 4.12  Reading the array barcode

NOTE: You can use custom barcodes to register an array in Detailed Sample
Registration.

NOTE: If you are using Affymetrix barcodes, the array type will be selected automatically
after the barcode is entered. If you are using custom barcodes, you will need to select the
array type manually.
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10. If you wish to enter a different array name:

A. Deselect Derive array names from sample names checkbox.

B. Enter the name in the Array Name column.

To register additional arrays:

11. Click Add Array.

An empty line appears in the list (Figure 4.14).

The line enables you to enter data on an array.

12. After you have entered arrays, click Save.

A notice that the Sample file has been successfully saved appears in a dialog box (Figure 4.15).

Figure 4.13  Arrays list with array entered

Figure 4.14  Array list with second array added

Figure 4.15  Sample File 
Saved notice
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Editing Files and Copying Attributes
You can use the Detailed Sample Registration to:

 Edit data in the Sample (.ARR) file

 Rename the Sample (.ARR) file 

 Change the Array name in the Sample file

 Copy attributes over to a new file

To open the Detailed Sample Registration page for a Sample file:

 Click the Sample file link in the Folder View or Search Results pages.

 While displaying information about a Sample file in the Project view, click the Open button.

If there are template and attribute discrepancies, the Sample Attributes Conversion page will open. 

See Sample Attributes Conversion on page 92 for more information about what you should do.

There are additional controls in the page when you have opened a previously created Sample file 
(Figure 4.16).

The Rename button allows you to change the name of the Sample file or array.

The Save As button copies the sample attribute and array type information over to a new Detailed 
Registration page which can be used to create a new file.

If you have made changes in a template used for the array file since creating the array file, you will see 
a notice and the Update button at the top of the Detailed Sample Registration page.

Figure 4.16  Detailed Sample Registration page with controls for editing
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Click the Update button to review the differences between the attributes and to correct the problem. 

See Sample Attributes Conversion on page 92 for more information.

Editing the Data in a Sample File

To edit the sample attributes in a Sample file:

1. Open the Sample file in the Detailed Sample Registration page.

2. Edit the attributes as desired.

3. Click the Save button.

A notice that the Sample file has been successfully saved appears in a dialog box (Figure 4.18).

Renaming the Sample File

To rename a Sample (.ARR) file:

1. Open the file in the Detailed Sample Registration page.

2. Click the Rename button next to the Sample File Name at the top of the page.

3. The Sample name can now be edited, and the Save button at the bottom of the page is replaced by the 
Rename button (Figure 4.19).

Figure 4.17  Warning message and Update button

NOTE: You cannot edit the barcode or array type information after an array has been
scanned.

Figure 4.18  Sample File 
Saved notice

IMPORTANT: If the Derive Array Name from Sample File Name checkbox is selected,
changing the Sample file name will result in changing the names of all the data files
associated with the Sample file.
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4. Enter a new name for the Sample file.

5. Make other changes as necessary.

6. Click the Rename button at the bottom of the page.

The Rename Sample File page opens with list of the DAT and CEL files that will be renamed 
(Figure 4.20).

Figure 4.19  Using the Rename function

Figure 4.20  Rename Sample page
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7. Click Yes to rename the sample file.

The page displays a list of the files with the new names (Figure 4.21).

Changing the Array Name(s) for a Sample File

Changing the array name for a sample file results in renaming all the data files associated with the array.

This can be done while editing or renaming a file.

To rename the array name(s) for a Sample file:

1. Open the Sample file in the Detailed Sample Registration page.

2. Deselect the Derive array names from sample file name checkbox.

3. Click in the Array name column of the array you wish to rename.

The Rename Notice appears (Figure 4.22).

4. Click OK and edit the Array Name(s).

5. Click Rename or Save in the Detailed Sample Registration page.

The Rename Arrays page opens with a list of the files that will be renamed.

Figure 4.21  Rename Sample File page with notice of changed data files

Figure 4.22  Rename notice



Chapter 4  |  Creating and Editing Sample (ARR) Files 91
6. Click Yes to rename the arrays and the data files.

The page displays a list of the files with the new names (Figure 4.24).

Copying File Data Over to New File

To copy file data over to a new Sample (.ARR) file:

1. Open file in Detailed Sample Registration page.

2. Click the Save As button by the Sample File Name box.

The Sample File Name becomes editable and the Barcode information for the arrays is erased.

The Save As button is not available for GeneTitan® System sample files.

3. Enter a name for the new Sample file.

4. Edit the Sample Attribute information if desired.

5. Enter new Array Type and Barcode information.

6. Click the Save button.

The Sample File Saved notice appears (Figure 4.25).

Figure 4.23  Rename Arrays page

Figure 4.24  Rename Arrays page with notice of changed data files
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Sample Attributes Conversion
You may see the Sample Attributes Conversion page (Figure 4.26) when you try to open a Sample file 
for editing.

The Sample Attributes Conversion page appears when there is a discrepancy between the properties of 
an attribute in the Sample file and the properties of the attribute as defined in the current template.

Attribute conversion may be necessary if any of the following changes have been made in a template:

 The attribute has been deleted from the template.

 The entire template has been deleted from AGCC.

 The data type for the attribute in the template is different from the data type in the Sample file.

The page displays the attributes with discrepancies and the conversion that will be applied to correct the 
discrepancy. Depending upon the type of discrepancy, the attribute will either: 

 Be converted to a user attribute, with Text type.

 Have its attribute type changed to match the template.

To apply the conversions:

1. Review the conversions in the Original Attribute and Converted Attribute lists (Figure 4.27).

The details are described in:

Figure 4.25  Sample File 
Saved notice

Figure 4.26  Sample Attributes Conversion page
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 Deletion of Attribute or Template on page 93

 Change in Attribute Type on page 94

2. Click Yes in the Sample Attributes Conversion page.

The Detailed Sample Registration page opens with the Sample file displayed. 

The converted attributes will be displayed in the Detailed Sample Registration page, but the 
conversions will not be applied to the Sample file until you:

3. Click Save in the Detailed Sample Registration file.

The changes will be applied to the Sample file. 

The attribute conversion may affect how you search for Sample files using that particular attribute in the 
Advanced search page. The sections below describe this in more detail.

For more information about templates and data types, see:

 Sample Attributes on page 79

 Working with Templates on page 292.

Deletion of Attribute or Template

If the attribute has been removed from the template, or if the entire template has been deleted, the attribute 
in the Sample file will be converted to a user-defined Sample attribute (Figure 4.28).

This is indicated by the blank cell in the Template column for the converted attribute. The new user 
attribute name will use the original attribute name with the original template name in square brackets to 
indicate the source, as in the example 
Disease Status [Sept_Template].

In case of a name conflict, the new user attribute will have an underscore-number (_1) added to the 
attribute name:

Disease Status_1 [Sept_Template].

Figure 4.27  Conversion details

Figure 4.28  Attribute deleted from template (converted to user attribute)

Attribute type changed in template

Attribute deleted from template

Attribute added to template



Chapter 4  |  Creating and Editing Sample (ARR) Files 94
The user attribute will be listed in the No_Template attribute list in the Select Template dropdown list of 
the Advanced Search page (Figure 4.29).

If other Sample files still have the original template attribute, the template will be listed in the Select 
Templates list (Figure 4.30).

When doing an advanced search, if you want to find Sample files having the previous attribute type and 
the current attribute type, you will need to select both attributes in the Select attributes section 
(Figure 4.31).

For more information about performing searches, see Advanced Search on page 46.

Change in Attribute Type

Each attribute in a template is assigned to one of the following data types:

 Text: Text string

Figure 4.29  Advanced Search: selecting a user attribute 
from the No Template list

Figure 4.30  Advanced Search, Unconverted attributes 
in template attribute list

Figure 4.31  Advanced Search, specifying converted and unconverted attributes
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 Number: Integer or floating point number

 Date: Calendar data

 SingleSelect: Presents a list of items for the user to choose

Beta Versions of AGCC included other data types which are no longer available, such as:

 Integer

 Floating Point

 MultiSelect

The data type determines the type of value that can be entered, and the types of comparisons that can be 
performed during an Advanced Search.

In this case, the results of the Attribute conversion depends upon the original attribute data type and the 
new attribute data type in the template. 

 If the data types are compatible, the sample attribute will be converted to the new data type.

The Sample Attributes Conversion page shows the old and new attribute data types (Figure 4.32). 

If the data types are not compatible, the existing sample attribute will be added as a user attribute with 
the text data type.

This gives you the option of manually transferring the attribute value to the new template attribute and 
deleting the added user attribute.

The attributes are converted according to the rules in the table below.

Figure 4.32  Conversion details

Table 4.1  Conversion rules

Old Sample File Data 
Type

New Template Attribute data 
type

Results

Text Number The attribute is converted to user attribute.

Date The attribute is converted to user attribute

SingleSelect Attribute type converted if it matches to one of the 
items in the Selection list; otherwise the attribute is 
converted to user attribute.

Number Text Attribute type converted.

Date Attribute is converted to user attribute.

SingleSelect Attribute is converted to user attribute.

Attribute type changed in template

Attribute deleted from template



Chapter 4  |  Creating and Editing Sample (ARR) Files 96
If the sample attribute has the data type changed, you will be able to find the attribute listed for the 
template in the Advanced Search screen (Figure 4.33).

If the attribute type is changed, but it remains in the template, the type of comparisons you can perform 
when searching for the attribute may change.

If converted to a user attribute, you will need to select the attribute from the No Template list in the 
Specify Sample Attributes section of the Advanced search (Figure 4.34).

Integer and Float (no 
longer supported)

Number Attribute type converted.

Text Attribute type converted.

Date Attribute is converted to user attribute.

SingleSelect Attribute is converted to user attribute.

Date Text Attribute type converted.

Number Attribute is converted to user attribute.

SingleSelect Attribute is converted to user attribute.

SingleSelect Text Attribute type converted.

Number Attribute is converted to user attribute

Date Attribute is converted to user attribute

MultiSelect (no longer 
supported)

Text Attribute type converted.

Number Attribute is converted to user attribute

Date Attribute is converted to user attribute

SingleSelect Attribute is converted to user attribute

Figure 4.33  Advanced search, selecting new attribute 
type

Table 4.1  Conversion rules

Old Sample File Data 
Type

New Template Attribute data 
type

Results
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If other Sample files still have the original attribute type, the attribute will be listed with both the old and 
new attribute types. 

 The current attribute type in the template will have (current type) appended to the attribute name

 The previous attribute type will have (previous type) appended to the attribute name.

When doing an advanced search, if you want to find Sample files with the previous attribute type and 
with the current attribute type, you will need to select both attributes in the Select attributes section 
(Figure 4.35).

For more information about performing searches, see Advanced Search on page 46.

Quick Sample Registration
The Quick Sample Registration enables you to create a set of Sample (ARR) files quickly with the 
following basic information for the Sample and Array: 

 Probe Array Type

 Sample File Name and Array Name

 Project

 Barcode (optional) 

Barcodes and sample attributes can be added later on using various editing options. For more information, 
see Adding a Barcode to a Sample file on page 117 and Batch Editing on page 120.

Both the Sample (.ARR) file and the array name will have the same value when using Quick Sample 
Registration. As an example, Sample1.ARR will have a physical array entry called Sample1. 

You can create up to 48 Sample (.ARR) files (one AutoLoader carousel’s worth) at a time.

Figure 4.34  Advanced Search: selecting converted 
attributes from a template

Figure 4.35  Advanced Search, specifying converted and unconverted attributes
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To create a set of Sample files with basic information:

1. From the Samples menu, select Quick Register.

The Quick Sample Registration page opens (Figure 4.36).

2. Select the number of Sample (.ARR) files to create (Figure 4.37).

You can add up to 48 arrays (an AutoLoader Carousel’s worth) during one quick registration 
operation.

NOTE: This function works best for registering arrays that are not part of a set. If your array
set contains an A and B array then use Register or Batch Register to create sample files (ARR).

You cannot use Quick Sample Registration to register GeneTitan® System Arrays.

Figure 4.36  Quick Sample Registration page

Figure 4.37  Drop-down list
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 Select a number from the drop-down list.

Blank array information lines appear in the Array list (Figure 4.38).

3. Set default values for all projects and/or probe array types (optional):

A. Select a project for the Project drop-down list.

B. Select a probe array type from the Probe Array Type drop-down list.

The selected projects and probe arrays appear in the Array list (Figure 4.40).

You can change the values for any sample file later on. Selecting these options will not erase your 
previously entered values for probe array type and project.

4. (Optional) Enter the barcode using the keyboard; or

Figure 4.38  Add Details section with added rows

Figure 4.39  Set Defaults

Figure 4.40  Add Details section with default probe array and project selected
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A. Click in the Barcode box. 

B. Hold a GeneChip probe array in front of the barcode reader and squeeze the trigger for 
approximately four seconds until you hear a beep. 

The array’s lot number and expiration date are displayed below the barcode (Affymetrix barcodes 
only).

5. Enter a name for the Sample (.ARR) file and the Array name (used for the DAT, CEL, and CHP files).

6. Change the project or probe array type using the individual drop-down lists in the list.

7. To delete un-needed Sample (.ARR) files:

A. Select the checkbox in the row.

B. Click Delete.

8. Click Next.

The Confirm Page opens (Figure 4.42).

The page displays the status of the sample files, indicating any errors that would prevent the 
registration.

These errors can include

 Same Sample (.ARR) file name

 Missing file name

 Other conflicts with previously registered arrays

If errors appear for certain sample files, but other sample files are correct, you can click the 
Corrections link to return to the Quick Sample Registration page and correct the errors.

9. Click Next to register the valid sample (.ARR) files.

The Finish page appears (Figure 4.43).

NOTE: You can use custom barcodes to register an array in Quick Sample Registration.

Figure 4.41  Sample names entered

Figure 4.42  Confirm page



Chapter 4  |  Creating and Editing Sample (ARR) Files 101
Click the Edit link to open the Sample file in the Detailed Sample Registration page (see Detailed 
Sample Registration on page 81)

You can use the links in the lower left corner of the screen to open the AGCC Scan Control or 
AGCC Fluidics Control software for further processing of the arrays.

Batch Registration
The batch registration features enable you to create multiple Sample (.ARR) files with different 
information, entering data using a specially formatted batch registration file. 

Custom barcodes can be used in batch registration.

Batch registration involves three different sets of steps:

1. Downloading an Empty Batch Registration File, below.

2. Entering values for the arrays into the batch registration file.

See Entering Values in the Batch Registration File on page 103.

3. Uploading the data in the batch registration file to create the Sample (.ARR) files.

See Uploading the Batch Registration File on page 106

Downloading an Empty Batch Registration File
The batch registration file is downloaded as an Excel workbook.

To download a batch registration file:

1. From the Samples menu, select Batch Registration.

The Batch Sample Registration page opens (Figure 4.44).

Figure 4.43  Quick Sample Registration Finish page
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2. Select the templates you wish to use by placing a check in the box next to their names (Figure 4.45).

You can display the attributes in the template by clicking on the template name.

Figure 4.44  Batch Sample Registration page

Figure 4.45  Select Templates (with attributes displayed for template)
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3. Specify the number of samples. The maximum number of samples for which the downloaded 
worksheet works well is 1000.

4. Specify project and array type for the Sample files.

5. Click Download to download the Excel workbook.

When using AGCC Portal, the Excel program displays the created workbook, which you can edit and 
save on your computer.

Entering Values in the Batch Registration File
The Batch Registration file can be used to enter data for several different Sample (.ARR) files at once.

The downloaded batch registration file is an Excel workbook with three worksheets:

 Samples worksheet, where you enter the data

 General info worksheet (do not edit), where AGCC Portal stores information about Array types, 
projects, and file format

 Template Info worksheet (do not edit), where AGCC Portal stores information about the template 
attributes

The columns in the Samples worksheet have column headers that define the information on the Sample 
files, the physical array, and the attributes:

NOTE: You cannot create .TSV files in AGCC 4.0, but you can use .TSV files. created in previous
versions of AGCC to perform batch registration. See Appendix F, Using TSV Files for Batch
Editing on page 329.

Figure 4.46  Batch Registration Workbook, Samples Worksheet

Sample File 
Path

The path to where the Sample file will be created. Can be used to place Sample files in 
project folders.

Project The project that the Sample (.ARR) file will be assigned to.

NOTE: Specify either the Path or the Project for the files. Specifying both will return an error
message.
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Path

The path needs to be associated with a data root. You can assign a set of sample files to a particular project 
if you select that project's folder in the Path field. 

Project

Specifying a project for the Sample file will determine the folder the Sample file is created in.

You can select the project from a drop-down list (Figure 4.47).

Sample File Name

Enter the name assigned to the Sample file that will be created.

Array Name, Array Type, and Barcode

If you are using Excel, you can select the probe array type from a drop-down list (Figure 4.48). 

You can also enter multiple array information for a single sample file.

Sample File Name Unique identifier for the Sample file.

Array Name Name assigned to the array during registration.

Probe Array Type Part number for the array(s).

Barcode Barcode on the array(s).

Attributes Additional information about the sample and experiment that you 
can use to interpret your results.

NOTE: Specify either the Path or the Project for the files. Specifying both will return an error
message.

Figure 4.47  List of projects

Figure 4.48  List of probe 
arrays
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To enter multiple arrays:

1. Enter the sample file information (File path, project, and file name) on a separate line of the 
worksheet for each array you wish to use.

2. Enter a different array name for each array for the sample.

3. Select the array type from the Probe Array Type list.

4. Enter the array barcodes in the appropriate lines.

5. Make sure that the attributes are the same for all sample entries.

Attributes

Enter the values for the attributes in the appropriate columns. 

You can select the value for a SingleSelect attribute from a drop-down list (Figure 4.50).

AGCC uses two types of attributes for Batch Registration:

 Template Attributes: Attributes that have been defined in a template. When you select templates for the 
downloaded batch registration file, the array attributes in those templates will be included as headings 
in the batch registration file.

 User Attributes: Attributes that you add in the Batch Register file.You create a user attribute by 
entering the attribute name and other characteristics in the column header, and then entering attribute 
values in the appropriate cells.

NOTE: You can use custom barcodes to register an array in Batch Registration.

Figure 4.49  Worksheet with multiple arrays entered for samples

Figure 4.50  Selecting the 
value for a SingleSelect 
attribute
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Attributes need to have the following characteristics defined:

 AttributeName

 TemplateName (if any; not used for User Attributes)

 DataType

 Required status, if any

The column headings are in the format:

 Header format for Template Attribute: 
AttributeName:TemplateName:AttributeType:RequiredStatus

 Header format for User Attribute: AttributeName:*:AttributeType

Uploading the Batch Registration File

To upload the Batch Registration File:

1. Enter the file path and name in the box (Figure 4.52); or

Click Browse to open the Choose File dialog box (Figure 4.53).

Figure 4.51  Template and user attributes in the Batch Edit file

Figure 4.52  Upload file

Template Attributes User Attribute
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 Select the Batch Registration file and click Open.

The file and its path is displayed in the box.

2. Select the Allow Custom Barcodes checkbox to use barcodes that are not provided by Affymetrix.

3. Click Upload.

If there are problems with the workbook, an error notification page appears (Figure 4.54).

The error messages indicate problems such as bad barcodes, problems with registering multiple arrays 
on a sample, etc.

 Click Cancel to cancel the registration and fix the problems; or

Click Save to register the valid records.

If the upload doesn’t have a problem the Folders View page appears with the newly created folders.

Figure 4.53  Choose File window

Figure 4.54  Error notification.
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Sample Prep Plate Registration
Sample Prep Plate Registration provides a convenient way to register samples and cartridge arrays for up 
to two 96-well plates by using an Excel workbook.

To perform Sample Prep Plate Registration for a target prep plate:

1. Download the Sample Prep Plate Registration File, below

2. Enter Data in the Workbook on page 108

3. Upload the Excel file with data into AGCC.

Download the Sample Prep Plate Registration File

To download the Sample Prep Plate Registration file:

1. From the Samples menu, select Sample Prep Plate Registration.

The Sample Prep Plate Registration page appears (Figure 4.55).

2. Click Download to create a blank Sample Prep Plate Registration file.

The Excel program displays the created workbook, which you can edit and save on your computer.

Enter Data in the Workbook

To enter data for the Sample Prep Plate Registration file:

 Enter a sample (.ARR) file name and Affymetrix GeneChip barcode for each well position you are 
analyzing using Excel or text-editing software. 

The blank Sample Prep Plate Registration file (Figure 4.56) is an Excel workbook with two tabs, to 
enable use with arrays that require two prep plates. 

The worksheet rows are marked A through H, corresponding to the plate rows. 

The worksheet columns are marked 1 through 12, corresponding to the plate columns.

Figure 4.55  Sample Prep Plate Registration page
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For each well position, enter the Sample name for the Sample (.ARR) and the barcode for the probe 
array.

Upload the Data for the Files

1. From the Samples menu, select Sample Prep Plate Registration.

The Sample Prep Plate Registration page appears.

2. Enter the path or click Browse to select the plate registration file.

3. Select a project for the Sample (.ARR) files (optional).

4. Enter plate IDs if registering samples for two plates.

The Array names will be based on the Sample Name entered in the worksheet, concatenated with the 
plate ID, if any, and the Well position as indicated by their position in the worksheet. 

5. Click Upload.

The Confirm page appears (Figure 4.57).

Figure 4.56  Excel File for the target prep plate
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The page displays a list of the Sample (ARR) files created for the plate, along with Sample name, 
barcodes, and array names. 

Error messages are displayed if there is a problem. These errors must be corrected before finishing 
the registration.

If there are any errors:

A. Click Cancel

B. Check the plate worksheet.

C. Proceed with the upload again.

6. Click Next.

The Finish page opens (Figure 4.58).

Figure 4.57  Confirm page
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Click Create Summary Spreadsheet for Batch Edit to open the Summary page and create a workbook 
summary of the Sample files that can be used for batch editing the Sample (ARR) files.

GeneTitan Array Plate Registration
GeneTitan Array Plate Registration provides a convenient way to register samples and plate arrays for an 
Array Plate by using an Excel workbook.

A 384 or 96 array plate can be used. A 96 array plate  (Figure 4.59) may contain 16, 24, or 96 arrays.

Allow for increased automation and processing times for large array counts.

The array plate has a barcode for tracking. Each individual array on the plate is identified by its row and 
column. For example, the circled array in the figure below is array D05.

Figure 4.58  Finish page

Figure 4.59  96 and 24 array Array Plates and Cartridge Array
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There are three sets of steps:

 Downloading the GeneTitan Array Plate Workbook, below.

 Filling out the Workbook on page 113.

 Uploading the Workbook on page 115.

Downloading the GeneTitan Array Plate Workbook

To download the Excel Workbook:

1. From the Samples menu, select GeneTitan Array Plate Sample Registration.

The GeneTitan Array Plate Sample Registration page appears (Figure 4.61).

Figure 4.60  Arrangement of Arrays on Array Plate
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2. Select the templates you wish to use by placing a check in the box next to their names (Figure 4.62).

You can display the attributes in the template by clicking on the template name.

3. Specify the GeneTitan Array Plate type and the project for the Sample files (required).

4. Click Download to download the file.

The Excel program displays the created workbook, which you can edit and save on your computer.

Filling out the Workbook
The Batch Registration file can be used to enter data for all of the plate arrays on an array plate in one 
operation. 

The downloaded workbook has three worksheets:

 Samples worksheet, where you enter the data

 General info worksheet (do not edit), where AGCC Portal stores information about Array types, 
projects, and file format

Figure 4.61  GeneTitan Array Plate Registration page

Figure 4.62  Select Templates
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 Template Info worksheet (do not edit), where AGCC Portal stores information about the template 
attributes

The Sample worksheet has columns with headers that define the property being entered.

Some properties define the sample and data files file and the physical array:

Figure 4.63  Excel file for Batch GeneTitan Array Plate Registration

Sample File 
Path

The path to where the Sample file will be created. Can be used to place Sample files in 
project folders.

Project The project that the Sample (.ARR) file will be assigned to.

NOTE: Specify either the Path or the Project for the files. Specifying both will return an error
message.

Plate Type Model of array plate.

Probe Array Type The array type on the plate.

Probe Array 
Position

Column and row position for the plate array.

Barcode Plate barcode: can be entered when you upload the batch 
registration file.

Sample File Name Name to be used for the Sample (ARR) file.

Array Name Name to be used for the array plate and for all the data files (DAT, 
CEL, and CHP)

Attributes Additional information about the sample and experiment that you 
can use to interpret your results.
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Path

The path needs to be associated with a data root. You can assign a set of sample files to a particular project 
if you select that project's folder in the Path field. 

Project

Specifying a project for the Sample file will determine the folder the Sample file is created in.

If you are using Excel, you can select the project from a drop-down list (Figure 4.47).

Plate Type, Probe Array Type, Probe Array Position

These items specify the array plate type, the plate array type, and the array plate position.

They are automatically filled out when you create the plate batch workbook file. 

File Names

Enter the name assigned to the Sample file that will be created.

Barcode

This is the array plate barcode; if you enter a barcode into the A05 probe array position barcode cell, the 
same barcode is copied automatically into all of the other rows.

Sample File and Array Name

Enter the names to be used for:

 The Sample (ARR) file.

 The Array plate and for all the data files (DAT, CEL, and CHP) for the array on the Array Plate.

Attributes

Enter the values for the attributes in the appropriate columns. See Attributes on page 105 for more 
information.

Uploading the Workbook

To upload the workbook:

1. From the Samples menu, select GeneTitan Array Plate Registration.

The GeneTitan Array Plate Sample Registration page appears (Figure 4.61).

2. Enter the file path and name in the Registration file box (Figure 4.65); or

NOTE: Specify either the Path or the Project for the files. Specifying both will return an error
message.

Figure 4.64  List of projects in Excel workbook
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Click Browse to open the Choose File dialog box (Figure 4.66).

 Select the array plate registration file and click Open in the Choose File dialog box.

The file and its path is displayed in the Registration file box.

3. Enter the plate barcode if it was not entered into the workbook.

4. Click Upload.

If there are problems, the Errors page appears.

 Click Cancel to correct problems before trying the upload.

IF there are no problems, the Confirm Batch Sample Registration page opens (Figure 4.68).

Figure 4.65  Upload file

Figure 4.66  Choose File window

Figure 4.67  Error notice
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5. Click Save to register the valid records.

The page displays a message that the Batch Sample Registration is complete (Figure 4.69).

Adding a Barcode to a Sample file
You may not have the barcode available when the Sample file is first created; if so, you can add it later 
using the Add Barcode page. 

To add a barcode to a Sample file:

1. From the Samples menu, click Add Barcode.

The Add Barcode page opens (Figure 4.70).

Figure 4.68  Confirm Batch Sample Registration

Figure 4.69  Confirmation page, upload successful

NOTE: The Add Barcode page can only be used to add one barcode at a time. The Batch Edit
workbooks can be used to add barcodes to multiple sample files or multiple barcodes to one
sample file in a single operation (see Batch Editing on page 120).

The Add Barcode page cannot be used to add a barcode for a Array Plate. Array Plate barcodes
must be provided at the time of registration
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2. Enter the barcode:

Enter the barcode using the keyboard; or

A. Click in the Barcode field. 

B. Use the barcode reader to scan in the barcode on the array. 

The reader reads and sends the barcode to the Barcode field.

3. Click Search Arrays.

A list of Array names for that type of array that need a barcode appears in the Array list (Figure 4.71).

Figure 4.70  Add Barcodes page
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4. Select the checkbox for the array that corresponds to the array barcode.

5. Click Assign Barcode.

If it is successful, the result page is displayed (Figure 4.72).

If the assignment was unsuccessful, the Add Barcode page is displayed with an error message.

Figure 4.71  Sample files displayed

TIP: You can use the View drop-down box and Customize button to add or delete attributes
for display in the Array list. See Selecting Attributes for the File List on page 35 for more
information.
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Batch Editing
Batch Edit enables you to make edits to a set of previously created Sample (.ARR) files.

Using Batch Edit involves three sets of steps:

1. Create a batch edit file listing the files you wish to edit, using the Project view, Folder, Search Results 
view, or use a previously created batch registration Excel file.

2. Edit the batch edit file, adding and changing attributes as needed.

3. Upload the batch edit file using the Batch Edit Upload function.

Creating the Batch Edit File
You can create a batch edit file for:

 The Sample (.ARR) files in a project or folder (see Generating a Project Summary on page 64).

 Selected Sample (.ARR) files (see below)

Figure 4.72  Results page

NOTE: Batch edit cannot be used to create new Sample (.ARR) files. Use the various Sample
Registration functions described in this chapter to create new files.

NOTE: Batch edit cannot be used to change file or array names. Use the editing functions of
the Detailed Sample Registration page to do this. See Editing Files and Copying Attributes on
page 87 for more information.
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To generate a Batch Edit File for selected Sample files:

1. Select the Sample files from the:

 Folder view page

 Project view page

 Search Results page

2. From the Command to Select dropdown, select the Create Batch Edit Files from Selected Arr files 
link.

The Summary page opens (Figure 4.73).

A list of Sample (ARR) files that will be in the summary appears.

3. Select a template to be used in editing (optional).

4. Click Create.

The Excel program displays the created workbook (Figure 4.74), which you can edit and save on your 
computer.

You can also edit a previously created Batch Registration file, adding attributes as needed. See Entering 
Values in the Batch Registration File on page 103 for more information about editing Batch Registration 
files.

Figure 4.73  Summary page
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Editing the Batch Edit File
The downloaded Excel workbook has three worksheets:

 Samples worksheet

 General info worksheet (do not edit)

 Template Info worksheet (do not edit)

The header row of the Samples worksheet includes special properties that define the file and the physical 
array:

The General Information Worksheet and the Template Info Worksheet (both marked Do Not Edit) contain 
information used by AGCC in processing the data in the workbook.

Make the changes in the summary file to edit the files. You can:

 Enter attribute values

 Add user attributes with values

 Delete attributes from the Sample (ARR) file

The following items in the workbook must not be edited.

Figure 4.74  Batch Edit Excel Workbook, Samples worksheet

Sample File Path The path to where the Sample file is located. 

Sample File Name Unique identifier for the Sample file.

Array Name Name assigned to the array during registration.

Probe Array Type Part number for the array(s).

Barcode Barcode on the array(s)

Attributes Additional information about the sample and experiment that you can use to 
interpret your results.

NOTE:  You can not make changes to file names or array names using this feature. Do not
make changes to file names in the downloaded file.

Sample File Path Path and Sample (.ARR) file name

Array Name Array name assigned to the files
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The first row of the workbook defines the data to be edited. Each additional row contains the information 
for one Sample (.ARR) file. 

Multiple Arrays for a Single Sample (ARR) File

If you have multiple arrays assigned to a single sample file, each array will be on a separate line of the 
worksheet.

You cannot enter different attributes values for the same attributes for arrays associated with the same 
Sample (ARR) file.

Editing the Barcode

You can only add a barcode to a Sample (ARR) file that does not already have one. You cannot edit a 
barcode that is already assigned to the Sample (ARR) file.

 If you assign an Affymetrix barcode to a Sample file, you will see a warning message if the probe array 
type specified in the barcode doesn’t match the probe array type previously assigned to the array.

 You can assign a custom barcode to a Sample file.

Editing Attributes

Enter the values for the attributes in the appropriate columns. See Attributes on page 105 for more 
information.

Uploading the Edited File
After editing the batch edit file, you need to upload the data into AGCC. 

To upload the data:

1. From the Samples menu, select Batch Edit Upload.

The Batch Edit Attribute page opens (Figure 4.76).

NOTE:  If you delete a the entire column for a template attribute, including the header, then
an error will be generated. In order to remove attribute values from a sample file, users need
to leave the header intact and remove the attribute values from the column

Figure 4.75  Multiple arrays



Chapter 4  |  Creating and Editing Sample (ARR) Files 124
2. Enter the file path and name in the box; or

Click Browse to open the Choose File dialog box (Figure 4.77).

 Select the Batch Registration or Batch Edit file and click Open.

The file and its path is displayed in the box.

3. In the Upload Spreadsheet section, click on Upload.

If there is a problem with the workbook, the Confirm Batch Edit Sample Files page (Figure 4.78) 
presents a warning notice.

Figure 4.76  Batch Edit Attribute page

Figure 4.77  Choose File window
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The error messages indicate problems such as bad barcodes, problems with registering multiple arrays 
on a sample, etc.

If there are no problems, the Confirm Batch Edit page opens (Figure 4.79).

4. Click Save to edit the valid records.

The page displays a message that the batch edit is complete.

Figure 4.78  Error notice

Figure 4.79  Confirm Batch Edit
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Controlling the Fluidics Station 450
Hybridizing and processing the array is the next step after sample registration in the recommended array 
processing workflow (Figure 5.1).

The Fluidics Station 450 is used to hybridize, wash, and stain the GeneChip® probe arrays (called arrays 
in this manual). The FS450 can independently process an array using a different fluidics protocol in each 
of four different modules. 

Instrument Care
 Disconnect the power cord of Fluidics Station before replacing fuses.

 Use a surge protector on the power line to the fluidics station.

 The fluidics station should be positioned on a sturdy, level bench away from extremes in temperature 
and away from moving air. 

Figure 5.1  Recommended Cartridge Array Processing Workflow

NOTE: You must have the required fluidics protocols installed before using the FS450. For
more information, see Installing and Updating Protocols on page 147.

AGCC Cartridge Array 

Processing Workflow

Register Sample(s) and Assign 
Arrays in Sample (ARR) files

Process Probe Array in Fluidics Station

Scan Probe Array and 
Save Image Data in DAT files

Review grid alignment and perform 
manual gridding if necessary

Analyze Cell Intensity Data and 
Generate Probe Analysis Data in CHP files

Steps performed using:

AGCC Portal

AGCC Fluidics Control and 
Fluidics Station 450

 AGCC Viewer

Affymetrix and Third Party 
Probe Analysis Software

AGCC Scan Control and:
 GeneChip® Scanner 3000 (GCS3000)
 GCS3000 With Autoloader

Hybridize Array and Sample
Not performed by AGCC for 

Cartridge Arrays
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The AGCC Fluidics Control software is used to control the FS450 Fluidics Station. A workstation with 
AGCC Fluidics Control software and a Sealevel card installed can control up to eight different fluidics 
stations.

This chapter describes how to use the AGCC Fluidics Control software in the following sections:

 AGCC Fluidics Control Software, below

 Running Protocols on page 131

 Filtering the Sample File List on page 140

 Adding a Label to a Station and Modules on page 145

 Installing and Updating Protocols on page 147

 Editing Protocols on page 152

Refer to the GeneChip® Fluidics Station User’s Guide for a description of the instrument itself.

You can set things up to provide email notification when protocols are complete or problems develop. 
See Appendix D, Configuring E-mail for the Notification Options on page 325 for more information.

AGCC Fluidics Control Software
The AGCC Fluidics Control software is used to control the FS450 Fluidics Station. The software is 
introduced in the following sections:

 Starting, below

 Master Controls on page 128

 Station Controls on page 129

 Status Window on page 130

Starting

To start the AGCC Fluidics control software:

 In the AGCC Launcher, click the AGCC Fluidics Control Icon; or

Click the Microsoft® Windows® Start button  and select Programs → Affymetrix → 
Command Console → AGCC Fluidics Control...

The AGCC Fluidics Control window opens (Figure 5.2).

NOTE: Before you use the fluidics station, check the fluidics station configuration and prime
the fluidics station with appropriate buffer. For more information, read this chapter.
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The AGCC Fluidics Control window has the following components:

To hide or display the toolbar:

 From the View menu, select Toolbar → Standard Toolbar.

To add text labels to the toolbar buttons:

 From the View menu, select Toolbar → Text Labels.

To hide or display the Status Bar:

 From the View menu, select Status Bar.

Master Controls
The Master controls (Figure 5.3) enable you to select a single protocol to run on any or all stations and 
modules attached controlled by the workstation.

Figure 5.2  AGCC Fluidics Control window, Master controls

Menu Bar Provides access to Fluidics Control functions.

Tool Bar Provides quick access to frequently used functions.

Master/Station 
controls

Click the tabs to switch between:

• Master Controls (see below): Use to select a single protocol to run on multiple 
stations and/or modules. 

• Station Controls (see page 129): Use to select different protocols to run on 
different modules in a station.

Status Window Displays list of arrays in process with information on their status. 

See Status Window on page 130.

Status Bar Displays information about the status of the Fluidics station and the fluidics run 
in progress.

Menu Bar

Tool Bar

Master/Station
controls

Status Bar

Status Window
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The Master controls are used for:

 Running a Priming or Maintenance Protocol on Multiple Stations and Modules on page 131.

 Running a Fluidics Protocol on Multiple Stations on page 133

Station Controls
The Station controls enable you to select arrays and protocols for each module of a selected station 
(Figure 5.4). The controls enable you to:

 Select a particular array for processing using the following parameters:

 Sample File Name

 Array Name

 Probe Array type

 Select a specific protocol for the array.

Each module has its own set of controls (Figure 5.5).

Figure 5.3  AGCC Fluidics Control window, Master controls

Figure 5.4  AGCC Fluidics Control window, Station controls

Protocol Selection Station and Module Selection



Chapter 5  |  Controlling the Fluidics Station 450 130
The use of the module controls is described in Running Fluidics on Individual Stations on page 135.

Status Window

The Status Window (Figure 5.6) displays:

Figure 5.5  Module controls

Figure 5.6  Status window

Station Fluidics station in operation.

Module Module in operation.

Array Name Name assigned to the array.

Probe Array Type

Barcode ID The last five digits of the probe array barcode.

User Person who created the Sample file.

Protocol Protocol used for the fluidics run.



Chapter 5  |  Controlling the Fluidics Station 450 131
Running Protocols
You have several different options for selecting and running protocols with AGCC Fluidics Control, 
depending upon:

 The type of protocol you wish to run.

 Whether you wish to run it on multiple stations.

 Whether you wish to select different protocols for different modules in a station.

This section describes how to select and run protocols using AGCC Fluidics Control:

 Running a Priming or Maintenance Protocol on Multiple Stations and Modules on page 131

 Running a Fluidics Protocol on Multiple Stations on page 133

 Running Fluidics on Individual Stations on page 135

 Resuming a Fluidics Protocol on page 139

 Bypassing Steps in a Fluidics Protocol on page 139

Running a Priming or Maintenance Protocol on Multiple Stations and Modules 
Priming fills the fluidics station lines with wash buffers and deionized water. The GeneChip® Fluidics 
Station must be primed before it can be used to run assay protocols. Prime the fluidics station when:

 The fluidics station is first turned on.

 A wash solution is changed.

 The fluidics station is to be used again after a shutdown has been performed.

 A module LCD window informs you that the module is not primed.

This section explains how to run priming or maintenance protocols on multiple stations and modules.

To prime the fluidics station:

1. Start the AGCC Fluidics Control Software.

See AGCC Fluidics Control Software on page 127.

The software opens with the Master controls displayed.

2. In the Select Protocols section of the Master controls, select List Maintenance Protocols Only.

Date Time Current data and time when a protocol is running, or data and time when it was 
complete.

Current Stage Fluidics protocol stage currently running.

Time/Cycle Amount of time left for current stage or wash cycle number (e.g. 2 of 4).

Temp Temperature used for current stage.

Time 
Remaining

Total time remaining for protocol.
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3. Select Prime_450 from the Protocol drop-down list; or

Select the maintenance protocol you wish to run.

4. Select the modules to be primed (Figure 5.8).

You can:

 Select individual checkboxes for each module.

 Click the Station ID checkbox to select all modules for a particular station.

 Click Check/Uncheck all Stations and Modules to select/deselect every station and module.

5. Click Copy to Selected Modules.

6. The selected protocol (Prime_450) is applied to the selected stations and modules.

7. Fill the intake buffer reservoirs A and B with the appropriate priming buffer. (Refer to the appropriate 
GeneChip® probe array package insert). 

8. Empty the waste bottle and fill the water reservoir with deionized water. 

Figure 5.7  Selecting the Prime protocol

Figure 5.8  Selecting the stations and modules for priming

Select to list maintenance
protocols

Then select Prime_450 
from the list



Chapter 5  |  Controlling the Fluidics Station 450 133
9. Load an empty, standard 1.5 mL microcentrifuge tube in the sample holder of each module to be 
primed.

10. Click the Run All button ; or

Select Start → Run All Modules Selected on Master Page.

11. Follow the prompts in the Status window (also shown in the module LCD window).

The Status window and the module LCD window display the status of the procedure. The fluidics 
station is ready to use when priming is completed and Priming done, Ready appears in the module 
LCD window. 

Running a Fluidics Protocol on Multiple Stations
You can run a selected protocol on any or all modules in the Fluidics stations attached to the workstation 
using the Master controls.

To select and run a fluidics protocol for a set of probe arrays:

1. Start the AGCC Fluidics Control Software.

See AGCC Fluidics Control Software on page 127.

The software opens with the Master controls displayed (Figure 5.9).

2. Select the array type from the Probe Array Type list (Figure 5.10).

Figure 5.9  Master controls

Figure 5.10  Selecting probe array type
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3. Limit the protocols listed by selecting from the different options (Figure 5.11).

To limit the protocols listed:

A. Select one of the following buttons:

 List All Protocols

 List Compatible Protocols Only (displays only protocols that can be used with the selected 
labeling kit):

Select the appropriate checkbox:

 GeneChip IVT Labeling Kit

 GeneChip HWS Labeling Kit

 List Custom Protocols Only (displays only protocols that have been edited or provided by the 
user)

 List Maintenance Protocols Only (displays only maintenance protocols)

Only the protocols that meet the selected requirements are displayed in the Protocol dropdown list.

4. Select the protocol from the Protocol drop-down list (Figure 5.12).

5. Select the modules to be run by:

IMPORTANT: The protocol that is displayed in the Protocol drop-down box after selecting
the probe array type may or may not be the correct protocol for the array, depending
upon the type of analysis being performed. To make sure the correct protocol is selected,
follow the steps below.

Figure 5.11  Selecting options to filter the list of protocols

Figure 5.12  Selecting protocols from the list

IMPORTANT: The protocol that is displayed in the Protocol drop-down box after selecting
the probe array type may or may not be the correct protocol for the array, depending
upon the type of analysis being performed. To make sure the correct protocol is selected,
select the correct options for filtering the protocol list as described above.

Select the options for 
filtering protocols

Select the protocol from 
the drop-down list
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 Selecting individual checkboxes for each module.

 Clicking the Station ID checkbox to select all modules for a particular station.

 Clicking Check/Uncheck all Stations and Modules to select/deselect every station and module.

6. Click Copy to Selected Modules.

The selected protocol is applied to the selected stations and modules.

7. Fill the intake buffer reservoirs A and B with the appropriate solutions (Refer to the appropriate 
GeneChip® probe array package insert).

8. Empty the waste bottle and fill the water reservoir with deionized water. 

9. Click the Run All button ; or

Select Start → Run All Modules Selected on Master Page.

The Status window and the module LCD window display the status of the procedure.

10. After the protocol is finished, remove the probe array and inspect the probe array window for air 
bubbles. 

If air bubbles are present, reinsert the probe array into the fluidics station to automatically drain and 
refill the probe array with the last wash buffer used. (Refer to the appropriate GeneChip® probe array 
package insert.) If no bubbles are present, the probe array is ready to be scanned.

Running Fluidics on Individual Stations
You can also select a particular fluidics protocol on an individual station and module.

To select and run a fluidics protocol on an individual station and module:

1. Start the AGCC Fluidics Control Software.

See AGCC Fluidics Control Software on page 127.

The software opens with the Master controls displayed.

2. Click the tab for the station you wish to use (Figure 5.14).

Figure 5.13  Selecting stations and Modules
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The Station controls displays the module controls for the selected station. 

Each module control has the same functions (Figure 5.15).

3. Click the Refresh button to refresh the list of Sample files.

4. Click in the Barcode box and enter the barcode using the keyboard; or 

Scan the barcode with an external barcode reader.

5. Press the Tab key.

The following items are selected automatically if the barcode is valid:

Figure 5.14  Tabs for Master and Station controls

Figure 5.15  Module control

Sample File name Sample File with which the barcode is associated.

Array Name Array name with which the barcode is associated.

Probe Array Type Probe array type with which the barcode is associated.
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If you enter a valid barcode or specify the array name by other means, the fluidics protocol 
information is kept with the Audit file for the array.

You can also:

 Select a Sample file without entering the barcode. In this case, if the Sample file has more than one 
array associated with it, you will need to select the proper array from the Array Name list.

 Specify a protocol without specifying a Sample file or array. In this case, the fluidics protocol 
information is kept in an audit file that does not link to a particular Sample file.

6. Set the options to filter the fluidics protocol selections.

Figure 5.16  Barcode entered, Sample File 
name, Array Name, and Probe Array type 
automatically selected

TIP: You can use the Filter dialog box to limit the Sample (ARR) files displayed by various
properties (see Filtering the Sample File List on page 140.

IMPORTANT: The protocol that is displayed in the Protocol drop-down box after entering
a barcode or selecting a sample name or probe array type may or may not be the correct
protocol for the array, depending upon the type of analysis being performed. To make
sure the correct protocol is selected, follow the steps below.

Figure 5.17  Selecting options for protocol selection

Select the options for 
filtering protocols
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To limit the protocols listed select one of the following buttons:

 All (lists all protocols available on your computer)

 Compatible (displays only protocols that can be used with the selected labeling kit):

Select the appropriate checkbox:

 GeneChip IVT Labeling Kit

 GeneChip HWS Labeling Kit

 Custom (displays only protocols that have been edited or provided by the user)

 Maintenance (displays only maintenance protocols)

Only the protocols that meet the selected requirements are displayed.

7. Select the fluidics protocol from the Protocol list.

8. Click Run to start the protocol on the selected module; or

From the Start menu, select Run All Modules on Current Station; or

Click the Run All Modules on Current Station button .

9. Load the probe array and sample vial holder containing the appropriate solution in each active 
module. 

Sensors in the fluidics station detect when the probe array and sample vial holder have been loaded. 
The process will proceed automatically from this point, although some protocols may require removal 
and substitution of the sample vial and solution. The Fluidics Status window displays the status of the 
procedure (see Status Window on page 130).

Figure 5.18  Selecting the protocol

IMPORTANT: The protocol that is displayed in the Protocol drop-down box after entering
a barcode or selecting a sample name or probe array type may or may not be the correct
protocol for the array, depending upon the type of analysis being performed. To make
sure the correct protocol is selected, select the correct options for filtering the protocol list
as described above.

Select the protocol from the list



Chapter 5  |  Controlling the Fluidics Station 450 139
10. Repeat as necessary for other modules in the fluidics station(s).

11. After the protocol is finished, remove the probe array and inspect the probe array window for air 
bubbles. 

If air bubbles are present, reinsert the probe array into the fluidics station to automatically drain and 
refill the probe array with the last wash buffer used. (Refer to the appropriate GeneChip® probe array 
package insert.) If no bubbles are present, the probe array is ready to be scanned.

Resuming a Fluidics Protocol
AGCC tracks the progress of a fluidics protocol run. If the protocol stops before completion, it can be 
resumed at the point where it was interrupted.

To resume a fluidics protocol:

 Click Resume in the Modules controls.

The selected protocol is started in modules one through four of the fluidics station.

Bypassing Steps in a Fluidics Protocol 
Some multi-step fluidics protocols can be started at any step, so that part of a protocol can be bypassed.

Figure 5.19  Fluidics Control window, protocol running

The resume feature is only available for fluidics protocols that display multiple steps in the
Step drop-down list of the Fluidics Station dialog box and that have failed. 

If you exit AGCC Fluidics Control while a fluidics protocol is running, the resume feature will
be unavailable upon startup of the software.

NOTE: The bypass function is only available for fluidics protocols that display multiple
steps in the Step drop-down list of the Fluidics Station dialog box.
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To bypass steps:

1. Select an array and protocol as described in Running a Fluidics Protocol on Multiple Stations on 
page 133.

2. Select the desired beginning step from the Step drop-down list (Figure 5.20).

3. Click Run to start the fluidics protocol at the selected step.

Filtering the Sample File List
When first opened, the Sample file list in the module control displays all the Sample files available in 
AGCC (Figure 5.21).

Figure 5.20   Bypassing protocol steps 1, 
2, and 3
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You can use the Filter dialog box to limit the types of files displayed in the Sample File list.

To use the Filter dialog box:

1. Click the Filters button ; or

From the Edit menu, select Filters....

The Filters dialog box opens (Figure 5.22).

Figure 5.21  Station controls with 
unfiltered Sample File list

NOTE: The Filter dialog box can also be used in the AGCC Scan Control in Manual mode.



Chapter 5  |  Controlling the Fluidics Station 450 142
The Filters dialog box enables you to filter the displayed Sample files by:

2. Select a date or range of dates for file creation:

A. Select the From checkbox.

B. Click the arrow at the date (displays the current date).

A calendar for the current month appears (Figure 5.23).

Figure 5.22  Filters dialog box

Date Files created on a date or range of dates.

Selected Project Names Files associated with a particular project.

Selected Probe Array 
Types

Files for a specific probe array model.

Template attributes 
and values

Files associated with a particular attribute value.

Array Scan status Files for arrays that have already been scanned.

Array Name wildcard Array names with a specified text string in their file name.
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C. Select a date for the start of the range. You can move from month to month by clicking the < and 
> buttons.

If you only select one date, the filter will display only the files created on that date.

To select a range of dates:

D. Select the To checkbox.

E. Select a date for the end of the range.

3. Select projects from the Project Name drop-down list:

A. Click the down button in the Project Name list.

A list of the projects available in AGCC on this computer is displayed (Figure 5.24).

B. Select the checkboxes next to the projects you want displayed in the filtered list.

4. Select Probe Array Types:

A. Click on the down arrow in the Selected Probe Array Types list.

A list of the available probe array types is displayed (Figure 5.25).

In some cases there may be multiple array models under the same header. in these cases you can 
click the + button to display the additional probe arrays.

Figure 5.23  From Calendar

Figure 5.24  Displaying Project List

TIP: For more information about creating and using projects, see Projects on page 24.
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B. Select the checkboxes next to the probe array types you want displayed in the filtered list.

5. Select template attributes and enter values:

A. Locate the attribute you wish to filter by.

Attributes are listed in the format: |Template Name|: Attribute Name.

User attributes are listed as: |USER|: Attribute Name. See User Attributes on page 17 for more 
information about user attributes.

B. Click in the checkbox next to the attribute name  (Figure 5.26).

C. Click in the User Value column next to the attribute and enter a value (Figure 5.27).

You can use the “*” symbol as a wildcard in the User Value column.

Figure 5.25  Displaying array types

Figure 5.26  Selecting an attribute

Figure 5.27  Entering an attribute value

NOTE: The Sample Attribute Conversion function may impact your selection of templates
and attributes. For more information, see Sample Attributes Conversion on page 92.
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6. Deselect the Include Scanned arrays checkbox to exclude arrays that have already been scanned; or

Select the checkbox to display all arrays, including scanned arrays.

7. Enter a text string used in different array names in the Array Name Wildcard box, using the “*” 
symbol as a wild card.

For example, if you have used the barcode as an array name, entering “@*” will display all array with 
filenames using a barcode.

8. Click OK.

The filtered Sample file list is displayed in the module controls (Figure 5.28).

A Filters Applied notice appears above the list.

Adding a Label to a Station and Modules
You can add a label to a station or module in the AGCC Fluidics Control software. The labels can be 
useful when you are using more than one Fluidics station. The labels appear in the Fluidics Control 
software and will be used in status e-mails and in the Audit file (see Appendix D, Configuring E-mail for 
the Notification Options on page 325).

To add a label to a station and/or modules:

1. Click the Settings button ; or

From the Edit menu, select Station Settings...

The Fluidics Options dialog box opens (Figure 5.29).

Figure 5.28  Filtered Sample file list

Filters Applied notice
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2. Set the number of Fluidics stations installed in the Fluidics Stations Installed box.

3. Select the number of the station you wish to label from the Station Number list.

4. Enter a label for the station in the Station ID box.

5. Enter labels for the modules in the Module ID boxes.

6. Click OK.

7. The Restart Notice appears (Figure 5.30).

8. Click OK to close the Restart Notice.

9. Shut down and restart AGCC Fluidics Control.

The labels are used in the station controls (Figure 5.31).

Figure 5.29  Fluidics Options dialog box

Figure 5.30  Restart Notice
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Installing and Updating Protocols
The fluidics protocols are files that list the steps used to process different types of probe arrays. After 
installing the AGCC Fluidics Control software, you will need to install the fluidics protocols. You may 
also want to check the installed protocols against the latest versions on the Affymetrix.com web site.

These procedures are described in:

 Installing Protocols, below

 Checking Protocol Status on page 151

Installing Protocols

To install protocols:

1. From the Files menu, select Install Protocols...

The Fluidics Scripts Installer opens (Figure 5.32).

Figure 5.31  Station Controls with labels
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2. Click Next.

The Select Software screen appears (Figure 5.33).

If you have both GCOS and AGCC installed, both radio buttons will be available.

3. Select the software you wish to install scripts for and click Next.

The Select Source screen appears (Figure 5.34).

Figure 5.32  Fluidics Scripts Installer

Figure 5.33  Select Software
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The screen enables you to: 

 Install the protocols from a directory on the file system.

 Install the protocols from the Affymetrix.com web site. 

To install from a directory:

A. Select the option.

B. Enter the path to the directory; or

Click Browse and use the Select Directory dialog box to locate the directory with the scripts.

To install from Affymetrix.com:

A. Select the option.

B. Enter user name and password.

4. Click Next.

The Select Package screen appears (Figure 5.35).

Figure 5.34  Select Source screen

NOTE: You must be registered with the Affymetrix.com web site before using this feature.

Figure 5.35  Select Package screen
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The screen displays a list of the fluidics scripts packages available from the selected source.

5. Select the package you wish to install and click Next.

The Select Protocols screen appears (Figure 5.36).

The screen displays a list of the protocols in the selected package with the following information:

6. Select the checkboxes for the protocols you wish to install and click Next.

The Summary Screen appears (Figure 5.37).

The Summary screen displays information about:

 Selected fluidics scripts

 Source Path

Figure 5.36  Select Protocols

Protocol Name With checkbox to select protocol for installation.

New Version Version of protocol in selected installation package.

Version of installed Script Version of protocol installed on your computer.

Figure 5.37  Summary Screen
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 AGCC Target Directory

 AGCC Log Path: location of the log file for this installation

7. Review the information and click Next.

A progress bar displays the progress of the install (Figure 5.38).

When the install is completed, the Finish screen appears (Figure 5.39).

8. Click Close to close the Installer.

Checking Protocol Status
Updated protocols are posted at Affymetrix.com. You can check to see if you have the latest protocols.

To check the status of the protocols:

1. From the View menu, click Protocol Information...; or

Click the Info button .

Figure 5.38  Progress screen

Figure 5.39  Finish screen

NOTE: You must be registered with the Affymetrix.com web site before using this feature.
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The Affymetrix.com Login credentials dialog appears (Figure 5.40).

2. Enter your email and password and click OK. 

The Fluidics Script information appears (Figure 5.41).

3. Click on the + signs to open the lists of protocols.

4. Click on the protocol name to see information about the protocol’s status.

Editing Protocols
You can edit some hybridization and wash (Hybwash) protocols.

To edit the protocol:

1. From the Edit menu, select Edit Protocol; or

Click the Edit button .

Figure 5.40  Login credentials dialog box

NOTE: You can click the Register link to go to Affymetrix.com and register.

Figure 5.41  Fluidics Script Information screen

NOTE: Modifications to a Hybwash protocol must be completed before it is run. Protocol
changes made during a run do not affect the run in progress.
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The Fluidics Protocol Editor dialog box appears (Figure 5.42).

2. Choose the fluidics protocol you want to edit from the Protocol Name drop-down list. The listed 
protocols are the same ones displayed when you select Custom in the Master and Station controls.

3. Highlight the parameter value you want to change and enter the new value (Parameters values must 
be within the ranges in Table 5.1the table below). Enter a Hybridization Time of zero if only a wash 
is desired. To omit Wash A or B, enter zero for the Number of Wash A or Wash B cycles.

Figure 5.42  Fluidics Protocol Editor

NOTE: Only the protocols in this list may be edited. All others are defined for specific
applications and cannot be customized.
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Regulatory Compliance
CE Mark Declaration of Conformity

We, 
Affymetrix, Inc.
3420 Central Expressway
Santa Clara, CA 95051 

Declare under sole responsibility that the Affymetrix® Fluidics Station model FS450 conforms to the relevant provisions of the following standards of safety & compliance, 
and/or other normative documents.

Electromagnetic Compatibility (EMC) Directive 2004/108/EC:

EN 61326-1, 2006 Electrical equipment for measurement, 
control, and laboratory use – EMC 
requirements

EN 55011: 2007; 
Amendment A2: 2007

Class A Radiated and Conducted 
Emissions

EN 61000-4-2: 1995; 
Amendment 2: 2001

Electrostatic Discharge

EN 61000-4-3: 2006; 
Amendment 1: 2008

Radiated Immunity

EN 61000-4-4: 2004 Electrical Fast Transient / Burst Immunity

EN 61000-4-5: 2006 Surge Immunity

EN 61000-4-6: 2007  Conducted Immunity 

EN 61000-4-8: 1993; 
Amendment 1: 2001

Magnetic Field Immunity

EN 61000-4-11: 2004 Voltage Dips and Interrupts 

EN 61000-3-2: 2006 Class A Harmonic Current Emissions 

EN 61000-3-3: 1995, 
Amendment 2: 2006

Limits; Voltage Changes, Fluctuations, 
and Flicker

EU Low Voltage Directive 2006/95/EC: 

IEC 61010-1: 2001 Safety requirements for electrical 
equipment for measurement, control, 
and laboratory use - Part 1: General 
requirements 

IEC 61010-2-101/A1: 
2003

Safety requirements for electrical 
equipments for measurement, control 
and laboratory use. Particular 
requirements for in vitro diagnostic 
medical equipment 

EN 61010-1: 2001 Safety requirements for electrical 
equipment for measurement, control, 
and laboratory use - Part 1: General 
requirements 

EN 61010-2-081/A1: 
2003 

Safety requirements for electrical 
equipment for measurement, control 
and laboratory use. Particular 
requirements for automatic and semi-
automatic laboratory equipment for 
analysis and other purposes 
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UL 61010-1/R: 2005-07 Safety requirements for electrical 
equipment for measurement, control, 
and laboratory use - Part 1: General 
requirements 

CAN/CSA C22.2 No. 
61010-1:2004

Safety requirements for electrical 
equipment for measurement, control, 
and laboratory use - Part 1: General 
requirements 

CAN/CSA C22.2 
No.61010-2-081: 2004

Safety requirements for electrical 
equipment for measurement, control 
and laboratory use. Particular 
requirements for automatic and semi-
automatic laboratory equipment for 
analysis and other purposes 
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The FS450Dx Instrument Specifications
Fluidics Station Dimensions:

(height, depth, width)
40.2 x 41.0 x 71.1 cm or 15 13/16 x 16 1/8 x 28 inches

Product Weight:
Approximately 80 pounds or 36.3 kg

Power Input:
100 to 240 V~, 3 A
300 watts or less

Main supply voltage fluctuations not to exceed 10% of the nominal supply voltage.

Temperature:
Operating: 15° to 30° C
Storage (non-operating):-10° to 60° C

Humidity:
Operating: 10-90% RH, non-condensing
Storage (non-operating):10% to 95% RH

Other:
Pollution degree, 2

Installation category, II

Electrical Supply
The electrical supply shall meet the input specified on the instrument label. Voltage fluctuations 
shall not exceed 10% nominal supply voltage.

Altitude
<2000m

4. Save the edited protocol:

 To save the parameters under the same protocol name (overwrites the old protocol), click Save. 

 To save the parameters under a new protocol name, enter a new name in the Protocol Name field, 
then click Save. 

This adds the new protocol name to the drop-down list.

5. Click Defaults to return the parameter settings to the default values.

Table 5.1  Valid ranges for hybridization or stain protocol parameters

Parameter Valid Range

Hybridization or stain time 0 - 86,399 seconds

Temperature 15 - 50° C

Number of Wash cycles 0 - 99

Mixes per Wash cycle 1 - 99
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Scanning Cartridge Arrays
After processing in the Fluidics Station, the arrays need to be scanned (Figure 6.1).

Scanning can be done with the following scanners:

 The GeneChip® Scanner 3000 (GCS3000) can be loaded with one chip at a time for scanning.

 The GCS3000 with AutoLoader (Autoloader) has a carousel that can be loaded with up to 48 chips. 
The chips can then be scanned in sequence without operator attention.

The scanners are controlled by with the AGCC Scan Control software.

This chapter contains the following sections:

 AGCC Scan Control Software, below

 Applying Tough-Spots® to Prevent Leaks on page 162

 Using GeneChip® Scanner 3000 on page 164

 Regulatory Compliance on page 178

You can set things up to provide email notification when scans are complete or problems develop. See 
Appendix D, Configuring E-mail for the Notification Options on page 325 for more information.

Figure 6.1  Workflow for the Cartridge Arrays

IMPORTANT: Read all the material in this chapter before running the scanner.

AGCC Cartridge Array 

Processing Workflow

Register Sample(s) and Assign 
Arrays in Sample (ARR) files

Process Probe Array in Fluidics Station

Scan Probe Array and 
Save Image Data in DAT files

Review grid alignment and perform 
manual gridding if necessary

Analyze Cell Intensity Data and 
Generate Probe Analysis Data in CHP files

Steps performed using:

AGCC Portal

AGCC Fluidics Control and 
Fluidics Station 450

 AGCC Viewer

Affymetrix and Third Party 
Probe Analysis Software

AGCC Scan Control and:
 GeneChip® Scanner 3000 (GCS3000)
 GCS3000 With Autoloader

Hybridize Array and Sample
Not performed by AGCC for 

Cartridge Arrays
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AGCC Scan Control Software
The AGCC Scan Control software is introduced in the following sections:

 Starting the Software, below

 Status Window Information on page 159

 Running Scans on Systems with Network Data Storage on page 160

 Setting Up the Scanner ID on page 161

Starting the Software

To start the AGCC Scan control software:

 Click the AGCC Scan Control icon  in the Affymetrix Launcher; or 

Click the Microsoft® Windows® Start button  and select Programs → Affymetrix → 
Command Console → AGCC Scan Control.

The AGCC Scan Control window opens (Figure 6.2).

The AGCC Scan Control window has the following components:

IMPORTANT: Please make sure that the data roots used in AGCC software on the instrument
control workstations do not contain files that have non-Affymetrix file extensions (eg .DLL,
.TMP, .CPP, .ASPX, .OUT, etc). 

Figure 6.2  AGCC Scan Control window

Menu Bar

Tool Bar

Status Window

Status Bar
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To hide or display the toolbar:

 From the View menu, select Toolbar → Standard Toolbar.

To add text labels to the toolbar buttons:

 From the View menu, select Toolbar → Text Labels.

To hide or display the Status Bar:

 From the View menu, select Status Bar.

Status Window Information

The Status window (Figure 6.3) displays the following information:
v

Menu Bar Access to functions of the software.

Tool Bar Quick access to commonly used functions.

Status Window Displays list of scanned arrays with information on their status. 

Status Bar Displays information about the status of the AutoLoader and the scan in progress.

Figure 6.3  Status window

Position Position occupied by a given cartridge in the AutoLoader carousel.

Completed scans are marked with a green checkmark . 

Interrupted or failed scans are marked with a red X . 

Array Name Array name assigned to the array.

Probe Array 
Type

The probe array type for the scan associated with a given cartridge position.
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Running Scans on Systems with Network Data Storage
You may wish to consolidate your data using network data storage. AGCC enables you to create a Sample 
(ARR) file on a remote network storage site. When you scan the array, however, the DAT and CEL files 
are created on the default folder of the computer running the IC software; this avoids creating DAT and 
CEL files over the network.

The Default folder is designated by the user as the automatic location of all files created during drop and 
scan operation, and for DAT and CEL files when the Sample (ARR) file is located on network data 
storage.

For more information on Network Data Storage option, see Appendix A, Network Functionality for 
AGCC on Windows XP or Windows 7 on page 301.

For more information about designating the Default folder, see Specifying a Default Folder on page 67.

For more information about transferring data to network data storage, see Uploading Data to Network 
Data Storage on page 68.

Reviewing Scanner Information

To review scanner information:

 From the Scanner menu, select Information; or

Click the Info button.

The Scanner Information box opens (Figure 6.4).

Barcode ID The unique identifier in the barcode for the scan associated with a given cartridge 
position.

User Name of the user (array owner) for the scan associated with a given cartridge 
position.

Date & Time Date and time of the scan.

Scan Status The status of the scan. (Autofocus, scanning). This field displays all scanner status 
strings associated with the scan and retrieved from the scanner.

The message strings that may appear in this field are listed below. 

Note: Not all of these messages will appear in each AutoLoader run.

• Autofocus 

• Scan Status - % of lines scanned

• Scan Complete status

• Autofocus Errors 

• The array XXX has already been scanned

• Chip load failures

• Invalid barcode errors

• Array does not exist errors

• AutoLoader door open errors 

Data File Location and name of data file.
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The box displays information on:

 Scanner Type

 Scanner ID, if assigned (see Setting Up the Scanner ID on page 161)

 Serial Number

 Hardware Version

 Software Version

 Filters

 Pixel Sizes

 Scans Completed

Setting Up the Scanner ID
You can add an ID label to the scanner which enables you to identify it when email notification is 
activated.

To add a label to a scanner:

1. From the Edit menu, select Scanner ID...

The Instrument Configuration dialog box opens (Figure 6.5).

Figure 6.4  Scanner Information box
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2. Enter a label for the Scanner in the Scanner ID box.

3. Click OK.

The label can be seen in the Scanner Information dialog box (Figure 6.6).

Applying Tough-Spots® to Prevent Leaks
Tough-Spots® are chemically inert polyvinyl labels that adhere to all plastics. Affymetrix recommends 
using 3/8-inch circle diameter Tough-Spots to prevent leakage from the array septa.

Before loading the probe array, follow this procedure to prevent the leaking of fluids from the array 
during scanning.

Even if you have already applied Tough-Spots to the array prior to hybridization or after washing, you 
must remove the old Tough-Spots and apply new ones before you load them into the AutoLoader.

Affymetrix recommends the use of Tough-Spots® obtained from Affymetrix P/N 64-0158

or from

USA Scientific, Inc. P.O. Box 3565 Ocala, FL 34478 (800)LAB-TIPS P/N 9185-0000

Figure 6.5  Instrument Configuration dialog 
box

Figure 6.6  Scanner Information Dialog box

New scanner ID
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To use Tough-Spots:

1. On the back of the probe array, clean excess fluid from around septa (Figure 6.7).

2. Carefully apply one Tough-Spot over each of the two septa. Press to ensure that the spots remain flat. 
If a Tough-Spot does not apply smoothly; that is, if you observe bumps, bubbles, tears or curled 
edges, do not attempt to smooth them out. Remove the spot and apply a new one (Figure 6.8).

WARNING: To reduce the risk of leakage, do not use excessively large pipette tips to pierce
the septa. 

Figure 6.7  The GeneChip® probe array

Figure 6.8  Applying Tough-Spots® to array septa
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Using GeneChip® Scanner 3000 
The GeneChip® Scanner 3000 (GCS3000) is used to scan GeneChip probe arrays. It enables you to load 
and scan one array at a time.

This section contains the following material:

 Introduction to the GCS3000, below

 Scanning a Probe Array with GeneChip® Scanner 3000 on page 168

Figure 6.9  The Affymetrix® GeneChip® Scanner 3000

WARNING: ONLY authorized personnel may service this equipment. The GCS3000 Scanner
contains an incorporated Class 3B laser. Use of controls or adjustments or performance of
procedures other than those specified herein may result in hazardous radiation exposure.

WARNING: The GCS3000 Scanner contains an incorporated Class 3B laser with the following
specifications: Wavelength = 532nm +/- 1 nm; Beam Divergence (full angle) = <8mrad; Output
Duration = Continuous Wave; Maximum Power Output = 500mW.

NOTE: Do not remove the cover of the scanner. Use the scanner only as instructed in this User
Guide. Do not attempt to service the instrument.

WARNING:  Laser in use during scanning. 

IMPORTANT: Read all material in this section before running the GCS3000.
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 Scan Options on page 171

 Troubleshooting on page 172



Laser Safety
The laser is equipped with an automatic shutter that inhibits its output beam and ensures safe operation 
under conditions encountered in normal operation. The instrument covers, the array access port, and 
protective shutters ensure that during instrument operation no directed or stray laser light leaves the 
instrument.

The green laser is a 532nm solid-state laser. This is a Class 3B laser and has visible outputs greater than 
5mw but not more than 500mw. It must never be operated in an exposed manner. Any object in the direct 
path of the laser beam may be damaged. Eyes and skin can be seriously damaged by direct exposure to, 
specular reflections from, or diffuse reflections from this laser. If improperly used, a laser of this type 
can cause fires. When used according to the instructions in this manual and when all covers are in place, 
the GeneChip® Scanner is classified as a Class 1 Laser Product per IEC 60825-1:2007. 

Complies with 21 CFR 1040.10 and 1040.11 except for deviations pursuant to Laser Notice No. 50, dated 
June 24, 2007.

Always take note of laser safety labels; they indicate areas where exposure to laser beams may be 
hazardous.

Electrical Safety
The scanner will automatically handle any input voltage from 100 to 240 VAC nominal, 50 to 60 Hz 

IMPORTANT: The scanner is a Class 1 laser product when the laser is enclosed in scanner case.
The laser itself is a Class 3B laser product.

DANGER
Laser radiation when open. 

Avoid direct exposure to laser 
beam.

The lasers can cause serious injury
if the instrument is not operated in
accordance with instructions in this
user guide.

CAUTION
Use laser safety glasses when 

servicing
DO NOT STARE INTO LASER 

BEAM.

Class 1 Laser Product
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The power supply cord is used as the main disconnect device. Ensure that the socket outlet is located and 
installed near the equipment and is easily accessible.

 

Introduction to the GCS3000
This section contains:

 Theory of Operation, below

 Starting the Scanner on page 167

 Shutting Down the Scanner on page 168

Theory of Operation

The Affymetrix® GeneChip® Scanner 3000 is a wide-field, epifluorescent, near-confocal microscope. The 
scanner uses a 532 nm solid-state laser to excite probe array fluorophores. This in turn produces an 
emission wavelength appropriate for the probe array being scanned, which is automatically specified in 
the scan parameters for the selected probe array. As the surface of the probe array is scanned, a 
photomultiplier tube collects and converts the fluorescent emissions into an electrical signal. An analog-
digital converter in the scanner converts this signal into corresponding numeric values representative of 
fluorescent intensities. These digital intensity values are collected from discrete areas on the array surface 
and are stored on the computer workstation as pixels that comprise the image data file (the DAT 
file).Affymetrix’ patented Flying Objective™ technology represents a radical departure from 
conventional laser scanners. The optical system comprises a scan arm that rapidly oscillates from side to 
side scanning the entire width of the probe array in a continuous arc while the probe array is advanced in 
front of the objective. The acquired image of the array is returned to the computer software as a set of 
arcs. The software then geometrically corrects these arcs to form a linear image of the array (Figure 6.10). 

NOTE: The scanner’s power supply will autodetect the input voltage source and configure
itself.

CAUTION: If you use the scanner in a manner not specified in this user guide, you may impair
the protection provided by the equipment.

CAUTION: Do not confuse your company’s network connections with the dedicated Ethernet
port of the scanner-workstation. The proper scanner connection is located near the top of the
workstation.

CAUTION: This 10/100 Base T Ethernet communications port is dedicated to the scanner-
workstation interface. You cannot connect the scanner to your company’s Ethernet
communications network. 

IMPORTANT: The reset button is the scanner’s circuit breaker. The breaker switch will be
tripped whenever the scanner experiences an electrical fault condition. Press to reset. If you
cannot reset this switch, contact Affymetrix technical support. 

CAUTION
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The laser source excites the hybridized fluorophores and the photomultiplier system simultaneously 
captures the resulting fluorescent intensities. The optical components direct the fluorescent beam back 
through the objective lens, through a dichroic mirror and to the PMT. An analog-digital converter 
transforms the PMT output into 65536 levels of intensity. Each level of intensity is stored in the software 
as a 16 bit number (216=65536).

The scanner is equipped with an IEC 320 compliant power entry module located at the rear of scanner.

The scanner is equipped with an RJ-45 interface connector compatible with 10/100 Base T Ethernet for 
communications with the host workstation.

The AGCC application controls the scanner. After the scanner has completed a scan, AGCC displays a 
picture of the image in the image window. The software displays the fluorescent intensity values from 
each pixel within the probe array feature in a grayscale or pseudo color mode and superimposes a grid on 
the image to delineate the probe cells.

AGCC analyzes the image and derives a single intensity value for each probe cell on an array. This data 
is automatically generated and saved to the cell intensity file.

Starting the Scanner

To turn on the Scanner:

 Press the on/off (I/O) switch on the front panel. 

The scanner’s onboard computer boots up. The bootup process takes a few minutes. During this time 
both the yellow and green light will be on. The scanner enters the laser warm-up state. During this 
warm-up time, the green light will turn off and the yellow light will remain on. You must wait 10 
minutes for the laser to stabilize.

Figure 6.10  Schematic of the scanner design
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Shutting Down the Scanner

To turn off the scanner:

1. Close the AGCC software. This is the best way to shut off the laser. Alternately, press the I/O (on/
off) button on the front panel to turn off the instrument.

Scanning a Probe Array with GeneChip® Scanner 3000
This section shows you how to scan a GeneChip® probe array using the Affymetrix® GeneChip® Scanner 
3000. 

To scan a probe array:

1. Turn on the Scanner-AutoLoader (see Starting the Scanner, above).

2. Start the AGCC Scan Control Software (see AGCC Scan Control Software on page 158).

3. Click the Start button  in the main tool bar; or

Select Scanner → Start Scanner from the menu bar.

The Scanner dialog box opens (Figure 6.11).

At this point, you can choose from a number of options:

 If your array has a valid barcode, you can scan the barcode on the probe array into the barcode field. 
The software will retrieve the sample file and array name associated with the barcode.

If the barcode is not associated with an existing Sample file and array, a sample file will be created 
during scan using Drop and Scan.

 If your array does not have a valid barcode, you can manually select an array as described below:

1) Select the Sample file name for the probe array you wish to scan from the Sample File Name 
drop-down list.

2) Select the array name of the probe array to be scanned from the Array Name drop-down list.

NOTE: The laser also has a sleep mode that activates after 1 hour of inactivity.

Figure 6.11  Scanner Dialog box

TIP: You can filter the files listed by various criteria by clicking the Filters button (see
Filtering the Sample File List on page 140).
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The Probe Array Type field automatically displays the probe array type that was entered while 
creating the Sample file. 

4. Click Start in the Scanner dialog box.

The Start window appears (Figure 6.12).

If you want to skip the warm-up period before scanning the first probe array, keep the default check 
in the Arrays at room temperature box. 

5. Click OK in the Start Scanner dialog box to start the run.

The GeneChip Scanner dialog box appears (Figure 6.13).

The scanner door opens and the chip transport mechanism raises to accept a probe array.

6. Load the probe array (Figure 6.14) into the scanner chip transport mechanism. Insert the probe array 
into the chip transport mechanism such that the front of the probe array (label side) faces to the rear 
of the scanner.

Figure 6.12  The Start Scanner 
dialog box

Figure 6.13  Scanner dialog box

NOTE: The scanner will enter Park mode if it is unattended for 15 minutes and will enter
standby, or sleep, mode if it is unattended for 60 minutes (45 minutes after entering Park
mode). The green light will turn off and the yellow light will turn on. To reactivate the
laser, click Turn Laser On in the scanner dialog box and wait 10 minutes.

Figure 6.14  Affymetrix® GeneChip® probe arrays: note the location of the flange. The 
scanner will accept the probe array in only one orientation.
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7. Click OK in the GeneChip Scanner dialog box to start scanning the probe array.

During the scan, the green light will flash, and the yellow light will be off.

After the scan starts, the software will start with the autofocus routine. Data collection starts after 
successful completion of autofocus. During the pre-scan state, when autofocus is complete, but before 
data collection has started, the software will count downwards. 

After the scan is completed, AGCC:

 Saves the image data.

CAUTION: Do not force the probe array. If the array does not drop easily into the chip
transport mechanism, eject the array and try again. If this does not remedy the situation,
seeTroubleshooting on page 172 or call Affymetrix technical support.

CAUTION: If a probe array becomes lodged in the scanner, you can manually remove it.
For more information, see Manually Removing a Lodged Probe Array on page 173.

NOTE: You cannot modify the scanner settings. AGCC automatically selects the
appropriate settings based on the probe array type specified during experiment setup.

Figure 6.15  Loading the probe array into the chip 
transport mechanism. Note that the front of the probe 
array faces to the rear of the scanner.

NOTE: When multiple emission filters are used during the scan process, the software will
display the scan with a letter followed by the percentage of scan completed. The letter
identifies the scan associated with the emission filter.
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 Aligns a grid on the image to identify the probe cells.

 Computes the probe cell intensity data.

 Ejects the probe array.

Scan Options
This section describes various options when using the GCS3000:

 Scanning Four-Color Arrays

 Stopping a Scan on page 171

Scanning Four-Color Arrays

The four color scans are performed on GeneChip arrays that have been configured for use with four 
emission filters. The four emission filters are specified in the AGCC scan parameters. when performing 
a multi-filter scan, AGCC scans the array with different emission filters, using the order specified for the 
array. 

A DAT file is created for each of the emission filter scans. To distinguish the different scans, AGCC 
appends a suffix of A, B, C, or D to the DAT files. Different file naming conventions are used in the case 
of a rescan of an array, depending upon whether the array was manually loaded.

When running multiple scans on an array, the scanner performs autofocus only once, prior to the first 
scan. This is true whether the scans are performed as part of a four-color scan or as a re-scan. 

Aborting a Scan with a Manually Loaded Array

If scanning is aborted on a manually loaded array, the emission filter scan in progress continues until it 
is complete, and the DAT data for the completed scans are saved. When the scan is resumed, AGCC 
autofocuses the scanner and then re-scans and re-creates a DAT file for each emission filter scan, 
overwriting the previously created DAT files.

Stopping a Scan

1. Click the STOP button  or select Run → Stop Scanner from the menu bar.

2. At the prompt, click Yes to stop the scanner or No to cancel stopping (Figure 6.16).

NOTE: If you leave the scanner idle for an additional 15 minutes, the scanner will also
enter “Park” mode. The yellow light will be off and the green light on.The chip transport
mechanism will retract and the scanner door will close. You must click the Eject Chip
button to open the scanner door and raise the chip transport mechanism.

NOTE: You can track the progress of the grid alignment and cell intensity computation in
the AGCC Viewer. For more information see Chapter 8, Using the AGCC Viewer on
page 238.

Figure 6.16  Stop scanner prompt
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3. After you stop a scan, the scanner will automatically eject the array. 

Troubleshooting

You can learn more about troubleshooting in:

 Issues Relating to the Scanner’s Operation, below

 Manually Removing a Lodged Probe Array on page 196

Issues Relating to the Scanner’s Operation

The table below lists some issues and problems that you may encounter while using the GCS3000.

CAUTION: If you click Yes, the data from a partial scan will be lost. This is different from
using earlier software or scanner versions where you could save the data from a partial
scan.

CAUTION: If you rescan a probe array that has been partially scanned, the previously
scanned area of the probe array may experience fluorophore bleaching. This will result in
non-uniform fluorescence intensity across the probe array.

NOTE: The scanner dialog box has an eject array button. This is reserved for ejecting an
array after the scanner goes into sleep mode or when you must manually eject the array
for any other reason.

NOTE: If the probe array becomes stuck, see Troubleshooting on page 172 or call
Affymetrix technical support.

Table 6.1  Troubleshooting tips

Problem Possible Cause Corrective Action

No image when scanning Power off or cable loose Check all connections and power.

Loss of laser power Contact technical support.

Intermittent problems scanning Loose cable Check all rear connections.

Scanner fails with probe array inside Power failure Manually extract probe array. Check 
all connections to scanner. Turn 
scanner on, restart software.
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Manually Removing a Lodged Probe Array

In the event that a probe array becomes lodged in the array transport mechanism, follow the procedure 
outlined below.

1. Turn off the scanner. 

2. Insert a paper clip or small Allen wrench into the rescue hole on top of the scanner and press to 
partially lift the array loading door.

Issue Explanation

If communications are interrupted 
during a scan (by a faulty cable 
connection or power being lost at 
the scanner, for example)

AGCC will properly note the failure and present a message “Cannot connect to Scanner.” 
However, there are two issues to note. First, AGCC will report such a failure only after a 
network time-out of about 30 seconds. Second, rarely, if communications have been lost, 
AGCC and the Scanner may not be able to automatically restore communications once the 
problem is rectified, and both may become unresponsive. 

To restore proper operation, verify that the scanner is on, that communication cables are 
properly connected, and close and restart Microsoft® Windows® then restart AGCC. If the 
system remains unresponsive, disconnect and reconnect power to the scanner, restart the 
scanner normally, close and restart Microsoft® Windows® and AGCC.

Repeated attempts to send 
commands (Start, Turn Laser On, 
etc.) from AGCC to the Scanner while 
AGCC is reporting the scanner 
“Offline” may result in AGCC 
becoming unresponsive until 
communications are restored

If communications cannot be re-established, please follow the recommendations of item 1

If the Scanner experiences multiple 
auto-focus failures, the system may 
enter an unresponsive state. 

Follow the recommendations of item 1 to restore communications and correct operation.

Laser warm-up lasts for ten minutes, 
during which time the “Turn Laser 
On” button will remain unchanged 
and AGCC will display the status 
message “Warm-up”. 

Simply note that this is normal operation.

If no array is inserted and a scan 
started.

The scanner will attempt go through the first parts of the auto-focus routine and then report 
“Failed to find chrome border”.

The scanner should be in the park mode to eject the array.

Auto focus will fail if salt deposits 
accumulate on the array.

Use Tough-Spots® to prevent leaks in the GeneChip® probe array. See the quick reference 
card, p/n 08-0076.

CAUTION: Heavy object. Two people are required to lift the scanner.
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3. Using your fingers, gently lift the front edge of the door. As you lift the front edge, lift the back edge 
approximately 1/4” to open the door straight up to expose the rescue screw in the front.

4. Using a standard (-) screwdriver, turn the rescue screw clockwise to raise the array transport 
mechanism.

5. Continue to turn the screw until the probe array ascends sufficiently to grab it.

Figure 6.17  Using the rescue hole
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Note that the screw is fine pitched and requires a number of turns. Stop if you encounter screw 
resistance. Do not over torque.

6. When the array has ascended sufficiently, remove it.

Figure 6.18  Turning the rescue screw
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7. Rescrew the array transport mechanism until it descends completely, or until you encounter 
resistance. Do not over torque.

8. Close the door.

Figure 6.19  Removing the array
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GCS3000 Specification
GCS3000 Specification Table 

Item Parameter Value 

Weight Shipping

Free �standing 

approx 74 pounds (35.4 Kg)

63 pounds (28.6 Kg)

Dimensions Width

Depth

Height 

�13.25 in

�27.5 in

�18.25 in

Power Voltage
Current
Line Frequency 

100 � 240 V –
4 � 2 A
50 � 60 Hz

Working Environment Temperature

Humidity

Clearance 

Pollution Degree

Installation Category 

Altitude 

59°F�85°F (15°C�30°C)

10�90% Non�condensing 

2 in.(5 cm) on side, back and top 

2

II

<2000m

Electrical Supply 

Main Supply Voltage Fluctuations 

Provide voltage, frequency or 
power rating per unit label

Are not to exceed ±10% of the 
nominal supply voltage 
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Regulatory Compliance
CE Mark Declaration of Conformity

We, 
Affymetrix, Inc.
3420 Central Expressway
Santa Clara, CA 95051 

Declare under sole responsibility that the Affymetrix® GeneChip® Scanner model GCS3000 conforms to the relevant provisions of the following 
standard(s) of safety and compliance, and/or other normative documents.

Electromagnetic Compatibility (EMC) Directive 2004/108/EC:

EN 61326-1, 2006 Electrical equipment for 
measurement, control, and 
laboratory use - EMC requirements

EN 55011: 2007; 
Amendment A2: 2007 
Class A

Radiated and Conducted Emissions

EN 61000-4-2: 1995; 
Amendment 2: 2001

Electrostatic Discharge

EN 61000-4-3: 2006; 
Amendment 1: 2008

Radiated Immunity

EN 61000-4-4: 2004 Electrical Fast Transient / Burst 
Immunity

EN 61000-4-5: 2006 Surge Immunity

EN 61000-4-6: 2007 Conducted Immunity

EN 61000-4-8: 1993; 
Amendment 1: 2001

Magnetic Field Immunity

EN 61000-4-11: 2004 Voltage Dips and Interrupts

EN 61000-3-2: 2006 Class 
A

Harmonic Current Emissions

EN 61000-3-3: 1995, 
Amendment 2: 2006

Limits; Voltage Changes, 
Fluctuations, and Flicker

EU Low Voltage Directive 2006/95/EC:

EN 60825-2:2004 Safety of laser products. Safety of 
optical fibre communication systems 
(OFCS)

IEC 61010-1: 2001 Safety requirements for electrical 
equipment for measurement, 
control, and laboratory use - Part 1: 
General requirements

EN 61010-1: 2001 Safety requirements for electrical 
equipment for measurement, 
control, and laboratory use - Part 1: 
General requirements

EN 61010-2-081/A1: 
2003

Safety requirements for electrical 
equipment for measurement, control 
and laboratory use. Particular 
requirements for automatic and 
semi-automatic laboratory 
equipment for analysis and other 
purposes
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UL 61010-1/R: 2005-07 Safety requirements for electrical 
equipment for measurement, 
control, and laboratory use - Part 1: 
General requirements

CAN/CSA C22.2 No. 
61010-1:2004

Safety requirements for electrical 
equipment for measurement, 
control, and laboratory use - Part 1: 
General requirements

CAN/CSA C22.2 
No.61010-2-081: 2004

Safety requirements for electrical 
equipment for measurement, control 
and laboratory use. Particular 
requirements for automatic and 
semi-automatic laboratory 
equipment for analysis and other 
purposes
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Using the GCS3000 with AutoLoader
The GeneChip® Scanner 3000 with AutoLoader (AutoLoader) is similar to the GCS3000 with the 
addition of a carousel autoloader, designed expressly for scanning multiple GeneChip® probe arrays. The 
AutoLoader can scan up to 48 probe arrays automatically without operator presence.

Introduction
For more information about the scanner, see Introduction to the GCS3000 on page 166.

Starting the AutoLoader

To turn on the AutoLoader:

 Turn on the Scanner-AutoLoader by pressing the on/off (I/O) switch on the front panel. 

The scanner’s onboard computer boots up. The bootup process takes a few minutes. During this time 
both the yellow and green light will be on. The scanner enters the laser warm-up state. During this 
warm-up time, the green light will turn off and the yellow light will remain on. You must wait 10 
minutes for the laser to stabilize.

Shutting Down the Scanner

To shut off the scanner:

1. Close the AGCC software. This is the best way to shut off the laser. 

2. Press the I/O button on the front panel to turn off the instrument.

WARNING:  Laser in use during scanning. 

Figure 6.20  The Affymetrix® GeneChip® Scanner 3000 with 
AutoLoader
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Scanning Probe Arrays with GeneChip® Scanner 3000 with AutoLoader
This section shows you how to scan a GeneChip® probe array using the Affymetrix® GeneChip® Scanner 
3000 with AutoLoader.

To scan chips using the AutoLoader:

1. Turn on the AutoLoader by pressing the on/off (I/O) switch on the front panel. 

The scanner’s onboard computer boots up. The bootup process takes a few minutes. During this time 
both the yellow and green light will be on. The scanner enters the laser warm-up state. During this 
warm-up time, the green light will turn off and the yellow light will remain on. You must wait 10 
minutes for the laser to stabilize.

2. Load your cartridges into the carousel (up to 48). Note that only one orientation is possible 
(Figure 6.21).

Cartridges should be loaded into the carousel starting at position #1. Additional cartridges need not 
be contiguous. A run will stop after 48 cartridges OR when the same barcode is read within the same 
run.

NOTE: For information on using the GCS3000, see Using GeneChip® Scanner 3000 on
page 164.

Figure 6.21  Loading the array into the chip carousel. Each slot is numbered, 1 through 
48, and each array can fit in only one orientation
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3. Load the carousel into the AutoLoader by inserting the carousel into the AutoLoader and turning the 
carousel until the alignment pin seats into the alignment hole (Figure 6.22).

4. Turn the carousel clockwise until the carousel mounting key flat seats gently into the AutoLoader 
alignment key. You may have to turn the carousel several times before it will seat into the alignment 
pin and alignment key. When seated properly, the carousel will be flush with the AutoLoader housing.

5. Close the AutoLoader door (Figure 6.23). 

Figure 6.22  Loading the array carousel into the AutoLoader

Alignment
Key in the
Autoloader

Alignment
Hole

Alignment
Pin

Carousel
Mounting
Key Flat
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If all probe arrays have valid, associated barcodes, you can run the AutoLoader in automode.

6. Start the AGCC Scan Control software (see Starting the Software on page 158).

7. Set the default settings.

A. Click Edit → Options.

B. Clear the Enable Manual Mode check box.

Figure 6.23  Inserting and turning the carousel; the carousel should be seated and flush with housing.

NOTE: The seating of the key flat is confirmed by a gentle falling of the carousel into the
key.

NOTE: If there exists an identical barcode within the database from an earlier AutoLoader
run, and you want to rescan the current probe array with that same barcode, check the
Allow Rescans box. This will create additional DAT files. The original DAT file WILL NOT
BE OVERWRITTEN. A new DAT file is created, and the file name for the new file has an
underscore and incremental number added to it, beginning with _2.

NOTE: If the AutoLoader encounters the same barcode within the same run, the run will
terminate.
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C. Click OK.

8. Click the Start button  in the main tool bar; or

Select Scanner → Start Scanner from the menu bar.

The Start window appears (Figure 6.25).

If you want to skip the warm-up period before scanning the first probe array, keep the default check 
in the First 4 arrays at room temperature box. 

9. Click OK in the Start Scanner dialog box to start the run.

 The AutoLoader blue indicator light will light up signifying that the AutoLoader door is now 
locked.

 The carousel automatically homes itself and performs inventory to determine the number and 
position of cartridges present. 

 The scanning run begins. During the scan, the green light will flash, and the yellow light will be off. 

 The AutoLoader completes the autofocus operation before scanning each of the probe arrays. This 
takes approximately two to three minutes. The scanner cannot be stopped during this period.

 The run will stop automatically when the last array is scanned.

 At the completion of each scan, the AGCC software will attempt grid alignment. If it is successful, 
the scan data will be automatically advanced to the Grid Alignment processing state. 
The progress of the scan data can be tracked using the Review Window of the AGCC Viewer (see 
Chapter 8, Using the AGCC Viewer on page 238).

 The progress of each scan is displayed in the Scan Status window (Figure 6.26).

Figure 6.24  Scanner Options 
dialog box with Enable Manual 
Mode checkbox cleared

Figure 6.25  The Start Scanner 
dialog box in automode
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 The window displays a list of the arrays as they are being scanned with the information displayed 
in the Status window (see Status Window Information on page 159)

After the scan is completed, AGCC:

A. Saves the image data to an image file (*.dat).

B. Ejects the probe array.

C. Aligns a grid on the image to identify the probe cells.

D. Automatically computes probe cell intensities and saves the data to the cell intensity file (*.cel).

Arrays with barcodes that are not associated with a Sample file and array will have a sample file 
created using Drop and Scan.

The AutoLoader will skip probe arrays if the AutoLoader encounters:

 Arrays with unreadable or invalid barcodes or without barcodes.

 Arrays that have been previously scanned if the Allow Rescans checkbox is cleared.

10. Close the AGCC Scan Control software. This is the best way to shut off the laser. 

11. Press the I/O button on the front panel to turn off the instrument.

Special Scan Options

The following sections describe various options for running the scan: 

 Drop and Scan on page 186

 Stopping an AutoLoader Run on page 186

 Adding Cartridges During a Run on page 186

 Scanning a Probe Array in Manual Mode on page 189

 Ejecting a Probe Array on page 191

 Using AGCC with the AutoLoader Disabled on page 191

 Scanning Four-Color Arrays on page 192

 Terminating a scan run on page 193

Figure 6.26  Scan Status window during autoloader run.

NOTE: You can track the progress of the grid alignment and cell intensity computation in
the AGCC Viewer. For more information see Chapter 8, Using the AGCC Viewer on
page 238.
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Drop and Scan

The Drop and Scan feature lets you scan a set of GeneChip probe arrays without first creating a Sample 
(.ARR) file for them. A Sample file is created automatically during Drop and Scan, with the probe array 
barcode used as the file name.

To use Drop and Scan:

1. Start the AGCC Scan Control software.

2. Start the scanner.

3. Load the arrays in the scanner.

4. Click the Start button.

If the arrays have valid barcodes, they are scanned. The ARR, DAT, and CEL files are named using 
the barcode and placed in the designated Default folder.

For more information about the Default folder, see:

 Default Folders on page 23

 Specifying a Default Folder on page 67

If the scanner cannot read the barcode, or if there are no library files on the system for chips with that 
part number, the chip is ejected and an error notice appears. 

Stopping an AutoLoader Run

The Stop button is only available after you have clicked the Start button. Click this button if you want to 
abort a scan or run in progress.

1. Click the STOP toolbar button  or select Scanner → Stop Scanner from the menu bar.

2. At the prompt, click Yes to stop the scanner or No to elect not to stop the AutoLoader run.

A window displays the message “The scanner will not stop until autofocus has finished.” 

3. Click OK.

After you stop a scan, the scanner automatically ejects the array.

Adding Cartridges During a Run

The software provides you with a button that will enable you to unlock the AutoLoader door and add 
additional probe array cartridges while in the middle of an AutoLoader run. You have two choices: 

 To add cartridges immediately even while a scan is in progress (in which case the DAT file is discarded 
and replaced with a newly collected one after the AutoLoader run is resumed). 

 To add cartridges after a scan has completed (in which case the DAT file is saved).

NOTE: If you stop the scanner while a probe array is in the process, you will lose all scan
information from that probe array. If you rescan the array, it may be affected due to uneven
photo-bleaching. This could potentially make the data from the array difficult to compare to
other array data.

Figure 6.27  Stop AutoLoader prompt
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To interrupt the scan in progress:

1. Click the Add Chips button , or select Run → Add Chips from the menu bar.

The Add Chips Options dialog box opens (Figure 6.28). 

2. Click Add Now.

The blue AutoLoader indicator light will turn off signifying that the AutoLoader door is now 
unlocked. 

If a scan is in progress, the software will continue to record the scan. However, to avoid the possibility 
of generating a corrupt DAT file, it will discard that scan that was in progress when the door was 
opened. 

3. Open the door and add probe array cartridges to the carousel.

4. Close the scanner door.

The following window appears (Figure 6.29).

5. Click OK. 

6. Click the Resume  button; or select Run → Resume.
The Notice dialog box opens (Figure 6.30).

NOTE: The Add Chips button is enabled only after the AutoLoader has started a run in
automatic mode. 

NOTE: If you stop the scanner while a probe array is in the process, you will lose all scan
information from that probe array. If you rescan the array, it may be affected due to uneven
photo-bleaching. This could potentially make the data from the array difficult to compare to
other array data.

Figure 6.28  The Add Chips Options dialog box

Figure 6.29  Resume notice
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7. Select the Allow Rescans option, if desired, and click OK.

The blue AutoLoader indicator light turns on signifying that the door is locked. The software homes 
the carousel and inventories the number of present probe arrays. The carousel then moves to that last 
previously scanned probe array (when the door was opened) and continues the scanning run by 
rescanning that probe array.

The array is rescanned and a new DAT file overwrites the previous DAT file.

To add chips without interrupting a scan:

1. Click the Add Chips button , or select Run → Add Chips from the menu bar.

The Add Chips Options dialog box opens (Figure 6.31).

2. Click Add after scan. 

The Interrupt After Scan Complete notice appears (Figure 6.32).

3. Click OK.

The AutoLoader will wait until the current probe array has undergone the autofocus and scan 
procedures before unlocking the door.

The blue AutoLoader indicator light turns off when the AutoLoader door is unlocked.

4. Open the door and add probe array cartridges.

5. Close the scanner door.

Figure 6.30  Notice dialog box

IMPORTANT: Do not load an array into the same carousel position that was occupied by
the array that had just been scanned, i.e., do not replace cartridges.

Figure 6.31  The Add Chips selection buttons

Figure 6.32  Complete Scan notice
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The Resume Notice dialog box opens (Figure 6.33).

The AGCC status bar displays a “waiting to start” status.

6. Click OK. 

7. Click the Resume  button; or 

Select Run → Resume.
The Run Options dialog box opens (Figure 6.34).

8. Select the Allow Rescans option, if desired, and click OK.

The blue AutoLoader indicator light turns on signifying that the door is locked. The software homes 
the carousel and takes inventory of the probe array cartridges present. The carousel then proceeds to 
the next array position following the previously scanned probe array. The AutoLoader continues the 
run from that array position.

Scanning a Probe Array in Manual Mode

In the AutoLoader Automode, each probe array requires a valid barcode in order to be scanned. The 
manual mode feature enables you to scan one probe array at a time without the requirement of a barcode. 
This is useful if you must scan probe arrays that have invalid or absent barcodes.

To scan a probe array in manual mode:

1. Set the scanner options.

A. From the Edit menu, click Options. 

The Scanner Options dialog box opens (Figure 6.35).

B. Check Enable Manual Mode.

C. Click OK.

Figure 6.33  Resume notice

Figure 6.34  Run options dialog box

NOTE: If you click the Cancel button in the Run Options dialog box, the AutoLoader will
not resume the scan.
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2. Click the Start button ; or

Select Scanner → Start Scanner from the menu bar.

The Scanner dialog box opens (Figure 6.36).

At this point, you can choose from a number of options:

 You can click Start without selecting an array name. If your array has a valid barcode, the software 
will get the barcode from the array in the AutoLoader and select the correct Sample file and Array 
name.

 If your array has a valid barcode, you can scan the barcode on the probe array in to the barcode 
field. The software will retrieve the Sample Attribute File associated with the array.

 If your array does not have a valid barcode, you can manually select an array as described below:

1) Select the Sample file name for the probe array you wish to scan from the Sample File Name 
drop-down list.

2) Select the array name of the probe array to be scanned from the Array Name drop-down list.

The Probe Array Type field automatically displays the probe array type that was entered 
during experiment setup. 

Figure 6.35  Scanner Options dialog 
box, Enable Manual Mode checked

Figure 6.36  Scanner Dialog box

TIP: You can filter the files listed by various criteria by clicking the Filters button (see
Filtering the Sample File List on page 140.
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3. Click Start in the Scanner dialog box.

The Start dialog box appears (Figure 6.37).

If you want to skip the warm-up period before scanning the first probe array, keep the default check 
in the Arrays at room temperature box. 

4. Load the probe array into slot number 1. 

5. Click OK in the Start Scanner box (Figure 6.37) to start the autofocus routine. This takes 
approximately two to three minutes. The scanner cannot be stopped during this period.

During the scan, the green light will flash, and the yellow light will be off.

After the scan is completed, AGCC:

A. Saves the image data to an image file (DAT).

B. Aligns a grid on the image to identify the probe cells.

C. Automatically computes probe cell intensities and saves the data to the cell intensity (CEL) file.

D. Ejects the probe array.

Ejecting a Probe Array

The probe array will automatically eject after a run.

Using AGCC with the AutoLoader Disabled

If you have a working scanner but the AutoLoader is not operating, you can still use the scanner, but you 
must check the Disable AutoLoader option in the Defaults window. This will disable the AutoLoader and 
enable you to use the scanner alone as you would in manual mode.

1. From the Edit menu, click Options. 

The Scanner Options dialog box opens (Figure 6.38).

2. Check Disable AutoLoader. 

3. Click OK.

Figure 6.37  The Start Scanner dialog 
box

NOTE: You can eject or load an array by clicking on the Load/Eject button at any time
except when the scanner is engaged in the autofocus operation or the scanning run.

NOTE: The array slot at position number 1 is the only slot available in Manual Mode.

TIP: You can view the status of the cell intensity computation by using the AGCC
Viewer (see Chapter 8, Using the AGCC Viewer on page 238.
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A window will appear asking that you reboot the scanner.

 

4. Press the scanner front panel I/O button once to turn off the scanner. Wait a few moments, the press 
the I/O button to turn on the scanner.

5. Open the AutoLoader door.

6. Manually load a probe array into the slot. 

7. Close the AutoLoader door.

8. Scan the probe array in the same manner as the AutoLoader in manual mode. See Scanning a Probe 
Array in Manual Mode on page 189.

After scanning the probe array, you must manually remove the probe array from the AutoLoader. See 
Steps 7 though 13 in Manually Removing a Lodged Probe Array on page 196.

Scanning Four-Color Arrays

Four color scans are performed on GeneChip arrays that have been configured for use with four emission 
filters. The four emission filters are specified in the AGCC scan parameters. when performing a multi-
filter scan, AGCC scans the array with different emission filters, using the order specified for the array. 

A DAT file is created for each of the emission filter scans. To distinguish the different scans, AGCC 
appends a suffix of A, B, C, or D to the DAT files. Different file naming conventions are used in the case 
of a rescan of an array, depending upon whether the array was manually loaded (see below) or loaded 
using the autoloader on page 193.

When running multiple scans on an array, the scanner performs autofocus only once, prior to the first 
scan. This is true whether the scans are performed as part of a four-color scan or as a re-scan. 

Aborting a Four-Color Scan with a Manually Loaded Array

If scanning is aborted on a manually loaded array, the emission filter scan in progress continues until it 
is complete, and the DAT data for the completed scans are saved. When the scan is resumed, AGCC 
autofocuses the scanner and then re-scans and re-creates a DAT file for each emission filter scan, 
overwriting the previously created DAT files.

Figure 6.38  Disable AutoLoader 
checked

Figure 6.39  Reboot notice
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Aborting a Four-Color Scan when Using the AutoLoader

If scanning is aborted on an array loaded using the autoloader, the emission filter scan in progress 
continues until it is complete, and the DAT data for the completed emission scans are saved. When the 
scan is resumed, AGCC autofocuses the scanner and then re-scans and re-creates a DAT file for each 
emission filter scan. AGCC does not overwrite the previously created DAT data, but creates a new set of 
DAT files, adding a suffix of “_nX” to the DAT file name, where n identifies the rescan number and 'X' 
is the letter assigned for the emission filter. A 4-color array scanned a second time will produce DAT files 
with the following suffixes: _2A, _2B, _2C, _2D. 

Autorotation

Autorotation occurs during a power failure only if the uninterrupted power supply (UPS) is included as 
an accessory. The UPS provides power to the scanner/AutoLoader during a power failure. If the power 
fails during the scan of an array, that scan is completed and then the system turns off the heater and enters 
the autorotation mode to conserve power and cool the chips in the carousel. The system will also attempt 
to send an e-mail to notify the user of the power failure.

During an AutoLoader run, the carousel is rotating as the chips are processed to introduce the next array 
to the scanner, so autorotation is not needed. After the AutoLoader run is complete the heater is turned 
off and the carousel is rotated to get even cooling of the chips.

Terminating a scan run

The AutoLoader run will terminate under certain normal circumstances. Table 6.2The table below 
outlines under what conditions a scan run will or will not terminate.

NOTE: When using the “Add Chips Now” function of the autoloader, if the door is opened in
the middle of a scan acquisition, AGCC treats the scan as an abort request. After the emission
filter scan in progress completes, scanning halts and the DAT and CEL files for the completed
emission filter scans are saved. Upon resume, the AGCC autofocuses the scanner and rescans
the array for each emission filter. To avoid the rescan of the array, it is recommended that
the “Add Chips Later” function be used.

AUTOROTATION

The AutoLoader is equipped with a heater to warm up the cartridges prior to scanning in
order to reduce condensation and fogging of the probe array window.

The autorotation routine is used for temperature stability but only after the AutoLoader run
is complete or during a power failure as described below. 
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Troubleshooting
Troubleshooting tips are given in the table below and in the following sections:

 AutoLoader Error Messages on page 195

 Manually Removing a Lodged Probe Array on page 196

Table 6.2  Summary of scan run termination conditions

The scan run will terminate if: The scan run will not terminate if:

You press the Stop button. Caution: If you stop the 
scanner while a probe array is in the process, you 
will lose all scan information from that probe 
array. If you rescan the array, it may be affected 
due to uneven photo-bleaching. This could 
potentially make the data from the array difficult 
to compare to other array data.

You check Allow Rescans box. When the AutoLoader encounters a probe array 
that was previously scanned in an earlier run, it will rescan that probe array 
and will create additional DAT files (.dat1, .dat2, etc.). 

The AutoLoader detects a probe array with the 
same barcode in the current run, i.e., in the 
currently loaded carousel. The probe array will not 
be rescanned.

You clear the Allow Rescans box. When the AutoLoader encounters a probe 
array that was previously scanned in an earlier run, it will log the probe array 
but will not rescan it. It will continue the run.

The AutoLoader detects 48 scanned cartridges in 
the same run. 

You click the Add Now button. The AutoLoader door will unlock to accept new 
probe array cartridges. The scan in progress will complete. When you close the 
door and continue, the AutoLoader will home, take inventory and move to the 
same probe array that was in the process of being scanned when the door was 
opened. It will discard the earlier DAT file and rescan that probe array. 

Note: this has nothing to do with the Allow Rescans check box.

You click the Add After Scan button. The AutoLoader door will wait until the 
scan in progress is complete then unlock the door. When you close the door 
and continue, the AutoLoader will home, take inventory and move to the next 
probe array from that which was in the process of being scanned when the 
door was opened. 

Problem Possible Cause Corrective Action

No image when scanning  Power off or cable loose Check all connections and power.

 Loss of laser power Contact technical support.

 Image display disabled Enable image display

Intermittent problems 
scanning

 Loose cable Check all rear connections.

Scanner fails with probe array 
inside

 Power failure Manually extract probe array. Check all connections 
to scanner. Turn scanner on, restart software.

Carousel does not 
automatically home

 Check for stuck array
 Carousel not seated on D ring
 Alignment Pin not engaged in Carousel
 Door is open or ajar
 Door is open when blue LED is off.

Carousel does not rotate  Door is open or ajar
 System is warming up, array in heater
 Carousel not seated on D ring
 Alignment Pin not engaged in Carousel
 Laser in Scanner is warming up. AGCC has 

Start grayed out in this case
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AutoLoader Error Messages

The following error messages indicate a serious malfunction of the scanner with AutoLoader. Your probe 
arrays, or the data generated from them, may be at risk. You should shut down the AutoLoader and 
remove the carousel. Do not continue to use the AutoLoader in Automode. Call Affymetrix Technical 
Support.

However, if the AutoLoader appears to be operating normally, you can continue to use the AutoLoader 
in Manual Mode. See Scanning a Probe Array in Manual Mode on page 189.

E-mail Messages

If the e-mail system is enabled, the instrument control software sends an e-mail alert for conditions that 
may occur during an AutoLoader run. 

Carousel misses next array  Array UP sensor not working, call technical 
support.

Stuck array  See Manually Removing a Lodged Probe Array on 
page 196

AutoLoader freezes up  Door is open or ajar

AutoLoader overheats  Heater Failure
 TE failure
 TE hot fans vent blocked

Call technical support.

Call technical support.

Autofocus routine fails to 
conclude 

 Try to rescan array.   
 Check for salt on chrome border. If still error, call 

technical support.

The array does not descend 
into scanner.

 Carousel not seated correctly
 Door is open or ajar
 Heater is waiting until array is at 

temperature.

HEATER_LOW “Warning: The warming chamber temperature is low. Refer to the troubleshooting 
guide.”

COLD_CHAMBER_LOW “Warning: The cold chamber temperature is low. Refer to the troubleshooting 
guide.” 

COOL_HOTSIDE_HIGH “Warning: The cooler hot-side temperature is high. Refer to the troubleshooting 
guide.” 
Note: Before calling technical support, check around the ventilation vents to ensure 
that nothing is blocking them.

COLD_CHAMBER_HIGH “Warning: The cold chamber temperature is high. Refer to the troubleshooting 
guide.”
Note: Before calling technical support, check the AutoLoader door to ensure that it 
is not open.

HEATER_HIGH “Warning: The warming chamber temperature is high. Refer to the troubleshooting 
guide.”

NOTE: For information on enabling the email system see Appendix D, Configuring E-mail for
the Notification Options on page 325.

Problem Possible Cause Corrective Action
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In case of a fatal error:

1. The software sends an e-mail to the specified set of e-mail addresses or to the Outlook distribution 
list.

2. The software provides you with the ability to send an e-mail without your intervention.

3. The software uses extended MAPI to send an e-mail.

4. Each e-mail message contains the following information:

A. Date and Time

B. Scanner ID

C. All experiment information displayed in the status window. You select error messages to be sent 
in the e-mail configuration.

Manually Removing a Lodged Probe Array

In the event that a probe array becomes lodged in the array transport mechanism, follow the procedure 
outlined below.

1. Turn the AutoLoader off and remove the power cord from the back of the unit.

2. Open the AutoLoader door on top of the unit. 

3. Remove the carousel from the system. (Keep cartridges in carousel at proper temperature while 
recovering the array still in the scanner).

4. Remove the hole plug, which is just in front of the array slot in the base piece of insulation. In 
Figure 6.40, the screwdriver is inserted into this hole.

Figure 6.40  Locating the rescue hole
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5. Using a standard, flat (-) screwdriver, (13-0257) gently slide it down through the hole making sure 
not to damage the shaft and spring that are protruding into the hole. When the screwdriver stops, it 
should be in contact with the scanner Y stage screw. Slowly turn the screwdriver until you feel it 
engaging the slot on the screw of the scanner Y stage.

6. Slowly turn the screw clockwise until it hits a hard stop and cannot turn further. (Do not try to turn it 
further or use excessive force because it will break the Y stage in the scanner). The Y stage has now 
ascended to its maximum position.

7. Using your fingers, slowly slide the slot pin, which is sticking through the slot in the base piece of 
insulation, to the right until it stops. You should see the little pinch rollers near the array slot close a 
little as you do this (Figure 6.41).

8. Insert a 3/16” hex driver (13-0255) into the hole that is located on the front of the AutoLoader housing 
on the left. You should feel it engage a coupling (Figure 6.42).

Figure 6.41  Pinch rollers and slot pin

Pinch 

Rollers

Slot 

Pin
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9. Turn the hex driver counter clock wise until you see the array appear through its opening. (The array 
should stay up if you stop turning the hex driver). If you don't see the array after turning the hex driver 
ten seconds go to step 11.

10. Grab and hold the array with your fingers. Using your other hand slowly slide the slot pin (Step 7) 
back to the left. This should open up the pinch rollers. Pull the array out. 

If you do not see the array after turning the hex driver for 10 seconds, stop. 

11. Using tool (13-0256) (Figure 6.43) with the hook down and toward the back, slide it vertically down 
against the front of the array opening, about 1.5 inches. (There is a small groove made for this tool in 
the middle of the front array guide).

12. Pull the top finger grip of the tool toward the front of the unit, and then pull it up while still putting 
pressure towards the front. The array should come up with the tool. When you see it, grab the array 
and pull it out of the unit. 

If you cannot get the array out after doing this procedure, call for Affymetrix technical support.

13. Put the hole plug back into the hole in the base piece of insulation.

Figure 6.42  Finding the coupling

Figure 6.43  Tool
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14. Plug the scanner back in and turn it on.

15. Load the carousel after the scanner boots up.

If cartridges continue to become lodged in the AutoLoader, you should call technical support
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GCS3000 with AutoLoader Specification

GCS3000 with AutoLoader Specification Table

Table 6.3  
Item

Table 6.4  
Param
eter

Table 6.5  
Value

Weight Shipping approx 115 pounds 
(52.2 Kg)

Free-standing approx 100 pounds 
(45.4 Kg)

Dimensions Width ~13.25 in. 

Depth ~21.25 in.

Height ~32 in. 

Power Voltage
Current
Line Frequency.

100 - 240 V ~
4 - 2 A
50 - 60 Hz

Working Environment Temperature 59°F-85°F (15°C-30°C)

Humidity 10-90% Non-
condensing

Clearance 2 in. (5 cm) on side, back 
12.5 in. on top

Pollution Degree 2

Installation Category II

Altitude <2000m

Electrical Supply Provide voltage, frequency or power rating per 
unit label

Main Supply Voltage 
Fluctuations

Are not to exceed ±10% of the nominal supply 
voltage
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Regulatory Compliance
CE Mark Declaration of Conformity

We, 
Affymetrix, Inc.
3420 Central Expressway
Santa Clara, CA 95051 

Declare under sole responsibility that the Affymetrix® GeneChip® Scanner model GCS3000 and its accessory Autoloader conforms to the relevant 
provisions of the following standard(s) of safety and compliance, and/or other normative documents.

Electromagnetic Compatibility (EMC) Directive 2004/108/EC:

EN 61326-1, 2006 Electrical equipment for 
measurement, control, and 
laboratory use - EMC requirements

EN 55011: 2007; 
Amendment A2: 2007 
Class A

Radiated and Conducted Emissions

EN 61000-4-2: 1995; 
Amendment 2: 2001

Electrostatic Discharge

EN 61000-4-3: 2006; 
Amendment 1: 2008

Radiated Immunity

EN 61000-4-4: 2004 Electrical Fast Transient / Burst 
Immunity

EN 61000-4-5: 2006 Surge Immunity

EN 61000-4-6: 2007 Conducted Immunity

EN 61000-4-8: 1993; 
Amendment 1: 2001

Magnetic Field Immunity

EN 61000-4-11: 2004 Voltage Dips and Interrupts

EN 61000-3-2: 2006 Class 
A

Harmonic Current Emissions

EN 61000-3-3: 1995, 
Amendment 2: 2006

Limits; Voltage Changes, 
Fluctuations, and Flicker

EU Low Voltage Directive 2006/95/EC:

EN 60825-2:2004 Safety of laser products. Safety of 
optical fibre communication systems 
(OFCS)

IEC 61010-1: 2001 Safety requirements for electrical 
equipment for measurement, 
control, and laboratory use - Part 1: 
General requirements

EN 61010-1: 2001 Safety requirements for electrical 
equipment for measurement, 
control, and laboratory use - Part 1: 
General requirements

EN 61010-2-081/A1: 
2003

Safety requirements for electrical 
equipment for measurement, control 
and laboratory use. Particular 
requirements for automatic and 
semi-automatic laboratory 
equipment for analysis and other 
purposes
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UL 61010-1/R: 2005-07 Safety requirements for electrical 
equipment for measurement, 
control, and laboratory use - Part 1: 
General requirements

CAN/CSA C22.2 No. 
61010-1:2004

Safety requirements for electrical 
equipment for measurement, 
control, and laboratory use - Part 1: 
General requirements

CAN/CSA C22.2 
No.61010-2-081: 2004

Safety requirements for electrical 
equipment for measurement, control 
and laboratory use. Particular 
requirements for automatic and 
semi-automatic laboratory 
equipment for analysis and other 
purposes
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Regulatory
This device complies with Part 15 of FCC Rules (Table 6.6). Operation is subject to the following two 
conditions: (1) This device may not cause harmful interference, and (2) This device must accept any 
interference received, including interference that may cause undesired operation.

This device complies with FDA performance standards for laser products except for deviations pursuant 
to Laser Notice No. 50, dated June 24, 2007.

This Class A digital apparatus meets all requirements of the Canadian Interference-Causing Equipment 
Regulation.

Cet appareil numérique de la classe A respecte toutes les exigences du Règlement sur le matériel broullier 
du Canada.

Table 6.6  Regulatory Certifications  

Regulatory Agency Certification

Class 1 Laser Device Complies with EN 60825-1:2007

Complies with FDA performance standards for 
laser products except for deviations pursuant to 
Laser Notice No. 50, dated June 24, 2007

Hand held barcode 
reader is a Class 2 laser 
device

Complies with EN 60825-1:2007
Complies with FDA performance standards for 
laser products except for deviations pursuant to 
Laser Notice No. 50, dated June 24, 2007

Compliant with directive 2002/96/EC (WEEE)
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Controlling the GeneTitan® Instruments
GeneTitan Array Plates need to be run through the following steps in the array plate processing workflow 
(Figure 7.1):

 Hybridization

 Washing and Staining

 Imaging

GeneTitan Array Plates are processed using one of the following GeneTitan instruments:

 GeneTitan Multi-Channel (MC) instrument, for genotyping and expression array plates

 GeneTitan Instrument (Single-Channel), for expression array plates only

There are differences in the workflows for genotyping array plates and expression array plates. This 
chapter describes the functions of GeneTitan Instrument Control that are common to both genotyping and 
expression array plates:

 Introduction, below

 Overview of the GeneTitan Workflow on page 216

 Tracking the Array Plate Through the Workflow on page 219

Figure 7.1  Recommended Array Plate Processing Workflow for GeneTitan System

GeneTitan Array Plate 

Processing Workflow

Register Sample(s) and Assign 
Arrays in Sample (ARR) files

Perform Fluidics on 
array plate

Image arrays on array plate and 
Save Image Data in DAT files

Review grid alignment and perform 
manual gridding if necessary

Analyze Cell Intensity Data and 
Generate Probe Analysis Data in CHP files

Steps performed using:

AGCC Portal

 AGCC Viewer

Affymetrix and Third Party 
Probe Analysis Software

AGCC  GeneTitan Control

Hybridize Array Plate 
and Sample
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 Aborting a Run on page 224

 Unload Plates on page 226

 Using the Wash-Scan-Resume Workflow on page 228

 Drop and Scan with Array Plates on page 231

 Insufficient Disk Space Notice on page 231

 Resetting the Lamp Life Clock (GeneTitan MC Only) on page 231

 Computer Practices, Maintenance and Troubleshooting on page 232

Information specific to Expression Arrays is given in the Expression Assay Manuals.

Information specific to genotyping array plates is given in Axiom Genome Wide Human Assay User 
Manual, PN 702830.

See the GeneTitan® Instrument User's Guide (PN 08-0296) and the GeneTitan® Multi-Channel 
Instrument User’s Guide (PN 08-0308) for a description of the instrument itself.

Introduction
The introduction describes:

 AGCC GeneTitan Instrument Control Software, below

 The GeneTitan Family of Instruments on page 214

AGCC GeneTitan Instrument Control Software
The AGCC GeneTitan Instrument Control software is used to control the GeneTitan Instruments.

To start the AGCC GeneTitan Instrument Control software:

 Click the AGCC GeneTitan Instrument Control icon  in the Affymetrix Launcher; or 

Click the Microsoft® Windows® Start button  and select Programs → Affymetrix → 
Command Console → AGCC GeneTitan Control.

The AGCC GeneTitan Instrument Control window opens. 

See Figure 7.2 on page 206 for 96 array plate AGCC GeneTitan Instrument Control window example.

See Figure 7.3 on page 207 for 384 array plate AGCC GeneTitan Instrument Control window example.

IMPORTANT: A computer used as a GeneTitan workstation requires a user account with
specific privilege settings. In addition, some of the other features of Windows XP or Windows
7 must be set up in particular ways or disabled to avoid causing problems when running
GeneTitan IC software.

A workstation set up by Affymetrix for use with GeneTitan has a user account called
AFFXUser with these privileges and features already set. If the settings have been changed,
refer to the AGCC Installation Instructions for information about the correct settings.

IMPORTANT: If the GeneTitan workstation becomes unstable during a workflow the cost of 
an aborted workflow and replacement plates is substantial. To avoid this, Affymetrix 
recommends:

 Rebooting the instrument control computer weekly. Windows XP users, see Preventative 
Maintenance (Windows XP) on page 233. Windows 7 users, see Preventative Maintenance 
(Windows 7) on page 235.

 Following the recommendations and performing the procedures described in Computer 
Practices, Maintenance and Troubleshooting on page 232.
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Figure 7.2  AGCC GeneTitan Control software, System Status Tab
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The software goes through the initialization process and starts the GeneTitan instrument.

You can track the initialization process in the Hybridization Status pane (Figure 7.4); when the 
initialization is completed, System Ready is displayed in the log, and you can display the Setup 
tab.

Figure 7.3  AGCC GeneTitan Control software, System Status Tab (384 array plate)
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You may see notices about:

 Lamp Life setting (see Resetting the Lamp Life Clock (GeneTitan MC Only) on page 231)

 Insufficient Disk Space (See Insufficient Disk Space Notice on page 231)

The software has the following components:

Toolbar Buttons

The Stop button is used to abort the array process. The software will ask the user to select which process 
is to be aborted if there are two or more plates running in the instrument. See Aborting a Run on page 224.

The Email button opens the AGCC Email Configuration File Editor, which allows you to send email 
messages about the instrument status. See Appendix D, Configuring E-mail for the Notification Options 
on page 325 for more information.

The Help button opens the AGCC Online help file. 

Figure 7.4  Hyb Oven log with System Ready notice

Menu bar Provides access to IC functions.

Tool bar Provides quick access to frequently used functions (see below).

System Setup/
System Status tabs

Click the tabs to switch between:

• System Status Tab on page 209, below: Use to track the progress of array plates 
through the workflow.

• System Setup Tab on page 209: Use to set up the GeneTitan Instrument for 
different workflows.

Status bar and 
Progress bar

Displays information about the status of the GeneTitan Instrument and the 
workflow in progress.
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System Status Tab

The System Status tab (Figure 7.5) displays the progress of any currently loaded array plate(s).

It has the following sections:

 Workflow

 Hybridization Oven Status

 Fluidics Status

 Imaging Device Status

The System Status tab is described in more detail in Tracking the Array Plate Through the Workflow on 
page 219.

System Setup Tab

The System Setup tab is used to:

 Specify the type of workflow you wish to perform

 Enter a barcode for the array plate being processed

 Unload and load trays and plates 

 Select arrays on the array plate for imaging

Figure 7.5  System Status Tab
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The tab has three sections:

Figure 7.6  System Setup Tab for genotyping array plates

System Setup Use to enter essential information and track progress of the setup and loading of the 
array plate and trays.

System Layout Indicates the drawers where different trays and array plates should be loaded. The 
system layout will change based on whether Genotyping or Expression arrays are 
being processed.

Array Selection Allows you to select individual arrays on the array plate for imaging.
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System Setup

Figure 7.7  Setup Option pane

Plate Information

Workflow Steps

Status pane
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The Setup Option pane (Figure 7.7) has the following controls and displays:

System Layout

The System Layout pane (Figure 7.8) displays:

 Schematic view of the drawers to be loaded

 Indication of plate/tray position in drawer

Setup Options dropdown 
box

Select from the following workflow options:

• Hyb-Wash-Scan

• Hyb-Wash

• Wash-Scan

• Wash-Scan-Resume

• Scan

• Unload Plates
See Running a Series of Array Plates on page 219 for more information.

Plate Information, with

Barcode Barcode of the array plate.

Plate Type Array Plate type.

Protocol Name Name of protocol used for array plate processing.

Location Side of drawer to load consumables.

Workflow Steps List of the sets of steps to be performed during the operation.

Status Displays information on the specific step to be performed, with 

• The plates and trays that need to be removed or placed.

• The drawer position the plates and trays should be place in.

Cancel Cancel the setup.

Next Proceed to the next step (not displayed when performing a step that 
requires you to press the Confirmation button on the front of the 
instrument.

NOTE: Different reagent trays are loaded when processing genotyping array plates and
expression array plates. The correct trays are selected for display when the array barcode is
entered, as shown in the figure below.
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Array Selection

The Array Selection pane (Figure 7.9) displays the arrays to be scanned on the array plate:

 Manual array selection checkbox

 Plate Layout indicator, where you can:

 Review the arrays available on the array plate

 Determine which are to be scanned

Figure 7.8  System Layout pane for genotyping (96 and 384) and expression arrays (96 only)

IMPORTANT: When running a series of array plates through the instrument, you must be
careful to remove and load the proper array plate and trays and pay careful attention to the
software prompts that tell you which side of the open drawer to remove or place a plate or
tray.

Figure 7.9  Array Selection (96 and 384 Array Plate layouts shown)

For genotyping arrays (96) For expression arrays (96)For genotyping arrays (384)
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 Manually select arrays to be scanned on the plate

The array selection process is described in the instructions for loading array plates in:

 Expression Assay Manuals

 Axiom Genome Wide Human Assay User Manual, PN 702830

The GeneTitan Family of Instruments
Affymetrix designed the GeneTitan Family of Instruments to serve medium to high throughput 
customers. This system supports 16, 24 and 96 well high throughput array plates and will support future 
array plate formats. The system integrates a hybridization oven, a fluidics station, and an imaging device.

Array Plates can be run on two different GeneTitan instruments:

 GeneTitan MultiChannel (MC) Instrument

 GeneTitan Instrument (single channel) (Figure 7.10)

Refer to the GeneTitan® Instrument User's Guide for more information.

GeneTitan Multi-Channel (MC) Instrument

The GeneTitan MC Instrument can process both Expression Arrays and WGA Genotyping Assay. The 
instrument uses an external 300W Xenon lamp and has multiple filters to provide stable, efficient, well-
collimated, uniform illumination to the array, optimizing exposure time to minimize photo-bleaching 
effects and maximize throughput. 

GeneTitan Instrument (Single-Channel)

The GeneTitan Instrument (single-channel) can only process Expression Arrays. The instrument has a 
single-channel emission filter with a high intensity stable LED excitation source.

NOTE: By default, all arrays are selected for imaging.

Figure 7.10  GeneTitan MC Instrument
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GeneTitan Instrument Controls and Indicator Lights

The figure below shows the location of the wash bottles, loading drawers, and other controls for 
GeneTitan instruments. 

Figure 7.11  GeneTitan Instrument

WARNING: The bottles are pressurized in normal operation. Wait until you see the
prompt that the buffer bottles have been depressurized before opening and refilling or
emptying the bottles.

1. Input/Output Drawer #1
2. Input/Output Drawer #2
3. Input/Output Drawer #3
4. Input/Output Drawer #4
5. Input/Output Drawer #5
6. Input/Output Drawer #6

13. Trash Bin Door for 
       Waste Chute

8. Waste Bottle

9. Wash A Bottle

10. Wash B Bottle
11. Rinse Bottle (DI Water)

12. Fluidics Station

1

2

5

4

3

6

 Imaging Device14.

7. Confirmation Button (to open/close drawers)
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The GeneTitan Instrument uses the indicator lights and button below (Figure 7.12).

Confirmation button: Press after completing certain steps for instrument setup, like adding fluids or 
adding trays and plates.

The button flashes blue when a step is pending.

Instrument Status lights:

 Solid yellow - initialing/homing system

 Solid Green - processing/available to process

 Blinking green - normal operation message box is displayed and requires user input

 Blinking yellow - abnormal event informational message box requires user response

All power to the instrument is turned on when the AGCC GeneTitan Control software is started and 
turned off when the software is shut down. The I/O switch on the front of the instrument is inoperative 
when the instrument is being controlled using the software.

Refer to the GeneTitan® Instrument User's Guide or the Affymetrix GeneTitan MultiChannel Instrument 
User’s Guide for more information.

Overview of the GeneTitan Workflow
Running an array plate through the GeneTitan workflow involves the following sets of steps:

1. Set up the Instrument:

A. Prepare plates and trays with samples and solutions, including buffer solutions.

B. Select type of workflow to be performed.

C. Select the Protocol, if required.

D. Refill Bottles.

Figure 7.12  GeneTitan Instrument controls and lights.

IMPORTANT: Do not make use of I/O switch on instrument panel to start/stop instrument.
Use the menu item in the software.

I/O Button

Imaging Device
Status Light (Yellow)

Imaging Device
Status Light (Green)

3.

4.

5.

Status (Green)
2. Instrument

GeneTitan™Plate
Confirmation Button
(to open/close drawers)

1.
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E. Remove used trays, plates and covers from the instrument.

2. Load new trays, plates and covers.

There are different procedures for the different array and workflow types:

 Expression Assay manuals

 Axiom Genome Wide Human Assay User Manual, PN 702830

3. Begin Array processing and track the array plate through the workflow.

4. Empty the instrument.

You can:

 Select only part of the overall processing workflow to run (see Workflow Options on page 217)

 Run a series of array plates through the workflow for high-throughput operation (see Running a Series 
of Array Plates on page 219)

Workflow Options
There are three sets of steps performed by the GeneTitan Instrument for array plate processing:

 Hybridization

 Wash and Stain

 Imaging (Scan)

The software allows you to perform all of these steps, or to select an option that runs only some of the 
steps, as described below.

You can choose from:

 Hyb-Wash-Scan

This workflow performs all the steps on the array being processed.

 Hybridization

 Wash and Stain

 Scan

 Hyb-Wash

The Hyb-Wash workflow enables you to bypass the Scan step, performing only:

 Hybridization

 Wash and Stain

 Wash-Scan

The Wash-Scan workflow enables you to bypass the Hybridization step, performing only:

 Wash and Stain

 Scan

 Wash-Scan-Resume

This allows you to resume an interrupted workflow at any point in the Wash stage. See Using the Wash-
Scan-Resume Workflow on page 228.

 Scan

The Scan workflow performs the scan only.

You select the different workflows during instrument setup. 

IMPORTANT: Once bottles are refilled, ensure that bottle caps are on tight.
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Selecting the different workflows may require loading the array plate on a different tray (array plate 
cover, hybridization tray, or scan tray). In addition, there are differences in how the workflows are 
performed on genotyping arrays and expression arrays.

These differences are covered in:

 Expression Assay manuals

 Axiom Genome Wide Human Assay User Manual, PN 702830

Differences in Processing for Genotyping and Expression Arrays
There are two types of Array Plates that can be processed using the GeneTitan instruments

 Genotyping array plates

 Expression array plates

Genotyping Array Plates

Genotyping Array Plates can be processed only on GeneTitan MC instruments, since they need to be 
scanned at two different wavelengths.

For genotyping arrays, the reagents trays need to be loaded twenty-four hours after the array plate and 
hybridization tray have been loaded, after hybridization has completed.

Needed reagents trays are:

 2 each Stain1 trays with covers

 Ligation tray with cover

 Stain 2 tray with cover

 Stabilizing tray with cover

 Scan tray with holding buffer and cover

See the Axiom Genome Wide Human Assay User Manual, PN 702830, for more information on running 
genotyping array plates.

Expression Array Plates

Expression Array plates can be processed on GeneTitan and GeneTitan MC instruments.

Needed trays/reagents are:

 SAPE 1 Stain tray with cover

 AB Stain Tray with cover

 SAPE 2 Stain tray with cover

 Scan tray with holding buffer and cover

See the Expression Assay manuals for more information.

Figure 7.13  Selecting workflow
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Running a Series of Array Plates
The GeneTitan Instrument can run two different workflows for the same probe array type at the same 
time. This enables you:

 To load a series of array plates with hyb trays and consumables for the Hyb-Wash-Scan workflow to 
process arrays more quickly.

 To run an array plate that was processed using a different system through the scan workflow while 
another array plate is going through earlier stages of the Hyb-Wash-Scan workflow.

Only certain types of workflows can be run at the same time, and delays may be necessary before starting 
the second workflow. These restrictions exist because an array plate should be scanned immediately after 
the wash and stain processing is finished, and GeneTitan scans one array plate at a time. In addition, there 
are restrictions caused by the differences in workflows for Genotyping arrays and Expression arrays, and 
by differences in the number of arrays on the plates. For more information, see:

 Expression Assay manuals

 Axiom Genome Wide Human Assay User Manual, PN 702830

Tracking the Array Plate Through the Workflow
You can review the progress of the Workflow in the System Status tab (Figure 7.14).

It has the following sections:

 Workflow Status, below

Figure 7.14  AGCC GeneTitan Control software, System Status Tab
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 Hybridization Status on page 220

 Fluidics Status on page 222

 Imaging Device Status on page 223

Workflow Status
The Workflow pane provides an overview of the array processing (Figure 7.15).

The Work Flow table lists the array plates and their status in the workflow, with the following 
information:

 Barcode of array plates being processed

 Plate Type

 Location

 Hyb. Status

 Fluidics Status

 Scan Status

 Estimated Completion Time

The Estimated Time Window information on when the next hyb-wash-scan workflow can be run

 Array Type
]

 Time when you can load the next array plate and other consumables.

Hybridization Status
The Hybridization Status pane displays details of the hybridization operations that have been run. The 
pane can display information for two array plates that are being processed at the same time.

Figure 7.15  Workflow pane

NOTE: If more than three arrays are loaded at a time, a scroll bar appears at the right side of
the table.

NOTE: You cannot select a different array type for the next array to be run.

NOTE: When processing genotyping Arrays, once processing begins you have a specified
period of time during which you can load another Array Plate and hyb tray. You cannot load
another array plate before or after this period of time.
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The pane displays the following information:

 Position 1

 Barcode of the array plate(s) being processed

 Time Remaining

 Position 2

 Barcode

 Time Remaining

 Oven Temperature

 Current. 

 Yellow: out of range

 Green: in range

 Target

 Log: displays history of the operations performed in the Hybridization stage.

Figure 7.16  Hyb Oven Status
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Fluidics Status
The Fluidics Status window (Figure 7.17) displays information on the wash and stain operations that have 
been run or are currently being run.

It displays the following information:

 Barcode of the array plate being processed

 Protocol Name

 Time Remaining

 Temperature for the protocol step

 Current

 Yellow: out of range

 Green: in range

 Target

 Protocol Tab:

displays list of steps in the protocol with:

 Step

 Task: short description of the task

 Time

 Status: Task pending, in process, or completed?

 Log tab: displays history of the operations performed in the Fluidics stage.

Figure 7.17  Fluidics Status
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Imaging Device Status
The Imaging Device Status pane (Figure 7.18) displays the progress of the scan.

It displays:

 Barcode of the array plate currently being scanned

 Time Remaining for scan

 Lamp Life/Imaging Device Status (see Lamp Life/Imaging Device Status Notices, below, for details)

 Plate Status tab with:

 Array Plate Layout

Each square represents an array with the following options:

 Log: displays history of the operations performed in the Fluidics stage.

Figure 7.18  Imaging Device Status

 (dark blue) Will be scanned.

 (light blue) Now Imaging.

 (white) Will Not Be Scanned.

 (green Scan Completed.

 (red) Scan Failed.
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Lamp Life/Imaging Device Status Notices

The Imaging Status pane displays lamp life and Imaging Device status notices for the GeneTitan MC.

In normal operation, the pane displays the hours of life left in the lamp:

It displays a red or yellow notice when the lamp life is getting short:

It also displays a red notice when the Imaging Device is offline:

Aborting a Run
You can abort a run if necessary.

For information on aborting a run because of facility power loss, see Facility Power Loss on page 226.

To abort a run:

1. Click the Stop  button in the Toolbar..

The Abort dialog box opens (Figure 7.22).

Figure 7.19  Lamp Life above tolerance

Figure 7.20  Lamp Life above tolerance

Figure 7.21  Imaging Device Offline

NOTE: The 300 Watt Xenon lamp in the GeneTitan MC instrument is warranted for 500 hours.
To replace the lamp refer to the instructions in the GeneTitan instrument manual. After
changing the lamp, it is necessary to reset the lamp life clock manually.
See Resetting the Lamp Life Clock (GeneTitan MC Only) on page 231 for more information
about the clock.

IMPORTANT: If you wish to abort a run while loading reagents for a genotyping array plate,
you must use the Cancel button in the toolbar. During reagent load the abort function will
not be available for the plate for which reagent trays are being loaded.
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The Abort DB has the following components:

 Plates Being Processed List with the following columns:

 Select checkbox

 Barcode

 Plate Type

 Location

 Current Step: explains the next step in the procedure.

 Abort and Cancel buttons.

2. Click the Select checkbox for the plate whose run you wish to abort.

3. Click Abort.

The software asks for confirmation.

Click Yes to continue with the Abort process.

When abort is completed, you can see the notice in the Status tab (Figure 7.24).

Figure 7.22  Abort dialog box

Figure 7.23  Abort 
Confirmation

NOTE: The abort process may take some time to complete. Wait until it is finished before trying
to perform any other operations.

Figure 7.24  Abort notice in Workflow pane
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If the array plate is in the Hyb Oven, it is placed in Drawer Number 1

If the array plate is in Fluidics when the abort is ordered, it is placed in the Scan tray.

You will need to unload the loaded plates and trays in a second step, using the Unload function or the 
unload steps during a setup.

Facility Power Loss
If facility power is lost and the UPS backup power battery percent remaining drops below 75%, the 
software will automatically abort all running plates. This automatic abort is intended to protect the plates 
by bringing all running plates out to the drawers for removal. However, if the user is in the setup tab 
performing setup steps (loading the machine) the software is prevented from performing the required 
abort sequence. 

If facility power is lost and the user is notified that the UPS power percent remaining drops below 75%, 
the user should cancel the loading operation to initiate the abort sequence. 

To cancel the loading operation and setup:

 Select Cancel in the system setup tab.

Unload Plates
The Unload Plates function can be used to empty the GeneTitan drawers after performing an abort 
operation.

To unload loaded plates:

1. Select Unload Plates from the Setup Option dropdown list (Figure 7.25).

The application prompts you to empty the cover trash bin.

2. Perform the following steps:

A. Open the trash bin door.

B. Remove and empty the trash bin.

C. Return the trash bin and close the door.

3. Press the Confirmation button to proceed.

The application prompts you to unload previously loaded plates and trays. 

For each loaded plate or tray:

 The appropriate drawer opens (Figure 7.26).

Figure 7.25  Selecting workflow
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 The status box prompts you to remove the tray or plate and the system layout indicates the array or 
tray to remove (Figure 7.27).

Figure 7.26  Unloading solution trays from Drawer #5

IMPORTANT: When running a series of array plates through the GeneTitan Instrument, you
must be careful to remove and load the proper array plate and trays and pay careful attention
to the software prompts that tell you which side of the open drawer to remove or place a
plate or tray.
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Remove any plate, plate receptacle, or tray from the drawer (Figure 7.27), then press the 
Confirmation button on the front of the instrument.

When you have finished emptying the old plates and trays, the software prompts you to proceed to 
the next step.

Using the Wash-Scan-Resume Workflow
The Wash-Scan-Resume can be used to resume an interrupted workflow on an array plate.

The Abort process places the Array Plate on the Scan Tray; you will need to manually put the array on a 
blue tray before resuming the workflow.

Affymetrix recommends using a new scan tray for the resumed workflow.

Figure 7.27  Unload tray(s)

Plate/tray position indicators
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To resume an interrupted workflow:

1. Select Wash-Scan-Resume in the setup process.

2. Enter the barcode for the interrupted array.

The Resume Plate dialog box appears.
The

The Resume Plate dialog box lists:

 Plate barcode

 Protocol that had been selected to run the array.

 Step where the process needs to be resumed.

3. Click Yes to proceed with the resume.

The ResumeStep dialog box opens.

The Steps dropdown list displays the uncompleted steps. 

Figure 7.28  Select Option--Wash-Scan-resume

Figure 7.29  Resume Plate dialog box

Figure 7.30  ResumeStep dialog box
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The list of unfinished steps will be different for:

 Expression arrays versus Genotyping Arrays

 Arrays interrupted in different parts of the workflow

4. Select the step in the workflow where you wish to resume.

5. Enter the time you wish to run the first step in the Time to Process box.

You cannot change the processing time for certain steps, and cannot set the time to longer than the 
protocol specifies.

6. Click OK to resume the workflow.

7. Follow the instructions in the software steps for loading the array and trays.

You must load the array plate on a blue array base.

Affymetrix recommends using a new scan tray for the resumed workflow.

You must load all the trays for the original workflow; if you know you are going to skip a particular 
step, you can load an empty tray in the designated location for that step.

Figure 7.31  List of unfinished steps

NOTE: If you have performed certain steps offline, you need to skip these steps in the
workflow.

Figure 7.32  Array Plate with blue base
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Drop and Scan with Array Plates
While you can register an array plate and its arrays using the AGCC Portal GeneTitan Array Plate 
Registration before processing, you can also process an array plate that has not been registered by using 
the Drop and Scan feature for array plates. When using Drop and Scan, the ARR, DAT, and CEL files for 
each array are named using the barcode and array position.

See GeneTitan Array Plate Registration on page 111 for more information about registering an array 
plate.

To use Drop and Scan:

1. Set up and load the GeneTitan Instrument as required for the workflow you are performing.

2. Process the array plate.

If the array plate has a valid barcode, it will be processed and scanned. The ARR, DAT, and CEL files 
for each array are named using the barcode and array position and placed in the designated Default 
folder.

For more information about the Default folder, see:

 Default Folders on page 23

 Specifying a Default Folder on page 67

If the instrument cannot read the barcode, or if there are no library files on the system for array plates 
with that part number, the array plate is ejected and an error notice appears. 

Insufficient Disk Space Notice
If there is not enough memory on the computer’s drives to save the data from an array plate, a notice 
appears when:

 You first initialize the software and instrument

 You select arrays for imaging.

If you see this notice, you will need to free up sufficient disk space before imaging starts.

Resetting the Lamp Life Clock (GeneTitan MC Only)
The GeneTitan MC uses a xenon arc lamp system to provide illumination for imaging the array at two 
wavelengths. The xenon lamp has a limited lifetime and needs to be replaced at regular intervals.

The GeneTitan Instrument Control software provides a timer that indicates the remaining useful light of 
the bulb and notifies you when it requires replacement. 

The replacement procedure is described in the GeneTitan MC Instrument User Guide. After replacing the 
bulb, you will need to reset the time, as described below.

If life of bulb is under a specified limit, the following notice appears when you open the software 
(Figure 7.34):

Figure 7.33  Insufficient Disk Space Notice
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If you click OK, the confirmation notice appears:

Click Yes to reset the lamp life timer to the specified time.

Click No to cancel.

Computer Practices, Maintenance and Troubleshooting
If the GeneTitan workstation becomes unstable during a workflow the cost of an aborted workflow and 
replacement plates is substantial. To avoid this Affymetrix recommends following certain computer 
operation practices and preventative maintenance routines.

These are described in:

 Computer Operation Practices, below

 Preventative Maintenance (Windows XP) on page 233

 Preventative Maintenance (Windows 7) on page 235

 Troubleshooting on page 236

Computer Operation Practices
The following computer operation practices are recommended to help prevent problems.

Hard drive 

For the instrument control system, it is recommended to keep all drives at a maximum of 50% full. If 
there is more data on the workstation, the system tends to slow down. If keeping data on the hard drives 
is absolutely necessary, the drives need to be defragmented regularly (ie: depending on the amount of 
data, every two weeks or monthly defragmentation is recommended).  

USB Memory Drives/Memory Stick

When USB drives or memory stick(s) are connected to the workstation, please properly disconnect them 
(safely remove hardware) before physically pulling them off.

Figure 7.34  Lamp Life Management notice

Figure 7.35  Reset dialog box
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Scanning Plates

If the GeneTitan system is scanning a plate or running fluidics, try not to run any other applications while 
the instrument workstation is running.

Moving data (DAT, CEL, etc.)

When archiving data or moving data off the workstation, it is highly recommended to do this process 
when scanning or running fluidics is not in process. The scanning process will be very slow if data is 
being moved at the same time.

Preventative Maintenance (Windows XP)
The following procedures should be performed on a regular basis on the GeneTitan workstation 
computer:

 Reboot the Computer

 Performing a Disk Defragment Procedure on page 233

Reboot the Computer

The GeneTitan Workstation computer should be rebooted on a weekly basis.

To reboot the computer:

1. Click the Start  button, then select Shut Down....

The Shut Down Windows dialog box appears (Figure 7.36).

2. Select Shut down or Restart from the drop-down list and click OK.

3. After the computer shuts down, restart it and log back in using the AFFXUser account.

Performing a Disk Defragment Procedure

The drives on the GeneTitan workstation need to be defragmented regularly (ie: depending on the amount 
of data, every two weeks or monthly defragmentation is recommended).

To perform disk defragmentation:

1. Click the Start  button, then click Programs → Accessories → System Tools → Disk 
Defragmenter.

The Disk Defragmenter window appears (Figure 7.37).

Figure 7.36  Shut Down Windows dialog box

NOTE: You must select Shut Down or Restart to reboot the computer. The other options
(Log off and Sleep) will not work.



Chapter 7  |  Controlling the GeneTitan® Instruments 234
The window displays a list of drives with information about capacity and free space.

2. Select the disk you wish to defragment from the list.

3. Click Analyze.

The Analyze process runs.

When the process is finished, the Analysis Complete dialog box appears (Figure 7.38).

4. Click Defragment.

The Disk Defragmenter process runs (Figure 7.39).

Figure 7.37  Disk Defragmenter window

Figure 7.38  Analysis Complete dialog box
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When the defragmentation process is finished, the notice appears (Figure 7.40).

5. Click Close in the notice.

6. Close the Disk Defragmenter window.

Preventative Maintenance (Windows 7)
The following procedures should be performed on a regular basis on the GeneTitan workstation 
computer:

 Reboot the Computer

 Performing a Disk Defragment Procedure on page 233

Reboot the Computer

The GeneTitan Workstation computer should be rebooted on a weekly basis.

To reboot the computer:

1. Click the Start  button, then click Shut down or Restart.  (Figure 7.41)

Figure 7.39  Disk Defragmenter running

Figure 7.40  Defragmentation complete 
notice
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2. After the computer shuts down, restart it and log back in using the AFFXUser account.

Performing a Disk Defragment Procedure

The drives on the GeneTitan workstation need to be defragmented regularly (ie: depending on the amount 
of data, every two weeks or monthly defragmentation is recommended).

To perform disk defragmentation:

1. Click the Start  button, then click All Programs -> Accessories -> System Tools → Disk 
Defragmenter.

The Disk Defragmenter window appears.

The window displays a list of drives with information about capacity and free space.

2. From the list, click to select the disk you wish to defragment.

3. Click Analyze disk.

The Analyze process runs.

When the process is finished, the Analysis Complete dialog box appears.

4. Click Defragment disk.

The Disk Defragmenter process runs.

When the defragmentation process is finished, the notice appears, click Close.

5. Close the Disk Defragmenter window.

Troubleshooting

If the GeneTitan IC Window and Taskbar Icon Disappear

The GeneTitan IC window may disappear from the computer screen while, at the same time, the Taskbar 
icon for GeneTitan IC disappears. If this happens, restore the window and icon by doing one of the 
following.

Solution 1

1. Simultaneously press Ctrl/Alt/Delete keys.

The Windows Security dialog box appears.

2. Click Task Manager.

The Windows Task Manager dialog box appears (Figure 7.42).

Figure 7.41  Windows 7 Shut down or Restart

NOTE: You must select Shut Down or Restart to reboot the computer. The other options
(Switch User, Log off, Lock, and Sleep) will not work.
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3. Click New Task …: 

The Create New Task dialog box appears  (Figure 7.43).

4. Enter explorer.exe and click OK.

The Task Bar should be displayed

5. Press the icon for GeneTitan in the taskbar to display the GeneTitan window.

Solution 2

1. Press and hold down Alt/Tab keys

A list of icons for active applications will appear

2. Keep pressing the Alt key and hit/release the TAB key to select the icon with the GeneTitan icon.

3. When selected, release the Alt key.

The GeneTitan IC window re-appears.

Figure 7.42  Windows Task Manager

Figure 7.43  Create New Task dialog b ox

NOTE: The explorer.exe application must be running properly to display the Taskbar at the
bottom of the screen. The above procedure will launch explorer.exe to re-display the Taskbar.
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Using the AGCC Viewer
After the array has been scanned (Figure 8.1), AGCC:

 Aligns a grid on the Image (DAT) file to identify the probe cells.

 Computes the probe cell intensity data for the array and creates a CEL file.

The AGCC Viewer displays DAT, CEL, and JPG files and enables you to:

 Track the progress of the data through grid alignment and cell intensity generation.

 View the files for quality control purposes, such as detecting scratches and bubbles.

 Check the grid alignment and realign the grid, if necessary.

See Checking the Grid Alignment on page 275.

 Create a JPG version of a DAT file for archiving.

See Exporting Images in Other Formats on page 286.

Figure 8.1  Array Processing Workflow

NOTE: Realigning the grids will update DAT headers and break the parent-child
relationship between DAT files and existing CEL files until the CEL files are regenerated.

AGCC  Array Processing 

Workflow

Register Sample(s) and Assign 
Arrays in Sample (ARR) files

Perform Wash and Stain operations on 
array(s) in Fluidics Station

Scan Probe Array and 
Save Image Data in DAT files

Review grid alignment and perform 
manual gridding if necessary

Analyze Cell Intensity Data and 
Generate Probe Analysis Data in CHP files

Hybridize Array(s) and Sample (not 
performed by AGCC for Cartridge Arrays)
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This chapter describes the operation of the AGCC Viewer in the following sections:

 Array and Grid Types, below

 Introduction to the Viewer on page 246

 Using the Review Window on page 252

 Opening Image Files on page 257

 Using the Review Window on page 252

 Learning about the Image File on page 273

 Checking the Grid Alignment on page 275

 Exporting Images in Other Formats on page 286

Array and Grid Types
The Alignment algorithm uses the checkerboard image of the control probes, located at the corners of the 
probe array, to superimpose a grid on the scan image. The algorithm aligns the grid so that each square 
in the grid delineates a probe cell.

The alignment of the grid and subgrids usually takes place automatically after imaging the array. The 
status of the alignment can be tracked in the Review window (see page 252). If the alignment algorithm 
fails you can perform a manual alignment of the main grid and/or subgrids. 

Different types of arrays use different grid types, as described in:

 Cartridge Arrays

 GeneTitan® Array Plates on page 242

Cartridge Arrays
Cartridge Arrays can use:

 Main Grid Only (Figure 8.2)

NOTE: Norton Antivirus can interfere with AGCC software The symptom is that AGCC will
stop generating CEL files. If that problem occurs, then you should check the Norton Anti-Virus
settings as described in Appendix B, Settings for Norton Anti-Virus of the AGCC 4.0
Installation Instructions (P/N 702567).
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 Main Grid with multiple Subgrids (Figure 8.3)

The position of each sub-grid can be adjusted independent of the other sub-grids.

Figure 8.2  Array with a single grid
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Each subgrid is identified by its row and column in the main grid. The corners of each subgrid are 
marked on the array by specific alignment patterns; the anchors of the subgrid are aligned to these 
patterns (Figure 8.4).

Figure 8.3  Main grid with subgrids
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The software uses the corner patterns at the 4 corners of the array to align the initial main grid. The 
main grid is then divided into smaller subgrids. Each subgrid is aligned on the corner grid patterns in 
the final steps of the gridding algorithm and in manual alignment.

GeneTitan® Array Plates
Plate Arrays use: 

 Subgrids only without a main grid (Figure 8.5)

There are two different types of Genetitan array plates:

 GeneTitan Expression Array Plates on page 243

 GeneTitan Genotyping Array Plates on page 245

Figure 8.4  Corner pattern of a subgrid
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GeneTitan Expression Array Plates

An array plate can have up to 96 arrays (see GeneTitan Array Plate Registration on page 111 for more 
information).

Each plate array on the array plate has multiple subgrids. Some arrays use a 7 x 7 grid, for a total of 49 
subgrids, while other array types use a 7 x 6 grid, for a total of 42 subgrids.

These sub-grids are similar to the sub-grids used for some cartridge arrays, but on a plate array the sub-
grids are not aligned to a main grid.

In addition, the data for all the mini-DAT files is consolidated into a single DAT file. This DAT file 
can be viewed in the Image Viewer; the file has all the image and gridding data for each subgrid and 
each exposure, and allows you to check the gridding independently for each exposure

Figure 8.5  GeneTitan Array DAT file
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.

The mini-CEL files for each exposure are merged into a single merged CEL file (.mgcel) (Figure 8.7), 
resulting in two merged CEL files per plate array.

The data in these two merged CEL files is then consolidated in a single CEL file, which is used for further 
analysis and can be viewed in the Image Viewer for QC purposes.

Figure 8.6  Mini-DAT and mini-CEL files

Plate Array with subgrids

Relationship between plate arrays, Mini-DAT files, Mini-CEL files, and DAT files

 A plate array does not have a main grid, but 
has up to 49 independent subgrids.

The array is scanned twice with different exposure times. Each scan produces 
a mini-DAT file for each subgrid, for a total of up to 98 different mini-DAT files

The data from each exposure is used to determine the cell intensity data for 
each subgrid. This data is kept in a mini-CEL file. In this example, there would be 
98 mini-CEL files for an array, with two mini-CEL files for each subgrid.

The data for all the mini-DAT files is 
consolidated into a single DAT file. 
You can use the DAT file to view the 
individual subgrids for each exposure 
and to correct problems with 
Gridding
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The mini-DAT files, mini-CEL files and merged CEL files will be deleted during normal processing. If 
something goes wrong, you may find these file types in the target folder during a scan. Also, when 
importing plate array data from GCOS using DEC, you need to import the mini-DAT files.

GeneTitan Genotyping Array Plates

GeneTitan Genotyping array plates are handled similarly to the Genetitan Expression arrays, except that 
the arrays are scanned at two different wavelengths, instead of two different exposure times.

Figure 8.7  Mini-CEL merge and consolidation.

Relationship between Mini-CEL, merged CEL, and CEL files

The data from each exposure is used to 
determine the cell intensity data for each 
subgrid. This data is kept in a mini-CEL file. In 
this example, there would be 98 mini-CEL files 
for an array, with two mini-CEL files for each 
subgrid.

The data for the two merged CEL files is 
consolidated into a single CEL file. The CEL file 
is used for further analysis, and can be viewed 
in the Image Viewer for QC purposes. 

Mini-CEL files

The mini-DAT, mini-CEL, and merged 
CEL files are deleted after the DAT and 
CEL files have been created.

CEL file

Merged CEL files

 First exposure

 First exposure

Second exposure

Second exposure

The mini-CEL data for each 
exposure is merged into a 
single merged CEL file, 
resulting in two merged CEL 
files for each plate array.
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Introduction to the Viewer
You can learn more about the basic functions of the AGCC Viewer in:

 Opening the Viewer, below

 File Display Differences on page 247

 Moving the Components Out of the Viewer on page 249

 Moving the Component Borders in the AGCC Viewer on page 251

Opening the Viewer

To start the AGCC Viewer:

 In the AGCC Launcher, click the AGCC Viewer icon ; or

Click the Microsoft® Windows® Start button  and select Programs → Affymetrix → 
Command Console → AGCC Viewer.

The Command Console® Viewer opens (Figure 8.8).

The viewer has the following components when it first opens:

 Viewer menu

 Viewer tool bar

 Review window (optional) (see Using the Review Window on page 252)

 Status bar: displays cursor position and intensity of selected pixel/cell

Additional components are visible when a DAT or CEL file is displayed (Figure 8.9)

Figure 8.8  AGCC Viewer with no image displayed

Viewer tool bar

Viewer menu

Review window

Status bar
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To learn about the Image window tool bar, see Changing the Display of the Image on page 266.

To learn about the Properties box, see Learning about the Image File on page 273.

To learn about the Grid box, see Checking the Grid Alignment on page 275.

File Display Differences
The AGCC Viewer has different types of functions and options for the different image file types that it 
displays:

DAT Files

DAT files are the image data files, the product of the initial scan.They are used to generate the cell 
intensity data file after the grid has been aligned.

The DAT file must be opened to perform manual gridding or to run the grid alignment algorithm in the 
AGCC Viewer.

If the cell intensity data (CEL) file has been generated, you can click the Cell Intensity button  and 
view the cell intensity data in the DAT Image window.

GeneTitan Expression Array Plate DAT File Exposures

Each array is scanned twice, with different exposure times. The image data from both exposures are in 
the GeneTitan Array Plate DAT file. You can switch between the different exposures for checking the 
gridding, etc., by using the Exposure button (see Displaying Different Exposures (GeneTitan Expression 
Array Plate DAT Files Only) on page 270).

Figure 8.9  Parts of the AGCC Viewer with DAT file displayed

Properties box

Grid box

Image window

Image window tool bar
Viewer tool bar

Viewer menu

cursor position

Review window
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GeneTitan MC Genotyping Array Plate DAT File Exposures

In GeneTitan MC each array is scanned twice, with different colors. The image data from both exposures 
are in the GeneTitan MC Array Plate DAT file. You can switch between the different exposures for 
checking the gridding, etc., by using the Exposure button (see Displaying Different Exposures 
(GeneTitan Expression Array Plate DAT Files Only) on page 270).

CEL Files

CEL files are cell intensity data files, produced using the DAT file data after gridding and feature 
extraction.

You cannot perform grid alignment or cell generation on a CEL file.

For certain types of probe arrays, failed control features in the array will be masked when viewing the 
cell intensity data (see Viewing Failed Control Features, below).

JPG Files

JPG files are a copy of the DAT image in a standard image file format; they provide an image file with a 
reduced file size for QC inspection, archiving, and publication.

Viewing Failed Control Features

For certain types of probe arrays, the cell intensity analysis also generates a Cell Summary Report. The 
report has information on the control features on the array that failed certain quality checks.

The failed control features are masked when viewing the cell intensity data in these cases (Figure 8.10).

See Changing the Grid and Intensity Display on page 269 for more information about controlling the grid 
and intensity display.

See Appendix C, Cell Summary Report on page 319 for more information about the cell summary report.

Figure 8.10  Cell intensity data with failed control features masked



Chapter 8  |  Using the AGCC Viewer 249
Moving the Components Out of the Viewer
You can move the following components to a different location on your screen by clicking in the title bar 
and dragging the box to the new location (Figure 8.11).

 Properties box

 Grid box

 Review window

You can move the Image window outside of the Viewer by clicking on the file name tab and dragging the 
window out of the viewer.

To dock the boxes back in the AGCC Viewer:

 Double-click on the box title bar or the file name tab in the Image window.

To choose a new location for the box:

1. Click on the title bar and drag the box back into the AGCC Viewer.

The docking hints buttons appear in the Viewer (Figure 8.12).

Figure 8.11  Dragging boxes outside of the AGCC Viewer
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2. Move the Cursor to the docking hint button. 

A gray box appears to show where the box will dock.

3.  Release the mouse button. 

The box is docked in the selected location.

The Box title bar contains some controls for the Properties and Grid boxes (Figure 8.13):

To close a box:

 Click the Close  button

To use the Autohide feature:

 Click the AutoHide button  in the box.

The box is closed, and a tab is displayed on the left side of the window (Figure 8.14).

Figure 8.12  Using the Docking Hints buttons

Figure 8.13  Box title bars

Docking Hint buttons
Indicator box
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To display a hidden box temporarily:

 Place your cursor on the tab.

To restore a hidden box:

 Display the box and click on the AutoHide button .

Moving the Component Borders in the AGCC Viewer
You can change the relative size of a component in the Viewer by moving the borders of that component.

To change the size of the component:

1. Move the cursor over the border until it changes to a double arrow .

2. Click and drag the cursor to change the size of the area (Figure 8.16).

Figure 8.14  Hidden Grid Box and tab

Figure 8.15  Placing cursor on boundary between two components

Hidden Grid
Box tab

Cursor on boundary
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Using the Review Window
The Review window, at the bottom of the viewer (Figure 8.17), displays a list of DAT files for 
scanned arrays. The window includes various information on the DAT files, including the grid 
alignment and cell generation status.

The Toolbar provides access to different functions of the window.

The Review window displays a list of the scans performed with the following information:

Figure 8.16  Grid box enlarged.

Figure 8.17  Review window

Status Icon  In progress.

 Finished

 Failed

Date Scanned Date and time the array was scanned.

Barcode Array Barcode.

Toolbar
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To enable or disable the Review window:

 From the View menu, select Review Window.

The Review window displays a list of the scanned arrays with their DAT files and their grid alignment 
and cell generation status. 

Well Position Well Position for Array Plate.

Array Name Name of the array file created.

Array Type Probe array model scanned.

Scan Status Status of scan.

Grid Alignment Status of grid alignment.

CEL Generation Status of cell file (CEL) generation.

Date Reviewed Data and time the DAT file was last viewed in the Viewer.

Error Message Short message describing the error found [do we need list of codes?].

Mouse over the error message to see a popup of the entire message.

DAT File Name Name of the DAT file(s) generated.

Mouse over the DAT file name to see the full path.

CEL File Name Name of the CEL file(s) generated.

Mouse over the CEL file name to see the full path.

Last Updated Date the workflow last ran.
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To display a listed DAT file:

 Double-click on the file in the list.

If the workflow is associated with more than one DAT file, the Choose File to Open dialog box opens  
(Figure 8.18).

 Select the DAT file to open and click the OK button in the Choose File to Open dialog box.

The image file is displayed in the viewer (Figure 8.19).

For information on aligning a misaligned grid, see Checking the Grid Alignment on page 275.

To update the list:

 Click the Refresh button  in the Toolbar.

To sort the list for a particular parameter value:

Click in the column header for that parameter.

Figure 8.18  Choose File to Open dialog box

Figure 8.19  AGCC Viewer with DAT file opened
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To select columns for display:

1. Right-click in any column header.

A menu of the column headers appears (Figure 8.20).

2. Select or deselect the desired parameters to conceal and display them.

Changing the Filter Settings
The window enables you to filter the workflows to display only the workflows of interest. 

You can filter the displayed workflows by:

 Date since workflow ran

 Error Status

 Any of the values in the columns.

It also indicates the number of displayed records in the Workflow Review window.

To filter by Date since workflow ran:

 Enter a value for the number of days for which you want to display records and click Apply  
(Figure 8.21).

To display errors only:

 Select the Show Errors Only checkbox  (Figure 8.22)

Figure 8.20  Column Header menu

Figure 8.21  Filter by Date controls

Figure 8.22  Show 
Errors Only checkbox
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To filter by other parameters displayed in the Review window:

1. Select the parameter type from the Filter by drop-down list  (Figure 8.23).

2. Enter a value in the Filter by textbox.

Only the workflows with parameters matching the entered value will be displayed.

Changing the Other Settings of the Workflow Review Window

To change settings for the Review window:

1. From the View menu, select Options...

The Options dialog box opens (Figure 8.24).

2. Select or deselect the following feature:

Figure 8.23  Filter by controls

NOTE: The Filter by function will filter on parameters that are not being displayed in the
Review Window.

Figure 8.24  Options dialog box.

Select parameter then enter value
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 Enable Review Window on startup: turns the Review window on whenever the AGCC Viewer is 
opened.

3. Change the value for the Refresh interval to control the frequency of the Review Window updates.

4. Click OK to close the dialog box and enable the changes.

Opening Image Files
You can display DAT, CEL, and JPG image files in the AGCC Viewer. The Viewer has different 
functions when viewing different types of files (see File Display Differences on page 247).

You have several options for opening files in the Viewer:

 Using the Search and Open Dialog Box, below

 Using the Open Dialog Box on page 264

 Displaying Multiple Files on page 265

 Using the Review Window on page 254

Using the Search and Open Dialog Box
The Search and Open dialog box enables you to search through the files on the AGCC system to find the 
ones of interest.

The Search and Open dialog box enables you to filter the displayed Sample files by:

 Projects

 File Type

 File Creation Date

 Probe Array Type

 Array Name

 Attribute Value

To use the Search and Open dialog box:

1. Click the Search and Open button in the Viewer tool bar; or

From the File menu, select Search and Open....

The AGCC File Open dialog box opens (Figure 8.25).

NOTE: This change will not take effect until you have stopped and restarted the AGCC
Viewer.

TIP: You can also open DAT and CEL files in the Viewer from the Folder View list and from
Windows Explorer.
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The dialog box displays a list of the files that meet the criteria in the upper right corner (Figure 8.26). 
You select the files to display from this list.

The upper left corner displays a list of the projects in AGCC. The lower left corner displays a set of 
additional filters you can apply to the file list.

The Filter Details in the lower right corner displays information about the filter criteria that have been 
applied to the list.

The buttons (Figure 8.27) allow you to:

Figure 8.25  File Open dialog box

Figure 8.26  Unfiltered file list

Figure 8.27  Buttons

List of Projects List of 
available 
files

File types

Filters controls

Filter Details

Buttons
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2. Select the project(s) with files you wish to list in the Projects list (Figure 8.28).

3. Select File Types from the drop-down list.

You can choose from:

 DAT

 CEL

Changes made in the Projects and Files filters are reflected instantly in the Filter Details part of the 
dialog box.

Changes to the Quick Filters and Attribute Value Filters have to be applied by clicking the Apply 
Filters button after selecting.

The Quick Filters (Figure 8.29) enable you to filter by:

 Date of file creation

 Probe Array Types

 Array Name

 Attribute Value

4. Select a date or range of dates for file creation:

A. Select the From checkbox.

Apply Filters Apply selected Quick Filter and Attribute Value Filter criteria

Clear Filters Clear all applied filters

File Attributes Select attributes to be displayed in File list (see Displaying Different File 
Attributes on page 264).

Open Selected Open selected files in File list

Figure 8.28  Displaying Project List

Figure 8.29  Quick Filters
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B. Click the arrow at the date (displays the current date).

A calendar for the current month appears (Figure 8.30).

C. Select a date for the start of the range. You can move from month to month by clicking the < and 
> buttons.

If you only select one date, the filter will display only the files created on that date.

To select a range of dates:

D. Select the To checkbox.

E. Select a date for the end of the range.

5. Select Probe Array Types:

A. Click on the down arrow in the Selected Probe Array Types list.

A list of the available probe array types is displayed (Figure 8.31).

In some cases there may be multiple array models under the same header. in these cases you can 
click the + button to display the additional probe arrays.

B. Select the checkboxes next to the probe array types you want displayed in the filtered list.

6. Enter text strings for Array Name and Attribute Value (Figure 8.32).

Figure 8.30  From Calendar

Figure 8.31  Displaying array types

Figure 8.32  Selecting an attribute
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You can use the “*” symbol as a wildcard in the Array Name and Attribute.

The Attribute Value filters (Figure 8.33) enable you to enter values for specific sample attributes.

7. To enter values for specific attributes:

A. Click the Attribute Value Filters tab (Figure 8.33).

B. Select a template with the attribute you wish to search on from the Select Template list 
(Figure 8.34).

The list displays only the templates with attributes that are being used in the data. |User| attributes 
are the attributes created specifically for a particular Sample (ARR) file and are not included in 
any template list.

The attributes in that template appear in the Name list (Figure 8.35).

NOTE: Entering a string for the Attribute Value will return all files with matches to the
value in any attribute. To search for a file with a specific attribute and value, use the
Attribute File Filters, described below.

Figure 8.33  Attribute Value Filters

Figure 8.34  Select Template
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C. Select the attribute and enter a value for it in the Attribute box.

You can perform special searches by using the “*” and “,” symbols.

“*” Serves as a wild card function. Using searchstring* will return all arrays that contain an 
attribute that starts with the search string. Using *searchstring will return all arrays that contain 
an attribute that ends with the search string.

If you select a numerical attribute, you can select from the following limits:

 Equal to

 Less than

 Less than or equal to

 Greater than

 Between (use comma-separated values to set the ends of the range).

Figure 8.35  Selecting attribute and entering 
value

Figure 8.36  Selecting Limits
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Whenever you change a setting in these filter boxes, you need to apply the changes. A notice 
appears to that effect in the Filter Details area (Figure 8.37).

8. Click Apply Filters after making changes.

9. The changes are displayed in the Filter Details section (Figure 8.38).

The filtered file list is displayed in the File List (Figure 8.39).

10. Select the file(s) you wish to open from the File list and click the Open Selected button.

The selected file is displayed in the Viewer.

Figure 8.37  Filter details with 
Status notice

Figure 8.38  Filter Details with attributes displayed

Figure 8.39  Filtered file list
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Displaying Different File Attributes

To display different file attributes in the File list:

1. Click the File Attributes button.

The Choose Column Details dialog box appears (Figure 8.40).

The dialog box displays a lit of the different characteristics that can be selected for display, with a 
check box next to each characteristic.

2. Select the check box for the characteristics you wish to display.

3. Click OK.

The selected characteristics are displayed in the File list.

Using the Open Dialog Box
The Open dialog box displays a list of all the available image files in the system.

To open a file using the Open dialog box:

1. From the File menu, select Open File; or

Click the Open File button in the AGCC Viewer tool bar.

The Open dialog box opens (Figure 8.41).

Figure 8.40  Choose Column 
Details dialog box

Figure 8.41  Open dialog box
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2. If necessary, use the dialog box tool bar to navigate to the directory with the file.

3. Select the file you wish to view.

4. Click Open.

The selected image file is displayed in the AGCC Viewer.

Displaying Multiple Files
You can open more than one file in the AGCC Viewer (Figure 8.42).

To display a particular image when you have more than one open:

 Click the tab at the top of the Image Window.

Use the < and > scroll buttons in the Image title bar to scroll through the tabs if necessary (Figure 8.43).

Different icons are used for DAT and CEL files.

To display the full path to a displayed file:

 Place your cursor on the file’s title bar tab.

The full path is displayed below the title bar (Figure 8.44).

TIP: You can also open DAT and CEL files in the Viewer from the Folder View list and from
Windows Explorer.

Figure 8.42  Displaying multiple image files

Figure 8.43  Image window title bar

Image Window
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click to close 
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Changing the Display of the Image
This section explains how to use the Image tool bar controls (Figure 8.45) for:

 Examining Different Parts of the Image on page 267

 Adjusting the Colors and Contrast on page 268

 Changing the Grid and Intensity Display on page 269

Part of the tool bar may be hidden if the AGCC Viewer is too small.

To display the hidden controls:

 Click on the Hidden Tool Bar button  at the right of the toolbar (Figure 8.46).

Figure 8.44  Displaying the path to a file

Figure 8.45  Image window tool bar for DAT and CEL file

Figure 8.46  Displaying hidden controls
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The hidden controls are displayed below the tool bar (Figure 8.46). 

Examining Different Parts of the Image
These functions work on DAT, CEL, and JPG files.

The Zoom controls are at the left end of the tool bar.

To zoom in on a selected area of the image:

1. Click on the Zoom Select button .

2. Click and drag around the area you want to examine in more detail (Figure 8.48).

3. Release the mouse button.

4. The selected area is displayed in the AGCC Viewer (Figure 8.48).

Figure 8.47  Zoom controls

Figure 8.48  Click and drag

Zoom buttons

Select Out ResetIn
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To zoom in or out on the whole image:

 Click on the Zoom In button  or the Zoom Out button .

To view a different area in magnified zoom:

 Click and drag the image to view the area of interest. 

To zoom out:

 Click the Zoom Reset button .

Adjusting the Colors and Contrast
These functions work on DAT, CEL, and JPG files.

To switch between Gray Scale or Pseudo Color display:

 Click the Gray Scale  or Pseudo Color  buttons.

To adjust the contrast range for the image:

1. Click the Set Contrast button .

Figure 8.49  Zoomed-in view (with grid displayed)

NOTE: You can also use the Grid box controls to select a particular corner or subgrid for
examination (see Checking the Grid Alignment on page 275).

Figure 8.50  Color and Contrast controls
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The Set Contrast dialog box opens (Figure 8.51).

2. Set the minimum and maximum contrast range.

3. Click OK to use the settings; or

Click Default to return to the default settings; or

Click Cancel to close the dialog box without changing the settings.

You can also use the slide bars in the tool bar (Figure 8.50) to set the contrast without opening the Set 
Contrast dialog box.

Using the Autoscale Function

The autoscale function takes the image area you are currently viewing and calculates the intensity to find 
a better minimum and maximum contrast.

To use the Autoscale function:

 Click the Autoscale button .

The contrast and brightness are automatically adjusted.

Changing the Grid and Intensity Display
These functions only work when DAT files are displayed (Figure 8.52).

Displaying Cell Intensity Data

If you have a DAT file open with the associated cell intensity data (CEL) file available, you can view the 
intensity data in the DAT file Image window.

To display or hide the cell intensity data:

 Click the Cell Intensity button .

The cell intensity data for the array is displayed.

Figure 8.51  Set Contrast dialog 
box

Figure 8.52  Image window tool bar, grid and intensity controls (for DAT files only)

Cell 
Intensity

Grid

Cell Centers

Autoscale
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Displaying Different Exposures (GeneTitan Expression Array Plate DAT Files Only)

Each GeneTitan array is scanned twice, with different exposure times. The image data from both 
exposures are in the GeneTitan DAT file. You can switch between the different exposures for checking 
the gridding, etc., by using the Exposure button. 

The Exposure button displays the currently displayed exposure time.

To switch between views of the different exposures:

 Click the Exposure button.

The other DAT Exposure is displayed.

Displaying Different Wavelengths (GeneTitan MC Genotyping Array Plate DAT Files Only)

Each GeneTitan genotyping array is scanned twice, at different wavelengths. The image data from both 
exposures are in the GeneTitan genotyping DAT file. You can switch between the different exposures for 
checking the gridding, etc., by using the Wavelength button. 

The Exposure button displays the currently displayed exposure time.

To switch between views of the different exposures:

 Click the Color button.

The other genotyping DAT Exposure is displayed.

Displaying Cell Centers

The center of each cell on the array can be displayed for certain array types. The centers are visible only 
when viewing DAT files for probe arrays with subgrids at a sufficiently zoomed-in level. The cell center 
display can be used in evaluating gridding problems.

To display cell centers:

 Click the Cell Centers button .

The cell centers are displayed (Figure 8.55).

NOTE: When displaying cell intensity data for certain types of probe arrays, control feature
cells that failed the cell summary analysis may be masked (see Viewing Failed Control
Features on page 248.

Figure 8.53  Exposure button

Figure 8.54  Wavelength button
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Displaying the Grid Corners

The grid can be displayed to evaluate gridding problems and perform manual gridding.

To display the grid:

 Click the Grid Corners button .

The outline of the grid is displayed on the image.

The grid cells are not displayed until you have magnified the DAT file so that they are visible 
(Figure 8.57).

Figure 8.55  Cell centers displayed for a subgrid

Figure 8.56  Outside edges of main grid displayed
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See Checking the Grid Alignment on page 275 of this manual for more information about manual 
gridding.

Changing Settings for the Grid Display

To change settings for the grid display:

1. From the View menu, select Options...

The Options dialog box opens (Figure 8.58).

2. Select a new color for the grids from the Grid line color drop-down box.

3. Click OK to close the dialog box and enable the changes.

Figure 8.57  Corner grid displayed for a subgrid

Figure 8.58  Options dialog box.
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Saving Image Display Options
You can change the save options for the image display settings. These allow you to apply the same 
contrast and other settings to different image files.

To change the Save Options for the image display options:

1. From the View menu, select Options...

The Options dialog box opens (Figure 8.58).

2. Select an option from the Saving Image Display options drop-down box:

 Do Not Save

 Save: Save settings from one program session to the next.

 During the program session: Save settings only until the Viewer is shut down.

3. Click OK to close the dialog box and enable the changes.

Learning about the Image File
The Properties box displays information about the image file displayed in the window. The information 
can be displayed in alphabetical order, or ordered by different categories, depending upon the type of file 
displayed:

For a DAT file:

 Array Information

 Fluidics

 Grid Alignment

 Image

 Scanner

For a CEL file:

 Array Information

 Cel

 CEL Summary Report (only for files with CEL Summary Reports)

 You can click on the Report row first, and then click on the button that appears to open a text display 
of the CEL Summary report (Figure 8.60).

Figure 8.59  Options dialog box.
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See Appendix C, Cell Summary Report on page 319 for more information.

 Fluidics

 Scanner

To expand or collapse a component: 

 Click on the +/- button to the left of the component.

To sort the data in a different way:

 Click the Category Sort  or the Alphabetical Sort  button.

Grid Information
The Grid information category displays information about the main grid and subgrids:

 Global Grid: Displays the pixel coordinates for the corners of the main grid.

 Subgrids (when available): Displays the pixel coordinates for the corners of each subgrid (Figure 8.62).

Figure 8.60  Cel Summary Report Section

Figure 8.61  Properties box

Click to open the Cell Summary Report

Properties tool bar
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Checking the Grid Alignment
This chapter describes the use of the AGCC Viewer for aligning failed grids:

 Aligning the Main Grid on page 275

 Aligning Subgrids on page 279

 Aligning Subgrids on GeneTitan Arrays on page 284

 Regenerating Intensity Values on page 286

For general information about grid alignment, see Array and Grid Types on page 239.

Aligning the Main Grid
If the array has subgrids, the main grid has to be aligned before aligning the subgrids.

If the main grid is misaligned, you will see a notice in the Review list (Figure 8.63).

To view the main grid:

 Click the Full Image button  in the Grids tool bar (Figure 8.64). 

The main grid is displayed for single-grid and multi-grid files.

Figure 8.62  Subgrids 
displayed

Figure 8.63  Notice of failed grid alignment
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You have two options for fixing an alignment problem:

 You can run the gridding algorithm again (see below).

 You can align the grid manually (see page 277).

Running the Gridding Algorithm

In some cases you can realign the grid by running the alignment algorithm again.

To run the alignment algorithm on an array that uses a single grid:

1. In the Grids tool bar, click on the Image Processing button  and select Realign All 
Grids from the shortcut menu (Figure 8.64).

A notice informs you that a new cell intensity data file (CEL) will be generated.

2. Click Yes to proceed with the alignment.

Progress bars display the progress of the alignment and cell generation.

When the process is finished, a notice appears (Figure 8.67).

NOTE: Realigning the grids will update DAT headers and break the parent-child
relationship between DAT files and existing CEL files until the CEL files are regenerated.

Figure 8.64  Grid box tool bar

Figure 8.65  Notice of regridding

Figure 8.66  Progress bar
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New gridding information and a new CEL file are generated.

Aligning the Grid Manually

If the algorithm alignment fails, an error message appears (Figure 8.68).

If you see the error message, you can manually adjust the main grid by using the following procedure:

1. Click on the failed DAT file in the Review window.

The main grid is displayed in the Image window (Figure 8.69).

Figure 8.67  Notice

Figure 8.68  Notice of main grid misalignment

Figure 8.69  Misaligned main grid
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2. Align the grid at each corner of the image:

A. Click a Corner button in the Grid box toolbar (Figure 8.70) to choose a corner.

The selected corner is displayed in the Image window (Figure 8.71). The software will display a 
box around each feature of the corner grid.

B. Place the mouse arrow over the grid perimeter (the arrow becomes a double arrow, ).

The diagonal orientation of the double arrow along the perimeter of a corner probe cell indicates 
horizontal and vertical adjustments can be made simultaneously using the click-and-drag method 
or by using the keyboard arrow keys.

C. Use the click-and-drag method or the keyboard arrow keys to adjust the horizontal or vertical 
position of the grid so that it is aligned over the corner of the outermost corner checkerboard.

D. Repeat the above steps for the other corners of the main grid.

3. After you align the grid, click the Save button  or select File → Save from the menu bar.

A notice opens, informing you that a new cell intensity data file will be generated automatically 
(Figure 8.72).

Figure 8.70  Grid box toolbar

Figure 8.71  Lower right corner displayed in the image 
window

Corner buttons Image Processing Options
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4. Click Yes to save the DAT file and generate a new CEL file.

The cell intensity data file will be generated automatically.

For arrays with a single grid, you can now proceed to generate the CEL file (see Regenerating 
Intensity Values on page 286).

For arrays with subgrids, you can now check the alignment of the subgrids (see Regenerating 
Intensity Values, below).

Aligning Subgrids
Sometimes one or more subgrids may require alignment. The failed subgrids are marked with an X in the 
Grids box (Figure 8.73).

If the subgrid alignment fails you can: 

 Run the subgrid alignment algorithm (see below).

 Perform a manual alignment on the failed subgrids (see page 281).

Running the Subgrid Alignment Algorithm

You can run the subgrid alignment algorithm if some of the subgrids are misaligned or if you have 
manually aligned the main grid.

To run the alignment algorithm again on an array that uses sub-grids:

1. In the Grids toolbar, click on the Image Processing button  and select Realign All 
Grids from the shortcut menu (Figure 8.74).

Figure 8.72  Notice

Figure 8.73  Grid box

NOTE: Realigning the grids will update DAT headers and break the parent-child
relationship between DAT files and existing CEL files until the CEL files are regenerated.

Misaligned 
subgrids 
are marked 
with an X
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A notice informs you that a new cell intensity data file (CEL) will be generated (Figure 8.75). 

2. Click Yes to proceed with the alignment.

Progress bars display the progress of the alignment and cell generation (Figure 8.76).

When the process is finished, new gridding information and a new CEL file are generated.

To run the subgrid alignment algorithm only:

1. In the Grids toolbar, click on the Image Processing button  and select Realign 
Subgrids Only from the menu (Figure 8.74).

A notice informs you that a new cell intensity data file (CEL) will be generated (Figure 8.77).

2. Click Yes to proceed with the alignment.

Progress bars display the progress of the alignment and cell generation (Figure 8.78).

Figure 8.74  Grids tool bar for array with subgrids

Figure 8.75  Regridding notice

Figure 8.76  Progress bars

NOTE: This will align the main grid and all the subgrids.

Figure 8.77  CEL generation notice
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When the process is finished, new gridding information and a new CEL file are generated.

Manually Aligning the Subgrids

The boundaries of a subgrid are indicated by the alignment patterns at the four corners of the subgrid. A 
small checkerboard may mark the corner of two or more subgrids, depending upon its position in the main 
grid (Figure 8.79).

If the sub-grids are not aligned correctly, the following error message appears after imaging an array or 
opening a DAT file (Figure 8.80):

Navigating from Subgrid to Subgrid

The failed subgrids are marked with an X in the Grids box (Figure 8.81).

Figure 8.78  Progress bars

Figure 8.79  Subgrid borders

Figure 8.80  Notice of subgrid misalignment(s)
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Highlighting

 Selected subgrids are highlighted in blue

 Selected misaligned subgrids are highlighted in yellow

 Modified subgrids are highlighted in green.

You can step through subgrids using the right and left buttons (Figure 8.82).

To step through all subgrids:

1. Toggle the Step button  to the all position

2. Click the left  and right  buttons to step through the subgrids.

To step only through the misaligned grids

1. Toggle the Step button to the misaligned position.

2. Click the left  and right  buttons to step through the subgrids

To manually align a failed subgrid:

1. Click OK in the Subgrid Alignment Failure dialog box (Figure 8.80).

2. Click on the subgrid you wish to align in the Grid box.

3. A zoomed-in view of the subgrid appears in the Image window (Figure 8.83).

Figure 8.81  Misaligned subgrids in the Grids box

Figure 8.82  Grid box toolbar, subgrid step buttons

Misaligned 
subgrids are 
marked with 
an X

All grid/
Bad Grid Only

Left Right
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4. Align the subgrid at each corner:

A. Click the Go To Corner button for the corner you wish to align.

A zoomed-in view of the corner of the subgrid appears (Figure 8.84).

B. Place the mouse arrow over the grid perimeter (the arrow becomes a double arrow, ).

The diagonal orientation of the double arrow along the perimeter of a corner probe cell indicates 
horizontal and vertical adjustments can be made simultaneously using the click-and-drag method 
or by using the keyboard arrow keys.

C. Use the click-and-drag method or the keyboard arrow keys to adjust the horizontal or vertical 
position of the subgrid so that it is aligned over the outside corner of the small checkerboard 
pattern (Figure 8.85).

Figure 8.83  Selected subgrid

Figure 8.84  The upper right subgrid corner
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D. Repeat steps A through C for the other corners of the subgrid.

5. Continue manually aligning all misaligned subgrids.

6. After you align the grid, click the Save button  or select File → Save from the menu bar.

The Notice appears (Figure 8.86).

7. Click Yes to save the file.

The file is saved and CEL file generation is done. 

Aligning Subgrids on GeneTitan Arrays
You use the same controls and steps to align subgrids for GeneTitan arrays as you do for cartridge arrays, 
with the following exceptions:

 You do not need to perform a main grid alignment

 You may have to check the grid alignment for both exposures (see Displaying Different Exposures 
(GeneTitan Expression Array Plate DAT Files Only) on page 270) or both wavelengths (see Displaying 
Different Wavelengths (GeneTitan MC Genotyping Array Plate DAT Files Only) on page 270.

 You can select an option to apply adjusted coordinates to all channels and exposures (see Changing the 
Manual Grid Adjustment Setting on page 285

Figure 8.85  Dragging the subgrid boundary

Figure 8.86  Save notice
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Changing the Manual Grid Adjustment Setting

You can apply the coordinate adjustments made to one exposure time or channel to the other exposure 
time or channel.

To change settings for the manual grid adjustment:

1. From the View menu, select Options...

The Options dialog box opens (Figure 8.88).

2. Select or deselect the Manual Grid Adjustment checkbox.

Figure 8.87  GeneTitan Array DAT file, grid selected

Figure 8.88  Options dialog box.
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3. Click OK to close the dialog box and enable the changes.

Regenerating Intensity Values
Cell intensity values are generated automatically after:

 Running any grid alignment algorithm.

 Saving a DAT file after manual gridding.

You can also regenerate the intensity values without performing one of these other steps.

To regenerate the intensity values:

1. In the Grids toolbar, click the Image Processing button .

2. Select Regenerate CEL Intensity from the list.

A new CEL intensity data file will be generated. It will automatically have an underscore and number 
appended to the name to distinguish it from a previously generated file.

Exporting Images in Other Formats
You have two options for exporting a copy of the image:

 Copying Images to the Computer Clipboard

 Creating a JPG File on page 286

Copying Images to the Computer Clipboard

To copy an image to the computer clipboard:

1. Display the image you wish to copy in the Image window.

2. Click the Copy button in the image window toolbar (Figure 8.89); or

Press CTRL-C.

The image in the Image window is copied to the clipboard.

You can then paste the image into a graphics program such as Paint and save it as a graphics file.

Creating a JPG File
You can create a JPG copy of a DAT file for archive purposes. 

To create a JPG copy of a DAT file:

1. From the File menu, select Create JPG from DAT....

The Open dialog box opens (Figure 8.90).

TIP: You can zoom in on a specific region of the image if you desire before
copying.

Figure 8.89  Copy button

Copy button
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2. Select the DAT file you wish to copy.

3. Click Open. 

The JPG file is created. 

Viewing the JPG File

To open the JPG file in the AGCC Viewer:

1. Click File → Open File from the main menu; or

Click the Open File button in the AGCC Viewer tool bar.

The Open dialog box opens (Figure 8.91).

2. If necessary, use the dialog box tool bar to navigate to the directory with the file.

3. Select the file you wish to view.

4. Click Open.

The selected image file is displayed in the AGCC Viewer.

Figure 8.90  Open dialog box for JPG creation

Figure 8.91  Open dialog box
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To open the JPG in the Windows Picture and Fax Viewer:

 In the Folder View, click the Explore link next to the JPG file.

The selected JPG file is displayed in the Windows Picture and Fax Viewer.

Changing Settings for the JPG Conversion

To change settings for the JPG conversion:

1. From the View menu, select Options...

The Options dialog box opens (Figure 8.92).

2. Change the values for Compression Ratio and Sampling Ratio.

Increasing either of these values increases the resolution of the JPG image, but also increases the size 
of the JPG file.

3. Click OK to close the dialog box and enable the changes.

Figure 8.92  Options dialog box.
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Changing The Probe Array Type
AGCC enables you to change the probe array type for any or all of a group of files. 

The Change Probe Array Type function enables you to:

 Change the probe array type for the selected Sample and data files, regrid the associated DAT files, and 
regenerate the associated CEL files

 Change the probe array type field for selected CEL files

You might wish to use this function:

 If you are working with probe arrays that can be used for more than one type of analysis.

 If you have analyzed a set of prototype arrays using a preliminary set of library files, and you now have 
the correct library file set.

To change the probe array type for a group of files:

1. Select the files for which you which to change the probe array type.

You can select files to change from:

 The Folder View (see Selecting Files on page 35).

 The Project View (see Selecting Files on page 43).

 The Search Results page (see Selecting Files on page 53).

2. Select Change Probe Array Type from the Command to Run drop-down list.

The Change Probe Array Type page opens (Figure 9.1).

3. Select the option you wish to use:

 Realign the grids of DAT files and regenerate CEL files, overwriting existing files.

This option will:

 Change the probe array type for the selected Sample and data files

 regrid the associated DAT files

 regenerate the associated CEL files and the cell summary report file

NOTE: The Change Probe Array Type function cannot be used for GeneTitan® Array Plates.

Figure 9.1  Change Probe Array Type page
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 Change only the probe array type of a selected CEL file.

This option will only change the probe array type information in the selected CEL file(s). It does 
not modify the Sample probe array type information in the Sample file or the DAT file. 

This option is for use when using a CEL file that belongs to a multi-use array. These arrays that can 
be analyzed in multiple ways, as an Expression array or a Genotyping array.

4. Click Next.

The page displays the data files (Figure 9.2).

5. Select the files to be changed by selecting the checkboxes in the left-hand column.

You can use the Select All and Deselect All buttons to select all or deselect all files.

6. Select the probe array type you want to change the selected files to from the drop-down list 
(Figure 9.3).

IMPORTANT: Realigning the grids will break the parent-child relationships between
DAT files and CEL files and between CEL files and CHP files until the CEL files are
regenerated (Any CHP files are not automatically regenerated; you must regenerate
them manually). Choosing this action will not delete any vital information because you
can change the probe array type back to its original value if you change your mind.

Figure 9.2  Change Probe Array Type page, step 2

Figure 9.3  File Type list
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7. Click Next.

The page displays the progress of the transformations (Figure 9.4).

Figure 9.4  Progress of probe array type changes
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Administration Functions
The Administration functions provide additional options for organizing and tracking your data:

 Working with Templates on page 292

 Tracking the Workflow on page 299

Working with Templates
Templates are used to organize a set of attributes that you can use to create a new Sample file.

Attributes are properties used to describe a sample and its associated array(s). Attributes include items 
like:

 Sample Name

 Gender

 Date

 Array Type

 Array Barcode

When you create a template, you specify:

 the attributes included in the template 

 the data type for each attribute:

 Text: text string

 Number: Floating point or Integer

 Date: Calendar data

 SingleSelect: enables the user to select a single item from a controlled vocabulary list

 whether the attribute is required

 value options for SingleSelect attributes

Templates allow you to organize attributes and collect consistent data for your experiments and samples.

The following templates are included in the AGCC install:

 MIAME sample information

 Pedigree template

This section describes the following functions:

 Creating a Template, below

 Editing a Template on page 295

 Deleting Templates on page 296

 Managing Default Templates on page 298

NOTE: The Project functions are described in Using Projects to Organize Data on page 57.
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Creating a Template

To create an attribute template:

1. From the Templates menu, select New Template.

The Create Template File page appears (Figure 10.1).

2. Enter a name for the template and click Next.

The Add Attributes page opens (Figure 10.2).

The page displays a lit of the attributes for the template.

Figure 10.1  Create Template File page

Figure 10.2  Edit Templates page
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To add a field to the list:

3. Click Add.

A new row appears in the list, with the following boxes for entering information or links:
.

4. Enter or select values for the field characteristics.

5. Repeat Step 3 and Step 4 for the other attribute fields you wish to add.

When you have finished creating the attribute fields:

6. Click Save to save the template.

The Results Page displays the name of the created template (Figure 10.3).

Sample Attribute 
Name

Enter a name for the attribute.

Required Click if the attribute is required.

Type Select from drop-down list:

•Text: Text string

•Number: Integer or floating point number

•Date: Calendar data

•SingleSelect: Presents a list of items for the 
user to choose

Control 
Vocabulary

Enter values for the controlled vocabulary, placing multiple 
values on separate lines.

Default Value Enter a default value to be displayed for the field in a new Sample 
file.

Figure 10.3  Result page
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Editing a Template
You can edit an existing template. 

To edit a template:

1. From the Templates menu, select Edit.

The Edit Template File page appears (Figure 10.4).

2. Select the template you wish to edit and click Next.

The Add Attributes page opens (Figure 10.5).

NOTE: Deleting an attribute from a template or changing data type will cause attribute
discrepancies if you have already used the template to create Sample files. See Sample
Attributes Conversion on page 92 for more information.

Figure 10.4  Edit Template File
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You can add, edit, or delete fields with the same functions used to create a new template. For more 
information see Creating a Template on page 293.

When you have finished editing the attribute fields:

3. Click Save to save the template.

The Results Page displays the name of the created template.

Deleting Templates
You can delete a template from the list.

Figure 10.5  Add Attributes page

Figure 10.6  Results page
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To delete a template:

1. From the Administration menu, select Templates → Delete.

The Delete Template File page appears (Figure 10.7).

2. Select the template to be deleted from the drop-down list.

3. Click Delete.

The template is deleted  (Figure 10.8).

NOTE: Deleting a template will cause attribute discrepancies if you have already used the
template to create Sample files. See Sample Attributes Conversion on page 92 for more
information.

Figure 10.7  Delete Template File page

Figure 10.8  Notice of template deletion
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Managing Default Templates
The default template attributes are displayed when the Detailed Sample Registration function is used and 
are displayed in the Default view in Folder view.

To change the default templates:

1. From the Administration menu, select Templates → Default.

The Default Template File page appears (Figure 10.9).

Click on a template name to see a list of the attributes in that template (Figure 10.10).

2. Select the template(s) to be defined as default templates from the Available Templates list.

3. Click Add.

The template is moved to the Default Templates list.

You can also use the Remove button to remove templates in the Default Templates list.

The template attributes will be available in the Detailed Sample Registration page (Figure 10.11).

Figure 10.9  Manage Default Templates page

Figure 10.10  Template Details
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Tracking the Workflow
The Workflow Monitor page enables users to view a list of the arrays in the workflow and see what their 
status is. 

To view the Workflow Monitor page:

 Click Administration → Workflow. 

 The Workflow Monitor page opens (Figure 10.12).

Figure 10.11  Detailed Sample Registration page with default Template attributes

Figure 10.12  Workflow Monitor page
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The Workflow Monitor page displays a list of the files waiting to finish workflow steps. It displays an 
item for each file and each unfinished step in the workflow; a file may have multiple entries, depending 
upon what step in the workflow has been completed. 

For each file, the following information is given:

To sort the file list by any column:

 Click on the column header.

Barcode Barcode of array.

Array Name Name assigned to the array by the user.

Probe Array Type Model of probe array.

Sample file Name of Sample file.

Workflow Step The uncompleted step in the workflow.

Project Project folder the Sample file is assigned to.

Status • Running.

• Not Ready.

• Error.
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Network Functionality for AGCC on Windows XP or Windows 7
A computer running Windows XP or Windows 7 and AGCC can be connected to a Windows network to 
provide the following functions:

 Using network data storage

If the Windows network has a network data root, you can consolidate data from multiple computers 
running AGCC Instrument Control in a single location. AGCC Portal provides convenient ways to 
keep Sample (.ARR) files and data files (DAT and CEL) in the same folder on the network data 
storage. 

 Running different parts of the workflow on different IC workstations

In some cases the Fluidics Station and Scanner used to process an array are controlled by different 
workstations. AGCC software allows you to perform different workflow tasks on different 
workstations while consolidating the Sample (.ARR), Data (DAT and CEL) and Audit files at a single 
storage location (during processing the files may be on different machines).

Examples of different configurations for AGCC with Windows network are given in Sample 
Configurations for AGCC with Network Functionality on page 301.

After installing the AGCC components, to use the network functionality you need to:

1. Connect the computer to a Windows network with necessary permissions and have permissions set 
for using network data storage.

See Setting Up Windows Networking on page 306 for more information.

2. Configure AGCC Services with the proper domain and user account with password to access the 
network assets.

See Configuring AGCC Services on page 307 for more information.

3. Add network data storage as a data root in AGCC Portal

Adding the Network Data Storage as a Data Root on page 313.

Sample Configurations for AGCC with Network Functionality
This section describes some sample configurations using AGCC network functionality: 

 Linked Instrument Control Systems, below

 Network Storage on page 303

The sample configurations show some of the ways you can connect computers with different roles in 
order to consolidate data, perform different parts of the workflow, and provide data access to other users.

NOTE: Contact your IT/CIS support for help with configuring network functionality.

NOTE: You cannot create DAT files on network data storage. AGCC Portal provides tools for
consolidating the data files with the Sample files on network data storage (see Uploading
Data to Network Data Storage on page 68 of the AGCC User Manual.
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Linked Instrument Control Systems
This configuration (Figure A.1) enables you to perform different instrument control tasks on different 
workstations while consolidating the data files on the Scanner workstation.

In the linked IC Workstation configuration, the Scanner Workstation and the AGCC Fluidics Workstation 
are linked with Windows Network.

Computer Roles in Linked Control Systems

Scanner System

The scanner workstation can be considered the ‘main’ system, in that the Sample files will be generated 
and stored there and all related DAT, CEL, and CHP files can be consolidated at the same location.

The dataroot of the scanner workstation is shared so that the fluidics workstation can access the Sample 
files and log AUDIT information for the arrays that are run through the fluidics station, without needing 
to copy the files locally. 

Requirements for the scanner system:

 Has the following software installed

 Windows XP SP3 and above or Windows 7 with SP1

 AGCC Portal with AGCC Portal Web Server

 AGCC Viewer

 AGCC Scanner Control

Tasks that can be performed using the IC Scanner Workstation:

 Create and edit Sample (.ARR) file and Register Array 

 Run Scan on array to create DAT file

 Grid and get CEL Data (and perform manual grid alignment check if necessary)

 Index and search the workstation data.

Fluidics System

In the linked system, the fluidics workstation does not store any Sample files, or generate DAT, CEL or 
CHP files. It uses the Sample files on the scanner system, and writes back AUDIT information about the 
fluidics processing. If necessary, the fluidics workstation can also register arrays/samples that will be 
stored on the scanner workstation.

Figure A.1  Linked instrument control system
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The IC workstation has AGCC Portal and AGCC Instrument Control installed. A Fluidics workstation 
can control up to eight fluidics stations.

Requirements:

 Has the following software installed

 Windows XP SP3 and above or Windows 7 with SP1

 AGCC Portal with AGCC Portal Web Server.

 AGCC Fluidics Control

 Connected through Windows Network to the Scanner System.

 Have necessary Domain and User Permissions settings to enable Read/write to the Scanner System.

 AGCC Services configured to work with Scanner System.

 Have Scanner System set up as a data root for AGCC Portal

Tasks that can be performed using the IC Fluidics Workstation:

 Run Fluidics station and update the Audit file for the array.

 Index and search the Fluidics workstation data and the Scanner workstation data.

 Edit Sample (.ARR) files on the Scanner and Fluidics workstation data.

The Fluidics system can also move data to and from Scanner System using Windows Explorer.

Network Storage
This configuration (Figure A.2) provides storage and tools to consolidate the data produced by a set of 
IC workstations. It also enables other users linked through the Windows Network system to access the 
data. 
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Computer Roles for Network Storage

The network data storage configuration supports the following computer roles:

 Network Data Storage

 AGCC IC Workstations

 Local Analysis Workstation

 Local Lab Computer

Network Data Storage

Network data storage serves as the central data repository for the networked computers. Sample (.ARR) 
files are created on it and the DAT and CEL data are pushed out to it from the IC workstations. The 
network data storage computer does not need to have any AGCC software installed.

AGCC IC Workstations

The IC workstation has AGCC Portal and AGCC Instrument Control installed. An IC workstation can 
control one scanner and up to eight fluidics stations.

AGCC IC Workstations have the following requirements:

 Has the following software installed

 Windows XP SP3 and above or Windows 7 with SP1

 AGCC Portal with AGCC Portal Web Server

Figure A.2  Network Data Storage configuration
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 AGCC Viewer

 AGCC Instrument Control

 Connected through Windows Network to the network data storage.

 Have necessary Domain and User Permissions settings to enable Read/Write access to the network data 
storage.

 AGCC Services configured to work with network data storage.

 Have network data storage set up as a data root for AGCC Portal.

Tasks that can be performed using the IC Workstation:

 Create Sample (.ARR) file and Register Array on network data storage and the workstation.

 Run Fluidics and Scan array to create DAT file.

 Grid DAT files, perform manual grid alignment check if necessary, and generate CEL file data.

 Use AGCC Portal data management functions to upload DAT and CEL files to network data storage in 
same folder as Sample (.ARR) file.

 Index and search the network data storage and the workstation data.

 Edit Sample (.ARR) files on the network data storage and the workstation.

The local IC workstation can also move data to and from network data storage using Windows Explorer.

Local Analysis Workstation

The IC workstation has AGCC Portal and AGCC Viewer installed.

A local Analysis Workstation has the following requirements:

 Windows XP SP3 and above or Windows 7 with SP1

 AGCC Portal with AGCC Portal Web Server.

 AGCC Viewer 

 Connected through Windows Network to the network data storage

 Have necessary Domain and User Permissions settings to enable Read/Write access to the network data 
storage.

 AGCC Services configured to work with network data storage.

 Have network data storage set up as a data root for the AGCC Portal

It can perform the following tasks:

 Create and edit Sample (.ARR) files on the network data storage and the workstation.

 Index and search the network data storage and the workstation data.

 Manual Gridding of DAT files on the workstation.

 Re-calculating CEL file data after gridding.

The local Analysis Workstation can also move data to and from network data storage using Windows 
Explorer.

Local Lab Computer

Lab Computers do not have any AGCC software installed. Lab Computers are commonly used to perform 
higher-level analysis on the data. 

Requirements:

 Connected through Windows Network

 Have necessary Domain and User Permissions settings to enable Read/Write access to the network data 
storage.

The local Lab computer can move data to and from network data storage using Windows Explorer.
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Setting Up Windows Networking
A computer running AGCC on Windows XP SP3 and above or Windows 7 with SP1 can be connected to 
a Windows network to provide different options for data consolidation and sharing.

Computers connected to the network are organized into domains. A domain is a group of computers that 
share common security and user account information. 

Each user is assigned to a domain and given a user account with a name and password. 

Any computer on the proper domain with necessary user permissions can get on the system using 
Windows Explorer and move data files on and off the network data storage.

If on a Windows domain these need to be domain accounts. If not on a Windows domain the share and 
the machine need matching account names and passwords.

Work with your IT department for help in setting up the necessary domain and user accounts.

For more information about Windows sharing and permission issues, see Appendix B, Windows Sharing 
and Security Issues of the AGCC User Manual.

If the domain, user account, and permissions are correct, when the computer running AGCC on Windows 
XP or Windows 7 is connected to the network you should be able to see the network data storage using 
Windows Explorer. You will not be able to add network data storage as an AGCC data root or use AGCC 
Portal to search the network data storage until you have configured the AGCC Services with the proper 
domain and account information.

Sharing and Security
You can use the Windows Sharing and Security settings to control access to your data when using 
network functionality. AGCC supports setting permissions at the folder level, not the file level, even 
though the Windows settings can be set at the file level. You can change the settings for Sharing, 
permissions, and security for a selected file, but you need to be very careful about setting permissions 
when using AGCC; you could lock yourself out of your own data or deny access to other people if the 
permissions are set incorrectly. 

Work with your IT department for help in setting the permissions. 

For more information about Windows sharing and permission issues, see Appendix B, Windows Sharing 
and Security Issues of the AGCC User Manual.

Examples

Let's take two different examples of how you might configure your file permissions for a network folder. 

In the first example, you have a folder that is shared by your department. This folder allows read and write 
access to a Windows domain group called “Liver Cancer Group”, and grants no other permissions to 
anyone else. In order for AGCC to be able to access this network folder, you must change your AGCC 
Services to run as one of the users who is a member of the Liver Cancer Group.

In the second example, you have a folder on a computer in a lab that you want access to, but you don't 
want anyone else to access that folder. If you create a local user account on that computer called 
LocalUser, with the password “LocalPassword”, then, you can share that folder on the network, but grant 
access only to LocalUser. If you have a computer outside of that lab that has AGCC installed, then you 
can also create LocalUser as a local user on this second computer, with the same password, and then 
change the AGCC services on that second computer to run as LocalUser. Now, if you add your network 
folder as a Data Root, then you should be able to have complete access to that network folder in AGCC.
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Configuring AGCC Services
AGCC services are tools that perform the functions of the software. To add a network data share as a data 
root, these services need to be configured as a domain user account, instead of a local system account. 

The AGCC services that need configuring include:

 AGCCAuditLogger

 AGCCIndexer

 AGCCTaskManager

 AGCCWebServer

 AGCC96FS_WorkflowSvc

If on a Windows domain these need to be domain accounts. If not on a Windows domain the share and 
the machine need matching account names and passwords.

You can also use matching local accounts on a domain.

Configuring the AGCC Portal Services for Windows XP

1. From the Windows Start menu, select Settings → Control Panel.

The Control panel opens (Figure A.3).

2. Double-click on Administrative Tools. 

The Administrative Tools window opens. (Figure A.4 on page 308)

NOTE: You need to be logged in using an account with Administrator privileges to perform
this configuration.

Figure A.3  Control Panel
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3. Double-click the Services icon.

The Services window opens  (Figure A.5).

There are 5 Affymetrix services: 

 AGCCAuditLogger

 AGCCIndexer

 AGCCTaskManager

 AGCCWebServer

 AGCC96FS_WorkflowSvc

You will need to perform steps 4 through 7 for all services.

4. Right click AGCCAuditLogger (or another service you are configuring) and select Properties. 

The Properties dialog box opens. (Figure A.6 on page 309)

Figure A.4  Administrative Tools window

Figure A.5  Services window
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5. Click the Log On tab (Figure A.7).

6. Change the log on information for the service.

A. Change the service to Log on as "This account". 

 Supply a domain user and password if on a domain.

 Supply a local account with matching username and password as the network storage device if 
not.

B. Click OK.

7. Stop and start the service from the services dialog. (Figure A.8 on page 310)

Figure A.6  Properties dialog box

Figure A.7  AGCC AuditLogger Properties 
dialog box, Log On tab
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8. Repeat steps 4 through 7 for the other AGCC services.

Configuring the AGCC Portal Services for Windows 7

1. From the Windows Start menu, select Control Panel.

The Control panel opens. (Figure A.9)

2. Make sure the View by (upper right) is set to Small icons, then click on Administrative Tools. 

The Administrative Tools window opens. (Figure A.10 on page 311)

Figure A.8  Turning service off and on

Figure A.9  Control Panel
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3. Double-click Services.

The Services window opens  (Figure A.11).

There are 5 Affymetrix services: 

 AGCCAuditLogger

 AGCCIndexer

Figure A.10  Administrative Tools window

Figure A.11  Services window
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 AGCCTaskManager

 AGCCWebServer

 AGCC96FS_WorkflowSvc

You will need to perform steps 4 through 7 for all services.

4. Right click AGCCAuditLogger (or another service you are configuring) and select Properties. 

The Properties dialog box opens (Figure A.12).

5. Click the Log On tab (Figure A.13).

6. Change the log on information for the service.

A. Change the service to Log on as "This account". 

B. Supply a domain user and password if on a domain.

C. Supply a local account with matching username and password as the network storage device if not.

7. Click OK.

A message window appears stating you have been granted Log On As privileges.

8. Click OK.

Figure A.12  Properties dialog box

Figure A.13  AGCC AuditLogger 
Properties dialog box, Log On tab
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A message window appears stating you must stop and restart the service to initiate your new login 
appears.

9. Click OK.

The Services window appears.

10. Click to highlight the service you just modified. then stop and start the service from the services 
dialog. (Figure A.14)

11. Repeat steps 4 through 7 for the other AGCC services.

Adding the Network Data Storage as a Data Root

To add the network data storage as a data root in AGCC Portal:

1. Start AGCC Portal.

2. Navigate to Data → Data Roots → Add.

3. Paste the UNC path to the share into the dialog box. UNC paths follow this format: 
\\servername\share. Mapped network drives should not be used (mapped network drives are network 
folders that a user has mapped to a drive letter, for example, “H:”.)

4. Click Add.

Figure A.14  Turning service off and on

NOTE: You cannot create DAT files on network data storage. AGCC Portal provides tools for
consolidating the data files with the Sample files on network data storage (see Uploading
Data to Network Data Storage on page 68 of the AGCC User Manual.

Figure A.15  Adding network data root
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If you configured this correctly you should be able to view the share in the Folder Viewer.

NOTE: If you have not configured the AGCC Services correctly, you will see a warning
message in the Add Data Root window. For more information on what to do, see
Configuring AGCC Services on page 307.

Figure A.16  Network data root
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Windows Sharing and Security Issues
You can use the Windows Sharing and Security settings to control access to your data when using 
network functionality. AGCC supports setting permissions at the folder level, not the file level, even 
though the Windows settings can be set at the file level. You can change the settings for Sharing, 
permissions, and security for a selected file, but you need to be very careful about setting permissions 
when using AGCC; you could lock yourself out of your own data or deny access to other people if the 
permissions are set incorrectly. 

The Windows file sharing and security issues are described in further detail in:

 General Principles of Security in Command Console Software, below

 How do Files Get Permissions That Don't Match the Folder? on page 315

 How Does Command Console Show this Error? on page 316

 How to Avoid This Issue on page 316

 How to Adjust Permissions for Files in a Folder on page 317

General Principles of Security in Command Console Software
Security within Command Console® can be separated into 2 different functional areas:

 Viewing file lists in the web UI, either from folders or from search results.

 File operations, such as editing or creating. 

Security for viewing file lists is implemented at the folder level. If a user has read permissions on a 
particular folder, Command Console will not display files within that folder if the user does not have read 
permissions for those files. In addition, if the user tries to perform various operations on those files, the 
operating system will not allow it. Conversely, if the user has read permissions to several files in a folder, 
but does not have read permissions on the parent folder, the files will not be displayed in the Command 
Console software. In order to maintain consistent permissions on files within the system, individual files 
should not have permissions set differently from their parent folder. If this occurs due to other 
applications or operating system functions, the permissions on all the files in a folder can be reset by an 
administrator.

When performing file operations, including editing the Sample (ARR) file, re-gridding the Image (DAT) 
file, or regenerating an Intensity (CEL) file, a user may be prohibited by the operating system if the user 
does not have appropriate permissions for that file. The Command Console UI attempts to indicate when 
an operation fails due to permissions, but there are times when the operating system does not indicate 
why an operation failed. If the user expects to be able to modify a file but cannot, and can modify other 
files within the same folder, it is possible that individual files have permissions that limit access. If this 
occurs, the file permissions should be checked by an administrator and reset as necessary.

How do Files Get Permissions That Don't Match the Folder?
Under most operating conditions, the files in a folder will have the same permissions as the folder in 
which they reside. However, there are particular cases when a file is moved that may cause the file to 
retain certain permissions that were applied to the file in its previous location. In this case, the file will 
not have the same permissions as the new folder or the other files in the folder. 

This happens to files that are moved to a new folder on the same NTFS partition on a local hard disk. It 
is important to note - this is a function of the Operating System, not Command Console. 

NOTE: Contact your IT/CIS support for help in setting the permissions for folders and files.
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As an example, a data folder has two subfolders, Project1 and Project2, and the Project1 and Project2 
folders have different permissions. If a user with appropriate permissions moves a file from Project1 to 
Project2, the files moved to the Project2 folder may retain some of the permissions applied in the Project1 
folder. If another user who has permissions to the Project2 folder but not to the Project1 folder tries to 
perform operations on these moved files, the operations may fail.

There are many conditions where this does not occur:

 Moving a file from a local hard disk to network storage (C:\data to \\storage\data)

 Moving a file from one folder to another on network storage (\\storage\data to \\storage\backup)

 Moving a file from one local hard disk to another local hard disk (C:\data to D:\data)

 Copying files from one location to another

How Does Command Console Show this Error?
The files or folders to which the user does not have access are not visible in the AGCC Portal pages. For 
example, if the user has read permission for a folder, but is denied access to specific files in the folder, 
the files are not displayed in the following pages:

 Folder View

 Search Results

 Project View

In the Copy Project page, only files in the project to which the user has access can be copied. 

How to Avoid This Issue
There are ways to avoid this issue that will not impact normal operations. These include:

 Not setting overly restrictive permissions on shared systems, especially Instrument Control 
Workstations

 Using network storage for the bulk of data, and applying permissions on the network folders

 Only applying permissions on the network folders that are truly necessary

 Access data through UNC paths whenever possible

Some simple security recommendations:
 Set permissions for groups, as opposed to individuals, for greater simplicity.

 Only restrict permissions to the degree needed, again for greater simplicity.

 Set permissions at the folder level when creating data roots and projects.

 Don’t use Deny permissions unless absolutely necessary, as these are more likely. to cause a situation 
with conflicting entries.

 Don’t restrict (deny) the “Read permissions” permission. This is needed in order for the software to 
properly determine the rights the user has for a given object.

 Take care when moving files that the consistency is not broken. If possible, move files by using the 
WebUI Copy Project and Upload Data functions.

 When permissions do get out of sync, they can be easily restored by an admin, who can remove the 
conflicting ACL entries and allow the file to get its permissions by pure inheritance.
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How to Adjust Permissions for Files in a Folder
To reset the permissions for all files and subfolders in a folder:

1. Right-click on the folder in question and select Sharing and Security from the context menu.

The Data Properties dialog box for the folder appears (Figure B.1)

2. Select the Security tab of the dialog.

3. Click the Advanced button.

The Advanced Security Settings dialog box opens (Figure B.2).

Figure B.1  Data Properties dialog box

Figure B.2  Advanced Security Settings dialog box
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4. Verify that the security settings are appropriate. 

5. Select the Replace permission entries on all child objects… checkbox. 

6. Click the Apply button. 

The following prompt will be displayed (Figure B.3).

7. To replace the permissions, click Yes to continue. 

This will reset the permissions for all files and subfolders of the selected folder.

Figure B.3  Security notice box
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Cell Summary Report
The Cell Summary Report is a tool for monitoring the performance of the hybridization and grid 
alignment of arrays. The report enables you to detect problems in these steps and compare the 
performance of different chips.

The Cell Summary Report uses the control features on the array. Control features are cells with special 
probes; the corresponding targets are spiked into the sample cocktail. The resulting patterns of bright and 
dark cells are used in grid alignment and other processes.

In AGCC the Cell Summary Report is automatically generated when CEL files are generated for certain 
types of arrays. These arrays require a .GRC file in the library file set. If you generate a CEL file for one 
of these arrays and the .GRC file is not available, you will see an error notice.

You can learn more about the Cell Summary reports in the following sections:

 Report Description

 Using the Cell Summary Report on page 323

 Cell Summary Report Algorithm on page 324

Report Description 
The cells that failed the analysis can be seen in the AGCC Viewer when looking at the DAT or CEL file 
(see File Display Differences on page 247).

The reports are placed in the data root and subfolder with the CEL file.

The cell summary report components are described in Cell Summary Report Components for Non-
Resequencing Chips, below.

Cell Summary Report Components for Non-Resequencing Chips
The Cell Summary Reports for all types of chips except Resequencing (Expression, Mapping, and others) 
provides information on the following features:

 Non-synthesized features

 OligoB1 features

 OligoB2 features

Refer to the relevant manual for the GeneChip array for more information about these features.

To open the Cell Summary Report:

1. Open the CEL file in the AGCC Viewer.

2. In the Properties box, click on the Report row.

A button appears in the Report Row (Figure C.1).

3. Click on the button to open a text display of the CELL Summary report.
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The Text Editor opens with the Cell Summary Report displayed (Figure C.2)

Figure C.1  Cel Summary Report Section

Figure C.2  Cell Summary report for Non-resequencing array
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The report contains the following sections:

 Report Header

 Summary on page 321

 Metrics on page 322

Report Header

The report header (Figure C.3) lists basic information about the Cell Summary report:

Summary

The Summary (Figure C.4) displays information:

Figure C.3  Expression Cell Summary report: header

Report Type Used to distinguish types of reports (Cell Summary Report, Algorithm Report, etc.).

Date Time and date report was generated.

Filename Input .CEL data file name that was used to generate the report.

GRC Filename Name of the .GRC file used to generate the report.

Probe Array Type Array type used for the CEL file.

Figure C.4  Expression Cell Summary report: Summary

For the following types of features:

Non-synthesized features

Bright control probes

Dim control probes
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Metrics

The metrics section (Figure C.5) displays additional data about the B1 and B2 oligos.

Total control features

The summary lists the following values:

Failures The number of features in the category that failed.

Total The total number of features in the category.

Failure Rate The percentage of features in the category that failed.

Figure C.5  Expression Cell Summary report: metrics
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Failed Cell Locations

Using the Cell Summary Report
The Cell Summary report provides clues to problems in the fluidics, grid alignment, and other issues with 
the cell file.

It can be used to establish a baseline for performance, which can then be used for quality control for 
subsequent experiments.

Features can fail the evaluation due to sample and system issues such as: 

1. Incorrect gridding 

2. Incorrect concentration of control oligo in sample (too high or too low) 

3. Incorrect scanner arc correction 

4. Incorrect recording of the scanner pixel size 

Figure C.6  Cell intensity data with failed control features masked

NOTE: To view these probes on a DAT file, view the cell intensity display. For more
information about this option, see Viewing Failed Control Features on page 248.
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5. Incorrect parameters for cell file generation 

6. Debris in the sample or on the array glass 

7. Array defects

Rules of Thumb
When processing a group of samples, identify the cell files that have the largest number of evaluation 
failures. This would be about ten percent of the cell files in the group. Use the graphic display described 
below to examine those cell files to identify any sample or system issues. 

When processing one or two samples use the graphic display to examine those cell files with evaluation 
failures greater than ten. 

In the event of substantial (greater than one hundred) evaluation failures the following guidelines may be 
helpful: 

 Failures limited to mostly bright or mostly dim control probes usually indicate debris or array defects. 

 Failures limited to mostly non-synthesized features often indicate non-specific binding and usually do 
not compromise any biological measurements. 

 Failures spanning both bright and dim probes often indicate gridding, scanning or other systematic 
issues. 

The relationship between Cell Summary Report results and biological results varies depending on the 
application. It is best to track these and determine trends for your laboratory and application. 

Cell Summary Report Algorithm
The algorithm’s goal is to use the probe design information to identify all probes that should have high 
intensities and make sure they in fact have high intensities. Similarly with the probes that should be dim. 
The features that fail the evaluation are totaled and flagged to enable their graphic display. 

Depending on the array/assay type, it is the target for the B1 probes that is spiked in and in others the 
target for the B2 probes is used. 

Thus, the first step of the algorithm is to determine which of the two probe types is brighter overall. The 
median for each of the B1 and the B2 probes is determined and if there is sufficient contrast (difference 
in median intensities) the probe type with the larger median is taken to be the bright probe type. 

If the contrast is insufficient an algorithm failure is reported. This kind of failure is typically only seen 
in the case of gross errors—such as use of the wrong library file, improper use of control reagents (spiking 
in both or neither of B1 and B2 control reagents) or rotation of the DAT image. The threshold is the 
calculated midpoint (or log midpoint) of the B1 and B2 medians. 

The algorithm examines each feature. If the feature is either B1, B2, or non-synthesized, then the intensity 
is compared against the threshold; otherwise, the feature is ignored. If the feature fails the threshold, then 
the feature is added to the total and the feature flagged to enable graphic display.
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Configuring E-mail for the Notification Options
AGCC provides e-mail notification of problems when:

 Running the GCS 3000 with AutoLoader

 Running the FS-450 Fluidics Station

 Running the GeneTitan® Instrument

 Running the Data Uploader

You will need to get information on the SMTPPort and SMTPServer from your IT department.

To configure the email notification for AGCC Fluidics control or AGCC Scan control:

1. In the appropriate instrument control software, click the Email button; or

From the Edit menu, select Email Messages...

The AGCC Email Configuration Editor opens (Figure D.1).

2. Enter the email account the messages will be sent from in the From box.

3. Enter the email account(s) to receive the message in the To... Box

4. Enter the SMTP Server and Port information in the appropriate boxes.

5. You can click the Test button to send a test e-mail.

6. Select the Scanner or Fluidics tab, depending upon which instrument you wish to select messages for 
(Scanner or Fluidics).

The message list displays the messages you can select from--they correspond to different types of 
failures or other conditions in the instrument.

Figure D.1  AGCC Email Configuration Editor
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7. Select and edit messages:

A. Select the checkbox next to the message ID.

B. Click in the subject or body column for the message and edit the text.

You can click the Default button to return to the original configuration.

8. Click Save to save the configuration changes.

Figure D.2  Message List for Scanners
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Log Files Generated by AGCC
The log files are produced by different AGCC components. The logs provide a record of the tasks 
performed by different components, such as the migration tools and installer. These log files provide 
useful information for troubleshooting problems. These files may be requested by your Field Application 
Specialist (FAS), Field Service Engineer (FSE), or the Affymetrix call center.

AGCC Log Files
The following files apply to both Cartridge Systems and GeneTitan Instruments. All the AGCC log files 
from C:\Command_Console\Logs

The different log files include:

Other AGCC Files

Your FAS and/or FSE may request you to send the following files for troubleshooting:

1. Library files (*.PARAMS, *.MASTER, *.WORKFLOW, *.SMD, *.MEDIA) located in 
C:\Command_Console\Library, excluding the large analysis library files (CDF, PSI, GRC). 

2. Provide a list of all sub folders and their contents under the library files folder located in 
C:\Command_Console\Library. Please ensure there are no duplicate library files, as these can cause 
problems.

3. AGCC system configuration file located at 
C:\Command_Console\Configuration\Calvin.System.config

4. Pending job order files located in C:\Command_Console\Jobs

5. Other AGCC related information, such as:

A. The number of files under C:\Command_Console\Data, including sub directory.

B. If the system is a networked system or a standalone system.

C. Other applications installed on the system, such as antivirus application, MS Office, Internet 
Explorer versions.

Systemlog.XML XML file with system information.

Workflow.log Text file with information on workflow status and 
history.

DEC.log Text file with information on the use of the Data 
Exchange Console.

DECError.log Text file with information on errors created while using 
DEC.

AGCC_LibFileImporter. log 
(with date and time code)

Text file with info on use of the Library File Importer.
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AGCC Log Files for Cartridge Systems
The following files are instrument-specific log files that apply to GCS 3000/FS 450 Instruments.

AGCC Log Files for GeneTitan Systems
Log files for the GeneTitan Instrument control processes are placed in subdirectories of the 
Command Console\Logs\ folder. Affymetrix may need the following files for troubleshooting:

GeneTitan Fluidics

1. C:\Command_Console\Logs\96F\

A. subdirectories named by date (e.g. Log7-29-2009) 

1) Collect all dated directories and contents since the GeneTitan app was started, not just the date 
of the event

(some logging goes into files from the date the app started so this can be critical for us).

2) Absolutely required are all the log directories from the date the run was started to the date of 
the event.

2. C:\Command_Console\Logs\96F\FluidicErrorLog - all files in this directory

3. C:\Command_Console\RAP2

The main user interface to this logging structure is file is C:\Command_Console\RAP2\RAP.html. 

 RAP.html contains historical information (since AGCC 4.0 was installed) about what has been run 
on the system

 RAP.html contains links to locations within the RAP2 folder and to some locations the standard 
logs found in C:\Command_Console\Logs\96F

 The logging structure supplements the standard logs found in C:\Command_Console\Logs\96F. It 
does not replace it.

 The RAP2 folder is not on the 30 day log file cleaner path.

GeneTitan MC Imaging Device

1. C:\Affymetrix\GeneChipHTScanControlMC\Log - collect all dated directories and contents since the 
GeneTitan app was started

2. C:\Affymetrix\GeneChipHTScanControlMC\RunLog - collect all dated directories and contents 
since the GeneTitan app was started

GeneTitan Single Channel Imaging device

1. C:\Affymetrix\GeneChipHTScanControl\Log - collect all dated directories and contents since the 
GeneTitan app was started

2. C:\Affymetrix\GeneChipHTScanControl\RunLog - collect all dated directories and contents since the 
GeneTitan app was started

fluidics.log Text file with info on Fluidics Station use

scanner.log Text file with info on Scan Control use

FS.log (with date and time 
code)

Text file with information on the Fluidics Script 
installation.
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Using TSV Files for Batch Editing
You can no longer download batch registration or batch editing files in TSV (Tab-Separated-Values) 
format in AGCC 4.0, but you can use previously created TSV files. The format of TSV files is discussed 
here.

The header row in a TSV file includes special properties that define the file and the physical array:

Path

The path needs to be associated with a data root. You can assign a set of sample files to a particular project 
if you select that project's folder in the Path field. 

Project

Specifying a project for the Sample file will determine the folder the Sample file is created in.

File Name

Enter the name assigned to the Sample file that will be created.

Path The path to where the Sample file will be created. Can be used to place Sample files in 
project folders.

Project The project that the Sample (.ARR) file will be assigned to.

NOTE: Specify either the Path or the Project for the files. Specifying both will return an error
message.

File Name Unique identifier for the Sample file.

Array Name Name assigned to the array during registration.

Probe Array Type Part number for the array (s).

Barcode Barcode on the array (s).

Attributes Additional information about the sample and experiment that you 
can use to interpret your results.

NOTE: Specify either the Path or the Project for the files. Specifying both will return an error
message.
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Barcode, Array Name and Array Type

If you are using Excel, you can select the probe array type from a drop-down list (Figure F.1). The drop-
down list can be disabled in Excel if you wish to enter multiple arrays for each sample (see below).

You can also enter multiple array information into the file.

To enter multiple arrays:

1. Enter a comma-delimited list in the barcode column: FirstArrayBarcode, SecondArrayBarcode

2. Enter a comma-delimited list in the array name column: FirstArrayName, SecondArrayName

3. Enter a comma-delimited list in the Array Type column: FirstArrayType, SecondArrayType

Attributes

Enter the values for the attributes in the appropriate columns. 

AGCC uses two types of attributes for Batch Registration:

 Template Attributes: Attributes that have been defined in a template. When you select templates for the 
downloaded batch registration file, the array attributes in those templates will be included as headings 
in the batch registration file.

 User Attributes: Attributes that you add in the Batch Register file.You create a user attribute by 
entering the attribute name and other characteristics in the column header, and then entering attribute 
values in the appropriate cells.

Attributes need to have the following characteristics defined:

 AttributeName

 TemplateName (if any; not used for User Attributes)

 DataType

Different methods are used for defining attribute characteristics in TSV and Excel format, as described 
below.

TSV Format

In TSV format, all of the attribute characteristics are defined in the column header, as shown in the 
template below.

 Header format for Template Attribute: AttributeName:TemplateName:DataType

 Header format for User Attribute: AttributeName:*:DataType

Figure F.1  List of probe arrays 
in Excel spreadsheet

NOTE: You can use custom barcodes to register an array in Batch Registration.
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Compliance Guide for FDA Title 21 CFR Part 11
What is Title 21 CFR Part 11?
Title 21 Code of Federal Regulation (CFR) Part 11 final rule provide criteria for acceptance by the FDA, 
under certain circumstances, of electronic records, electronic signatures, and handwritten signatures 
executed to electronic records as equivalent to paper records and handwritten signatures executed on 
paper. These regulations, which apply to all FDA program areas, are intended to permit the widest 
possible use of electronic technology.

The complete copy of the Title 21 CFR Part 11 requirements document can be found at the FDA web site 
www.fda.gov.

Compliance Scope
This section is intended to provide guidance on the use of the Affymetrix GeneChip Command Console® 
Software (AGCC) in relative to compliance with the Electronic Records / Electronic Signature rule (21 
CFR Part 11), hereafter referred to as “the rule”, promulgated by the United States Food and Drug 
Administration (FDA). To fully meet the intent of the rule, both the product design and the operational 
practices of the FDA-regulated firm must be properly addressed. This guidance describes the elements of 
the product’s design that promote compliance, as well as outlines the recommended practices to be 
incorporated within standard operating procedures by the firm. The main intent of this version of the 
section is to define the basic statement of work required to fully comply with the rule without imposing 
undue manual procedures on the regulated customer.

This guidance section provides useful information to: 

 Persons subject to Part 11 

 Persons responsible for creating, modifying, maintaining, archiving, retrieving, or transmitting 
electronic records or electronic signatures

 Persons who develop products or services to enable implementation of Part 11 requirements

AGCC System
AGCC system is an Open System since it is an environment in which system access is not controlled by 
persons who are responsible for the content of electronic records. The customer may choose to implement 
it as a Closed System by putting appropriate system controls.

http://www.fda.gov
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AGCC Title 21 CFR Part 11 Requirements Compliance Guide
AGCC System may be used in a Title 21 CFR Part 11 environment if the customer implements the 
requirements as noted in the guidance table in the customer section. Implementation can be done in the 
form of tools, application, and standard operating procedure or polices that are not built in the AGCC 
software.

FDA Title 21 Part 11 Guidance Section Affymetrix:
GeneChip Command Console Software (AGCC) Requirement 
Implementation and 
Customer: Recommended Practice to be implemented by the 
customer

Subpart B - ELECTRONIC RECORDS

§ 11.10 Controls for Closed Systems

a) Validation of systems to ensure accuracy, reliability, consistent 
intended performance, and the ability to discern invalid or 
altered records.

Affymetrix: 
AGCC is validated software based on requirements specifications 
to ensure accuracy, reliability, consistent intended performance, 
and the ability to discern invalid or altered records.
Customer: 
The customer is required by FDA to validate their use of a 
purchased configured software package to its intended use 
based on the specific predicate rule requirements. 
The customer should also ensure based on predicate rule 
purchasing requirements that the vendor is qualified and follows 
good software development practices.
Customers may develop and/or execute the validation plans and 
protocols themselves or outsource these activities. Validation 
should follow an established system life cycle (SLC) methodology

 (b) The ability to generate accurate and complete copies of 
records in both human readable and electronic form suitable for 
inspection, review, and copying by the agency. Persons should 
contact the agency if there are any questions regarding the 
ability of the agency to review and copy of the electronic 
records.

Affymetrix: 
AGCC allows accurate and complete copies of records in both 
human readable and electronic form such that the customer can 
demonstrate to FDA with appropriate procedures that the copies 
of records can be provided for inspection/review.
Customer:
Based on the predicate rule, appropriate policies and procedures 
must be established to ensure that records are accessible, 
readable, and held for an appropriate duration of time.

 (c) Protection of records to enable their accurate and ready 
retrieval throughout the records retention period.

Affymetrix:
AGCC Software has the data root which can be on the same or 
other systems where all the data is stored. Customer can develop 
procedures to perform the backup/restore to allow for 
maintenance of the records throughout the customer’s required 
record retention period
Customer: 
Customer shall train the user based on User Manual, User 
Instruction or Training Documents. Appropriate policies and 
procedures must be established to ensure that records (data) are 
accessible, readable, and held for an appropriate duration of 
Time
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 (d) Limiting system access to authorized individuals. Customer: 
AGCC software utilizes MS Windows and IIS security to 
Limit system access: Customers should implement MS Windows 
and IIS account policies to enforce password uniqueness, aging, 
and account lockout following a number of unsuccessful 
attempts.
Login attempts: Although not required by the rule, minimum 
length and legal construction (i.e. must contain one numeric 
character) should be considered. In addition, password-
protected screen savers can be used to ensure that workstations 
are not left unattended for longer than a specified period of 
time.
(AGCC relies upon Windows to demonstrate compliance to Part 
11)
Customer should consider following configurable settings.
Settings/Options:
(Controlled by Windows System Administrator)
Setup User, Access privileges, Permissions, User Type, Delete 
User, Password Expiry, Temporary Logins, Intrusion Email: On/Off
Security Audit Report Email: On/Off

(e) Use of secure, computer-generated, time-stamped audit trails 
to independently record the date and time of operator entries 
and actions that create, modify, or delete electronic records. 
Record changes shall not obscure previously recorded 
information. Such audit trail documentation shall be retained 
for a period at least as long as that required for the subject 
electronic records and shall be available for agency review and 
copying.

Affymetrix:
AGCC maintains audit, installation, and system logs.
Customer:
Customer shall implement appropriate procedures for Audit 
Trails and Retention Period. Affymetrix recommends utilizing a 
clock synchronization utility to ensure that all date and time 
stamps are accurate.

 (f) Use of operational system checks to enforce permitted 
sequencing of steps and events, as appropriate.

Affymetrix:
AGCC has diagnostic tools to check for instrumentation and 
software. The sequencing of steps/workflow is based on 
customer configurations.
Customer: 
Customer shall configure system based on their workflow needs 
and performs validation of the configuration.

 (g) Use of authority checks to ensure that only authorized 
individuals can use the system, electronically sign a record, access 
the operation or computer system input or output device, alter 
a record, or perform the operation at hand.

Same as item (d)

 (h) Use of device (e.g., terminal) checks to determine, as 
appropriate, the validity of the source of data input or 
operational instruction.

Affymetrix:
AGCC captures the fluidics and scanner id. 
Customer: 
The MS operating system captures the Process ID, Terminal ID, 
network ID, and workstation device ID for every user logged 
onto the system.
Customer should consider following configurable settings
Settings/Options:
(Controlled by Windows System Administrator)
Setup User, Access privileges, Permissions, User Type, Delete 
User, Password Expiry, Temporary Logins, Intrusion Email: On/Off
Security Audit Report Email: On/Off
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(i) Determination that persons who develop, maintain, or use 
electronic record/electronic signature systems have the 
education, training, and experience to perform their assigned 
tasks.

Affymetrix:
Affymetrix personnel developing, maintaining and supporting 
the AGCC software were trained and have the proper education 
and training.
Customer: 
Ensure that all persons involved with regulated system have the 
necessary levels of education, training, and experience to 
perform their assigned tasks. Customers should develop Training 
procedures and documentation practices that will support the 
proper qualification of the affected individuals. Customers must 
develop policies and procedures to support the application’s use 
in a regulated environment. 

 (j) The establishment of, and adherence to, written policies that 
hold individuals accountable and responsible for actions 
initiated under their electronic signatures, in order to deter 
record and signature falsification.

Customer: 
Customers must develop policies and procedures to support the 
application use in a regulated environment.

 (k) Use of appropriate controls over systems documentation 
including: 
(1) Adequate controls over the distribution of, access to, and use 
of documentation for system operation and maintenance. 
(2) Revision and change control procedures to maintain an audit 
trail that documents time-sequenced development and 
modification of systems documentation.

Customer: 
Customers must develop policies and procedures to support the 
application use in a regulated environment.

§ 11.30 Controls for Open Systems

Persons who use open systems to create, modify, maintain, or 
transmit electronic records shall employ procedures and controls 
designed to ensure the authenticity, integrity, and, as 
appropriate, the confidentiality of electronic records from the 
point of their creation to the point of their receipt. Such 
procedures and controls shall include those identified in Sec. 
11.10, as appropriate and additional measures such as document 
encryption and use of appropriate digital signature standards to 
ensure, as necessary under the circumstances, record 
authenticity, integrity, and confidentiality.

Customer: 
Customers must develop policies and procedures to support the 
application use in a regulated environment.

§ 11.50 Signature Manifestations – Not Applicable: AGCC Software does not use Electronic Signature to store, import, export 
and archive the records.

§ 11.70 Signature/Record Linking – Not Applicable: AGCC Software does not use Electronic Signature to store, import, export 
and archive the records.

Subpart C - ELECTRONIC SIGNATURES

§ 11.100 General Requirements – Not Applicable: AGCC Software does not use Electronic Signature to store, import, export 
and archive the records.

§ 11.200 Electronic Signatures components and controls – Not Applicable: AGCC Software does not use Electronic Signature 
to store, import, export and archive the records.

§ 11.300 Controls for Identification codes/passwords – Not Applicable: AGCC Software does not use Electronic Signature to 
store, import, export and archive the records.
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see also
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data roots
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see Data Exchange Console
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operating temperature 156
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see network data storage

network data storage 25, 68, 301, 303
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O

online documentation 7

opening
Portal 26
Scan Control 158
Viewer 246

opening folders 32

P

parent-child file relationships
broken during Change Probe Array Type 290
broken during DAT regridding 21, 276, 279
tracked with GUIDs 21

Park mode 169

passwords 306

permissions 23, 306, 315

Portal
Home page 27
Menu bar 28
see also

Administration functions
Advanced Search
Basic Search
Data functions
Sample Registration

see also Add Data Root
see also Remove Data Root
starting 26

primary folder 62

priming fluidics station 131

Priming protocol 131

Probe Analysis (CHP) files
see CHP files

probe array
manually removing array 196

Project view 42
selecting files 43

Projects 24
adding existing subfolder to 62
assigning folder to 58
characteristics 24
creating 58
deleting 63
introduction 24
primary folder

designating 62

protocols

see fluidics protocol

Q

Quick Sample Registration 97
creating new Sample file 97

R

Reconnector 13

registering array names 16

registering samples 16
Array Plate 111
Batch Sample Registration 101
Detailed Sample Registration 81
Plate Registration 108
Quick Sample Registration 97

removing data root 56

renaming folders
in Folder View 31

renaming Sample (ARR) file 88

Report files 35

resuming fluidics protocols 139

Review window 252
changing settings 256

running fluidics 133, 135

running on multiple stations 133

S

Sample (ARR) files
adding barcode 117
creating 78
editing 78, 87, 117, 120
introduction 19
renaming 88
see also

array name
attributes
Sample Registration

Sample Attribute Conversion
user attributes 92

sample attributes 17, 19, 79

Sample Attributes Conversion 92

Sample file list
filtering in Fluidics Control 140
filtering in Scan Control 168

Sample files
see Sample (ARR) files

Sample Prep Plate Registration 108

Sample Prep Plate Registration file 108
entering values in 108
uploading 109

Sample Registration 78
Add Barcode 117
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components 158
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starting
Fluidics Control 127
Launcher 12
Portal 26
Scan Control 158
Viewer 246

Station controls 129

Status window
Fluidics Control 130
Scan Control 159

subfolder
creating

in Folders View 30
with Windows Explorer 30

creating in Manage Projects 58
introduction 23
renaming

with Windows Explorer 30

subgrid alignment 279
manual 281
subgrid alignment algorithm 279

subgrids
selecting 281

Systemlog.XML 327

T

technical support 7
template attributes 17, 79

templates 292
create 293
deleting 296
designating default templates 298
edit 295

Text data type 79

Title 21 CFR Part 11 331

TOUGH-SPOTS™ 162

troubleshooting
AutoLoader 194
GCS3000 Scanner 172

U

UNC path 23, 55

Universal Naming Convention
see UNC
see UNC path

Upload Data 68, 70

uploading
Batch Edit Files 123
Batch Registration file 106, 115
data files to network data root 68, 69
Sample Prep Plate Registration file 109

user attributes 17, 79
in Advanced Search 47
in Detailed Sample Registration 84
in Sample Attribute Conversion 92
in Sample Attributes File Filter 144
in Search and Open 261

user-defined attributes
see user attributes

V

Viewer 19, 238
adjusting colors and contrast 268
Autoscale function 269
changing display of image 266
displaying cell centers 270
displaying grid 271
hiding components 250
moving components 249
opening 246
Review window 252
Search and Open dialog box 257
zoom functions 267

W

Web Resources 14

Windows Explorer



Index 341
adding folders 30
opening folders 32
renaming folders 30

Windows file folders 22

Windows Sharing and Security 23, 306, 315

workflow
see array processing workflow

Workflow Monitor 299

Z

zoom functions 267


